CRS Pro

CRS Pro is the easiest and most advanced software for creating XML files in the Common Reporting Standard format. With CRS Pro users can quickly import or manually enter data.

This help manual provides users with instructions and operations on how to use CRS Pro.
Disclaimer

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.
# Table of Contents

## Part I Getting Started

1. Disclaimer ......................................................... 9
2. About 1099 Pro, Inc. ........................................... 10
3. Quick Tour ....................................................... 11
4. Registration & Upgrades ................................. 12
5. Software Updates ............................................. 13
6. System Requirements ....................................... 14
   Language Settings ............................................... 14

## Part II The User Interface

1. 1099 Pro Central .............................................. 16
2. Task Panel ....................................................... 16
   Select Another Filer ........................................... 16
   Reporting F1 ...................................................... 17
   Preparing My Forms ......................................... 17
   Create XML ...................................................... 18
   Help & Extras ................................................... 18
   CRS Reference Materials .................................. 18
   Print Preview Toolbar ........................................ 19
3. Keyboard Shortcuts .......................................... 20

## Part III Helpful Hints

1. Adobe Acrobat .................................................. 20
2. Compliance Seminars ....................................... 20
3. Map by Name Import ....................................... 20
4. Master Audit Trail Browser ............................... 21
5. Menu Bar ........................................................ 21
6. Online Help Tutorials ....................................... 21
7. Online Knowledge Base .................................. 21
8. Registration Code ............................................ 21
9. Welcome Wizard ............................................. 22

## Part IV Support

1. Technical Support & Maintenance .................... 22
2. Online Help ..................................................... 23
4. Multi-User Installations ................................. 23
   Multi-User Considerations ............................... 25
Part V Security and Administration 28
1 Security Overview ................................................................. 30

Part VI Audit Trails 41
1 Audit Trails Activity Report.......................................................... 42
2 Deleted Record Detail................................................................. 43
3 Master Audit Trail Browser..................................................... 43
4 Purge...................................................................................... 43
5 Record History........................................................................ 43
6 Turn Audit Trails On/Off......................................................... 44
7 Audit Trail Report Filters......................................................... 44

Part VII Browse Filers 45
1 Add a Filer............................................................................... 46
2 Change a Filer........................................................................ 47
3 Delete a Filer......................................................................... 47
4 Filer Record Details................................................................. 48
5 Contact Persons..................................................................... 49
6 Filer Reports.......................................................................... 49
7 Tag Filers............................................................................... 49

Part VIII Work With My Tax Forms 50
1 Form Entry Screen................................................................. 51
2 CRS Forms: Add, Change, Delete........................................ 53
Part IX Imports Overview

1 Import Data......................................................................................................................................... 64
   * SAMPLE IMPORT FILES * ............................................................................................................. 64
   Import Wizard .................................................................................................................................... 65
      Manage Import Maps...................................................................................................................... 65
      Delimited or Excel Import Map Wizard........................................................................................... 66
      Map by Name Method..................................................................................................................... 68
      Drag & Drop Method....................................................................................................................... 69
      Modifying an Existing Import Map ................................................................................................ 69
   Step 1: Import Data or Filers ................................................................................................................ 70
      Import Status Options..................................................................................................................... 72
      Import Session Status Values ......................................................................................................... 72
   Step 2: Validate Data .......................................................................................................................... 73
      Review Import Records ................................................................................................................... 73
   Step 3: Final Import - Post Results .................................................................................................... 75
      Reset (Void) Import Session ............................................................................................................ 76
      Country Codes Table ...................................................................................................................... 76
2 Import File Conventions ...................................................................................................................... 77
3 Converting Excel Formats................................................................................................................... 80
4 Delimiters............................................................................................................................................. 81
5 Import Session Report.......................................................................................................................... 81
6 Reset/Void Import Session .................................................................................................................. 82
7 Reject Imports....................................................................................................................................... 82
8 Form Status Overview .......................................................................................................................... 82
   Microsoft Access 2007 Rollup Procedure ........................................................................................... 83

Part X Error & Validation Checking ...................................................................................................... 85
1 Warnings and Errors Scan ..................................................................................................................... 86

Part XI XML Overview .......................................................................................................................... 87
1 XML File Session Window ........................................................................................................... 87
2 XML Wizard .................................................................................................................................. 88
3 XML to Excel .................................................................................................................................. 89
4 Reset XML Session ....................................................................................................................... 91
5 NIL Reports .................................................................................................................................... 92

Part XII XML Failed Schema Validation ......................................................................................... 92

Part XIII Filing via OECD ................................................................................................................. 98
1 OECD Overview .............................................................................................................................. 98

Part XIV Reports ............................................................................................................................ 98
1 Form Control Totals ....................................................................................................................... 98
   Troubleshooting Control Totals ....................................................................................................... 99
2 Form Counts ..................................................................................................................................... 100
3 Forms Issued By Filer .................................................................................................................... 100
4 Import Map Reports ...................................................................................................................... 100
5 Daily Totals Report by UserID ....................................................................................................... 101

Part XV Current Sort/View .............................................................................................................. 101
1 Current Sort/View .......................................................................................................................... 101
2 Custom Sort Order ....................................................................................................................... 102
3 Dynamic Queries (CS Version Only) ............................................................................................ 102

Part XVI Queries ............................................................................................................................ 104
1 Custom Query using Manual Override ......................................................................................... 104
2 Custom Query Wizard .................................................................................................................. 105
3 Form Status Values: Database Queries ......................................................................................... 106

Part XVII Error Messages ................................................................................................................. 107
1 Invalid Record Declaration (47) ................................................................................................... 108
2 Unable to Open Required File (ProTips): 2 – File Not Found ...................................................... 108
3 Unable to Open Required File (ProTips): 3 - Path Not Found .................................................... 109
4 Unable to Open SystemID: 2 - File Not Found .......................................................................... 109
5 Unable to Open SystemID: 3 - Path Not Found .......................................................................... 110
6 Unable to Open SystemID: 5 - Access Denied .......................................................................... 110
7 Unable to Open SystemID File: 53 - Invalid Clarion File ........................................................... 110
8 EC002 – Unable to Open Files! ..................................................................................................... 111
9 File Not Found - Information Request ....................................................................................... 112
10 Could Not Load DLL Library \USER32.DLL ............................................................................ 112
11 Clarion Trappable Runtime Errors ............................................................................................. 112

Copyright 1099 Pro® 2017
Part XVIII Additional Services
1 Managed Services

Part XIX Glossary
1 Business Rules
2 ASCII
3 Cascading Updates
4 Corrected Options
5 Element: Country Codes
6 Element: Currency / CP Codes
7 Element: Payment
8 Element: TIN
9 Filer
10 Filing Deadlines
11 Hotspot
12 Import Map
13 Penalties
14 Pending Status
15 Recipient
16 SSAE 16 SOC I Type II
17 SSN
18 States Code Table
19 Tag
20 Task Panel
21 TIN Defined
22 TIN Masking

Index
1 Getting Started

Welcome to CRS Pro 2017

1099 Pro, Inc. proudly offers CRS Pro to aid users in complying with the Common Reporting Standard's XML schema. The CRS was developed by the G20 and approved by the Organisation for Economic Co-operation and Development (OECD) to initiate a "global model of automatic exchange of financial account information" between jurisdictions to help regulate offshore tax evasion. CRS Pro is developed in accordance with the OECD's Standard for Automatic Exchange of Financial Account Information in Tax Matters, 2nd Edition and the current Common Reporting Standard Status Message XML Schema: User Guide for Tax Administrations.

In short, CRS Pro allows a Filer/Reporting FI (defined as the unique combination of the Jurisdiction being reported to AND the associated Reporting Financial Institution) to report Account Holder information to a Reporting Country in an XML schema format to fulfill their CRS obligation.

CRS Pro Basic Software Functionality

Add a Filer
Add a Record
Import Data | Sample Import Files
XML Overview
Software Updates
Support

-------------------
Language Settings
-------------------

V. 12/11/2017

1.1 Disclaimer

Disclaimer

The 1099 Pro, Inc. methodology of flagging errors and warnings is merely a tool to help detect some of the possible inconsistencies or omissions in your data. 1099 Pro, Inc. does not assert that our system of detecting Errors and Warnings matches that of the IRS/SSA or that our system will detect any or all errors in your data. You may in fact have records that flag no Errors or Warnings and the IRS/SSA may both reject your files and or records and assess significant penalties on the data or lack of data that you submitted or did not submit. 1099 Pro, Inc. assumes no responsibility or liability for the detection of errors, omissions, inconsistencies, warnings, formatting, accuracy or complete filing or processing of your data. This software application identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this application. Even if no errors are identified by this software, your
submission could be returned or you could be penalized because of other errors.

1.2 About 1099 Pro, Inc.

About 1099 Pro, Inc.

1099 Pro, Inc.
Founded in 1989, 1099 Pro, Inc. is a market-leading provider of information-reporting solutions and services for 1099, W-2 and 1042-S filers. 1099 Pro develops and markets a comprehensive range of products that enable any size business or institution to effectively manage and be compliant with IRS requirements. 1099 Pro products range from Client Server / ASP applications (capable of filing over 100 million records) utilizing an MS SQL back end with a multi-year presentation of forms via Internet Explorer, to desktop software products for filing from 20 – 100,000 forms, to www.eFileMyForms.com for Internet filing of < 20 forms. Adjunct products include secure Hosting and Services for information processing, printing, filing and penalty abatement. With the ever-changing IRS laws and regulations, 1099 Pro develops new services, solutions, and software enhancements, remaining ahead of the curve of the industry. 1099 Pro is a Microsoft Certified Partner; MBE certified and has received SSAE 16 SOC I Type II certification.

Software offered by 1099 Pro, Inc.

1099 Pro Professional
Professional edition offers a streamlined and cost effective answer to your tax season. Prepares printing and paper filing for all forms in the 1098, 1099, 3921, 3922, 5498 and W-2G series. For an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

1099 Pro Enterprise
Enterprise software is a powerful information reporting solution designed with simplicity in mind. Enterprise supports the processing, printing, and paper or electronic filing of forms from series 1098, 1099, 3921, 3922, 5498, and W-2G. Through the software users may generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

W-2 Pro
Prepares forms W-2, W-2C, W-3 and W-3C transmittals. Supports printing to blank or preprinted forms. Through the software users can generate a formatted transmittal file for the SSA site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

1042-S Pro
Prepares form 1042-S on plain paper and allows users to print recipient copies B, C, and D on one page with instructions on a separate page. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS.

1099 Pro Corporate Suite
The 1099 Pro, Inc. Corporate Suite software combines the power of our Professional and Enterprise software with the speed, performance, and security of Microsoft’s SQL Server technology, making it the ultimate solution for businesses. Corporate Suite supports the processing, printing, and paper or electronic filing of forms from series 1095 (ACA Compliance), 1097, 1098, 1099, 3921, 3922, 5498, 592-B*, W-2, W-2G, 1042-S and Puerto Rico. Through the software users can generate a formatted
transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

8966 Pro
1099 Pro provides secure and intuitive FATCA Form 8966 software capable of tax form management and IRS XML reporting. The IRS is quickly finalizing the FATCA reporting requirements and will require Foreign Financial Institutions (FFIs) from Model 2 countries to report FATCA Form 8966, the FATCA report, directly to the IRS. FFIs from Model 1 countries, that must report to their host country who in turn transmits to the IRS, still must manage their FATCA Reports in one centralized location for ease of reporting.

CRS PRO
CRS Pro allows a Filer/Reporting FI (defined as the unique combination of the Jurisdiction being reported to AND the associated Reporting Financial Institution) to report Account Holder information to a Reporting Country in an XML schema format to fulfill their CRS obligation per the OECD.

The 1099 Pro Service Bureau
The 1099 Pro, Inc. Service Bureau was established for the purpose of helping companies successfully ease through the tax season. The Service Bureau features a highly secure SSAE 16 SOC I Type II and PCI Compliant environment, configured to process an unlimited amount of records and form types. The Service Bureau can print and mail records to your recipients, display records online securely via the Web Presentment service, and electronically file your records with the IRS. Continue reading to learn more about the services that 1099 Pro offers. Using the simple upload wizard and secure FTP agent available in your 1099 Pro software, users can easily transmit records for printing, mailing, or filing. To make sure users are taking full advantage of our information reporting solutions, we offer free technical support via phone or live chat.

The Service Bureau does not offer filing for CRS forms.

1.3 Quick Tour

Quick Tour

Overview of Common Reporting Standard (CRS)
The XML sent from a Sending Country to the Receiving Country is composed of groups and subgroups similar to the below:

- MessageSpec – Sending and Receiving Countries, contact information (from the Filer/ReportingFI)
- CrsBody
  - Reporting FI – Information on the organization reporting (from the Filer/ReportingFI)
    - Reporting Group
    - AccountReport
      - DocSpec - is this original, correction or deletion with unique identifiers
        The information below is normally imported but small volumes can be manually keyed in:
        - AccountNumber and other attributes
        - AccountHolder – name, birth and address information
        - ControllingPerson – if a organization or trust who controls
        - AccountBalance
        - Payment
The Message Spec and Reporting FI information comes from each Filer / Reporting FI that is created. Note that a Filer is for reporting from one sending country to one receiving country (jurisdictions). Filers are manually entered into CRS Pro.

The Account Report information is normally imported from an excel spreadsheet. Please see Sample Import Files. We recommend users save a copy of their spreadsheet in a text (tab) delimited format if your spreadsheet has more than 1,000 rows.

**XML Envelopes / Additional Specifications**

Some jurisdictions have additional specifications—such as Germany (DE) and Luxembourg (LU)—which require an AEOI XML envelope. 1099 Pro Technical Support handles these on a case-by-case basis at TS@1099pro.com. Please provide the jurisdiction variation AND a hyperlink to the specification for support with such envelopes.

**CDOT**

CRS Pro does not support CDOT—also referred to as "UK FATCA". UK FATCA is being phased out and will ultimately be replaced by the Common Reporting Standard. HMRC UK AEOI Submission v2.0 schema is not supported.

**Who Are We?**

1099 Pro, Inc., a California corporation, provides award-winning 1099 software for filing tax forms 8966 FATCA, 1042-S, 1099, 1098, W-2, 1094/1095 ACA and many others. 1099 Pro continues to offer complimentary technical support with the purchase of any of our software products.

1.4 **Registration & Upgrades**

**Registration & Upgrades**

**Software Activation**

To activate a "DEMO" version of software, users must enter their 14 character authorization code. Activating a demo provides the user access to all software features and retains their existing data. Purchase the software online or contact Sales to obtain an authorization code. Follow these steps to activate your software:

1. From within the software, at the top of the menu bar click Utilities > Software Registration/Demo Activation.
2. At the Product Registration/Demo Activation screen enter your Authorization Code and click the "Activate Now" button.
3. If your code does not work, please verify the correct TY version of the purchased software is installed. For example, a CRS Pro 2017 code is incompatible with a CRS Pro 2016 installation.

**How To Obtain an Authorization Code**

Internet: go to www.1099pro.com and purchase the software from our web site.
Phone: call toll-free (888) 776-1099 or (888) pro-1099 from 6am-5pm PST or call (818) 876-0200
E-Mail: sales@1099 Pro.com
Upgrading Transaction Limits

Transactions are the number of actual tax forms that may be entered or imported, regardless of print status, into CRS Pro. A standard installation allows for 1,000 transactions. To enter additional transactions users must upgrade their software with a bump code. Bump codes can be purchased online at www.1099pro.com or by contacting Sales at (888) 776-1099.

To Upgrade Transactions (Bump Codes)
1. At the menu bar go to Utilities > Software Registration/Demo Activation.
2. Enter your Upgrade/Bump Code and click "Upgrade Now". Newly entered Bump Codes are immediately reflected in the Current Record Limit.
   - In multi-user environments, the Bump Code must be entered at the Admin or Web Update workstation; this option may not be available at individual work stations (depending on access rights).

How Many Transactions Do I Have?
To track records or transactions, refer to the Product Registration/Demo Activation screen:
1. At the menu bar go to Utilities > Software Registration/Demo Activation.
2. The Product Registration/Demo Activation screen displays both the Current Record Limit and Current Record Total.

1.5 Software Updates

Software Updates

1099 Pro, Inc. regularly publishes software updates to keep up with the evolving rules and regulations of the IRS, SSA, and state agencies. To ensure your compliance, frequently check for software updates. By default, the software checks for updates occasionally during the summer, more frequently as tax season approaches and every day at the height of tax season. Users are strongly encouraged to take advantage of this process; an active internet connection is required.

Users can verify they are running the most up-to-date version of CRS Pro 2016 software:
- When starting any version of the software, a pop-up prompts to run a software update, OR
- Perform a Manual Update (as discussed below), OR
- Visit our WIKI download site at host.1099pro.com

Manual Updates

There are two methods to manually check for software updates.

Method 1
1. From the menu bar select Help > Check for Updates to CRS Pro.
2. Use the "Check for Updates" button to run an update. An active Internet connection is required.

Method 2
1. Close the CRS Pro software.
2. Use the Windows Start button to locate your CRS Pro software and select "Check for Updates" to initiate the Web Update Wizard.
3. Follow the prompts by clicking "Next". If there is a new version, a message displays the version number and provides a brief summary of items included in the update. Download the update and
allow the update to install. This process should begin automatically.

4. After the process is finished, confirm that the new version number of the software corresponds with
   the version number of the update by opening CRS Pro and at the menu bar selecting Help > About.

Users experiencing issues downloading updates may have a firewall on their network or local machine
   preventing them from retrieving updates. Check with your Administrator, IT personnel or temporarily
disable the firewall.

☐ All updates are available for download at the 1099 Pro WIKI site host.1099pro.com.

**Update Options**

Users can modify the frequency and/or type of software updates performed by CRS Pro. To edit these
   settings see Preferences.

Considerations:

- If an installation of CRS Pro has Security enabled, the User must have Administrator level access to
  modify the Checking for Updates options.
- For multi-user installations only the Server (not the Workstations) can view and modify the Checking
  for Updates option.
- Workstations cannot run the actual web update process -- they can only check for new versions.
  Once your Server has been updated, each workstation automatically updates itself the next time
  CRS Pro is run on that machine.

1.6 **System Requirements**

**System Requirements**

CRS Pro minimum system requirements include:

- Windows 7/8/10 - NEW
- 32 or 64 bit operating system compatible
- Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
- 512MB or more preferred
- 100+MB free hard drive space
- For use with ANY Windows compatible printer
- Windows compatible network (optional)

CRS Pro also requires specific Language Settings and Video Display Settings or users may experience
display or data input issues. Some Deskjet, Inkjet or Bubblejet printers may not print reports to the
bottom 1/2-inch of paper.

1.6.1 **Language Settings**

**Language Settings**

This version of CRS Pro **REQUIRES** the following settings on your Windows® Computer:

- Control Panel > Clock, Language, and Region—Set Format to English (United States) and Date and
Time Formats to M/D/YYYY.
- Control Panel > Clock, Language, and Region—Set Language to **English (United States)** for keyboard input.

Users who do not edit these settings may experience display or data input issues.

**Edit Region to Format > English (United States) and Short Date > M/d/yyyy**

Likewise edit **Language** to **English (United States)**

---

*Copyright 1099 Pro® 2017*
2 The User Interface

2.1 1099 Pro Central

CRS Pro Central

The CRS Pro Central Screen provides rapid access to important information.

Overview:
General overview of the XML generation process from start to finish.

To-Do:
Summarizes total filers, forms and form statuses. Allows users to create custom notes and To-Do Lists!

Help/Videos:
Provides links to technical support resources, contact information for support, and Online Tutorials.

2.2 Task Panel

Task Panel

The task panel is the blue bar on the left side of the CRS Pro screen and provides quick access to common tasks. Click on the links for details on the options contained within each task panel area.

Select Filer
Reporting F1
Preparing My Forms
Create XML
Help & Extras

2.2.1 Select Another Filer

Select Another Filer

Use the "Select Another Filer" button, located at the top left of the task panel, to select between Filers. The Current Filer displays both the Filer/Reporting FI name and its associated Payer Code.
To Select Filers
1. On the task panel click the "Select Another Filer" button.
2. At the Browse the Filers File screen highlight the filer to use and click "Select". The currently selected filer is displayed at the top of the Select Another Filer box.

2.2.2 Reporting F1

Reporting F1

From the Reporting F1 task panel, users can access:

My Filers List:
Add, edit or delete Filers and run various reports.

2.2.3 Preparing My Forms

Preparing My Forms

From the Preparing My Forms task panel users can:

Work With My Tax Forms
View records, Add or Change a record, Delete a record, Void a record, Quick-Print Forms, Email Tax Forms and run various reports.

Import New CRS Forms
View import sessions, Void import sessions, Import comma delimited files or tab delimited files.

Form Totals Reports
Customize a Control Totals report with the option to generate a listing of any errors and/or warnings.
2.2.4 Create XML

Create XML

From the Create XML task panel users can access:

XML V1.0 OECD:
Create XML files, view XML sessions, run reports, and access the OECD site.

NIL Report
Create NIL reports.

2.2.5 Help & Extras

Help & Extras

From the Help & Extras task panel users can access:

Help and Tutorials:
Go directly to the 1099 Pro Central Help/Videos Screen.

Correcting Filed Forms:
Create Corrections, Reprint Corrected or Original Forms

CRS Reference Material

2.2.5.1 CRS Reference Materials

CRS Reference Materials

Direct links to the below documents are accessible via the task panel under Help & Extras > CRS Reference Materials. An active Internet connection is required.

Publications
FAQ's— Collection Efforts, Account Holder Research and Definitions
Foreign Tax Identification Numbers (TINs)
High Level Overview of Common Reporting Standards (CRS)
OECD—Activated Exchange Relationships for CRS Information
OECD—CRS by Jurisdiction (2 years)
OECD—Implementation Handbook (CRS Standard)
2.2.6  Print Preview Toolbar

Print Preview Toolbar

The Preview screen allows users to view a form or a report and check it for accuracy before printing. Use the following icons located at the top of the Preview screen:

Use to print THIS page only.

Use to VIEW the previous page.

Use to view the NEXT page.

Use to toggle STAY after printing.

Use to Search for characters within a report.

Use the "Print" icon to access the "Print Setup" screen to print the entire report. See Duplex Printing.

Use to exit the preview report WITHOUT printing.

Use to view the preview report in full WIDTH view.

Use to view the preview report in full HEIGHT view.

Use to save in PDF format when printing.

Additional options available for this screen include:
- "Zoom PCT" defaults to 98% (may vary depending on monitor) and adjusts from 25 - 250% viewing.
- If the preview consists of more than one page, scroll forward/ backward with the double arrow icons.
2.3 Keyboard Shortcuts

Keyboard Shortcuts

<Alt>:
Use the <Alt> key and the underlined letter (or number) of any menu bar item to access a drop menu.
For example, ALT + R to access "Reports".

<F1>:
Access context-sensitive help at any screen.

<F2> or Right-Click Mouse:
With your cursor in the Account Number Type or Name Type fields, use the <F2> key or right-click your
mouse to access box specific data:

Incremental Search:
Find a Filer via the Search Name field.

Drop Menu*:
Right click your mouse to view a pop-up box with options to add, change or delete forms.

*Available at the Filers List (Manage) and Work With My Tax Forms screens only.

3 Helpful Hints

3.1 Adobe Acrobat

Adobe Acrobat

Use Acrobat Reader to open/view a PDF file. Download Acrobat Reader for free at ADOBE's website.

3.2 Compliance Seminars

Compliance Seminars

For information about 1099 Pro, Inc. sponsored seminars and conferences, visit our website at http://

3.3 Map by Name Import

Map By Name Import Method

Use if your import file incorporates header records from one of our sample import files. Simply click the
"Map By Name" button and the fields automatically assign themselves.

For more information see the Import Wizard and Map By Name topics.
3.4 **Master Audit Trail Browser**

**Master Audit Trail Browser**

The Master Audit Trail Browser is available only to Administrators or Users with administrative access rights. This browser offers greater functionality than the Record History screen and includes the ability to view all forms and make changes directly to forms.

See [Audit Trails](#).

3.5 **Menu Bar**

**Menu Bar**

The menu bar is a traditional navigational tool located at the top of the CRS Pro screen. For example, use ALT + R to access "Reports".

3.6 **Online Help Tutorials**

**Online Help Tutorials**


Additional tutorials are available on YouTube:
- [CRS Import](#) (3 minutes)
- [CRS Tutorial](#) (12 minutes)

3.7 **Online Knowledge Base**

**Online Knowledge Base**


3.8 **Registration Code**

**Registration Code**

A registration code (activation code) is provided upon proof of payment. Registration codes are 14 alpha/numeric characters (e.g., Z91234567XXXSE). The algorithm of your registration code indicates the edition, user license and number of transactions purchased.

See [Registration](#) topic
3.9 Welcome Wizard

Welcome Wizard

Upon first entering CRS Pro the Welcome Wizard walks users through creating their first Filer/Reporting FI and activating optional security features.

4 Support

4.1 Technical Support & Maintenance

Technical Support

All 1099 Pro software products includes context-sensitive help screens as the first means of supporting your use of this product. In addition, 1099 Pro, Inc. offers many technical support options including; Online Help Tutorials and an Online Knowledge Base. These options are intended to provide customers with immediate solutions. If these sources do not contain the answers to your questions, contact technical support by phone or E-Mail. To help us better assist you, please provide the following information:

- Company name or Customer Identification (CID) number
- Please be at the computer you are experiencing the problem with
- A list of what steps were taken prior to the problem
- Any error messages that you have encountered.

Technical Support Options
Help Tutorials and Knowledge Base
http://www.1099.Pro.com
Phone (888) 776-1099 (toll-free) or (818) 876-0200
E-mail support@1099.Pro.com

Service Bureau
Phone - (866) 444-3559
E-Mail - sb@1099.Pro.com

Normal Hours
Monday to Friday: 5AM to 5PM PST
Saturday: Closed
Sunday: Closed

Tax Season Hours (January)
Monday to Friday: 5AM to 5PM PST
Saturday: 8AM to Noon PST
Sunday: 8AM to Noon PST

Direct Links
Video Tutorials: http://www.1099pro.com/videos.asp
Software downloads: http://host.1099.Pro.com
YouTube Tutorials: CRS Import and CRS Tutorial
Complimentary technical support is limited to questions regarding CRS Pro software. We are NOT authorized to provide accounting, tax or legal advice. Please direct such questions to your accountant or attorney. Calls may be limited during peak tax season.

4.2 Online Help

Online Help

Context-Sensitive Help
Use the <F1> key at any screen to access context-sensitive help screens.

To search for a topic
At the CRS Pro menu bar select Help > Search the Help File and at the Index tab type the first few letters of the word you're looking for. For example, type "fil" to display all related topics such as Filer.

4.3 Install Single-User Version

Install Software

To download any 1099 Pro, Inc. software product please visit: http://host.1099pro.com. All software installations are two-step; requiring both the Full Install and the most recent Update.

Foreign Operating Systems see Language Settings
See Multi-User/Network Installations

To Install Single-User* or Demo
1. Insert the CD-ROM into your computer's CD-ROM drive.
2. On your Windows desktop click the "Start" button and select "Run".
3. In the Open field, type x:\setup.exe, where x is the name of the CD-ROM drive and setup.exe is the name of the CRS Pro executable.
4. Click "OK" to start the setup program.
5. Follow the instructions provided by the setup program. If CRS Pro prior year data is detected on your system the Roll Forward Utility activates.

Virus Checkers
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in CRS Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.

4.4 Multi-User Installations

Multi-User Installations
CRS Pro is available in single, multi-user or unlimited-user licenses. The algorithm of your registration code indicates the edition, user license and number of transactions purchased.

- Foreign Operating Systems see Language Settings

**Upgrade From Single-User/DEMO to Multi-User Version**

1. Close CRS Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "CRS Pro" for the year you are upgrading and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Uninstall the program, but KEEP data files and backups" and then click the "Next" button to start the uninstall program.
6. CRS Pro prompts through the remainder of the uninstall routine.
7. Once the process is completed remove the "Admin" in the installation folder for the software year just uninstalled.
8. Proceed to the appropriate multi-user installation instructions below.

CRS Pro is network neutral; either a peer or server install is acceptable. The only requirement is that one machine be designated as server and all others as workstations.

**Network Installation**

1. Determine a network drive and folder to install CRS Pro. All workstations must have rights to this folder. The software can use a UNC or a mapped network drive.
2. Install CRS Pro on the server where the data will be stored. Enter your multi-user Registration code as prompted. Select Web Update Workstation as the Install Type. Allow the program files to reside on the local drive.
3. Upon successfully installing CRS Pro to the network, click on the "CRS PRO icon" on your desktop. The Welcome Wizard prompts through setting up the software. By default, Audit Trails and Security are enabled*. Complete the Welcome Wizard and then re-enter the software. Administrators use "Administrator" and "NEW" to logon for the first time with enabled security. Administrator must create users and assign rights prior to installing CRS Pro to workstations.

*We recommend enabling Security. If security is disabled ANY USER on ANY WORKSTATION can access CRS Pro and view/modify Administrator settings and all data. This includes the potential for ANYONE to create himself as Administrator and lock you out of CRS Pro!

**Workstation Installations**

1. Complete network installation prior to installing workstation(s).
2. Install CRS Pro at the workstation. Enter your multi-user Registration code as prompted. Select Workstation Installation as the Install Type. Browse for the network drive and folder (e.g., X:\1099 Pro\ProCRST17 where "X" is the mapped network drive). Allow the program files to reside on the local drive (e.g., C:\1099_Pro\ProCRST).
3. If the Administrator enabled security, the workstation is deemed a "User". Upon first entering CRS Pro at the workstation a User ID (as assigned by the Administrator) is required. For the Password enter "NEW". The User is then required to create their own unique password.

Multi-User Installation with Remote Data/Program Location

1. **Install Server** - Installing software a code ending with ME or MP will trigger a Multi-user installation. ALWAYS install the "Server" first noting that this PC will be the only PC where software updates can be applied. Subsequent installations are "Workstations".

2. **Remote Data/Program Location** - When installing the 'Server', you are presented with an option to have your data and program DLL's reside on another PC, Novell drive or Network Attached Storage.
   - Check the box "Allow Remote Server Installation" to start the Remote Data/Program Location.
   - Click on the "Browse" button and select the destination directory. Note that the value under "Select Destination Directory" must end with a pathname of \ProCRST17. Note that you may select a mapped network drive or you may use UNC such as //amd800/\C in this case.
   - Next you will be prompted if you wish to roll forward data such as Filers, Security Settings, ... from a prior year. Once you have finished installation you can open the software, click on "Help" and "About" and then click on the graphic icon for the software and you can see the data paths involved. Note that none of the data or program files are kept on the "Server", they are kept at the Remote Server/Data Location.

3. **Install Workstations** - Perform subsequent workstation installations as needed. Be sure that each workstation has read/write/delete rights to the Remote Data/Program Location. Note: each Workstation must communicate with the Remote Server/Data Location via UNC or a mapped letter drive. Workstations do not have to communicate with the "1st Multi-user Installation = 'Server' shown above.

4. **Web Updates** - When it is time to perform a Web Update you will have to perform it from the "Server" that you just installed. Web Updates are performed at the "Server" and in this case performing the update at the "Server" will result in the program files and the data files being updated on the "Remote Server" (based on the .ini file on the "Server"). Note that workstations will communicate with the Remote Server/Data Location only and not with the 'Server' where the software was originally installed from or the Web Update was run from.

**Note:** CRS Pro uses a local .ini file to store the data path of your remote data. Verify the following: If the CRS Pro install was done under a different account with a drive letter mapping then that same path will need to be mapped with the same drive letter. For example: If the Administrator of the computer has the remote drive as L: and the user has the mapped drive as a K: then the user will not be able to access the data.

See Multi-User Considerations

4.4.1 Multi-User Considerations

Multi-User Considerations

When running CRS Pro software's multi-user versions, some tasks require exclusive control of certain
files. These tasks are detailed below.

**Record Locking**
The multi-user version of CRS Pro software utilizes record locking when two or more users concurrently open the same record. This allows users to simultaneously view the same record but prevents them from overriding each other's changes. For example, Users A and B open the same record. User A changes an amount and saves the record. User B then changes an amount and attempts to save the record. User B receives a "Record Was Not Updated" warning and the record is automatically updated with User A's changes. User B may then select a field to restore and use the <F4> key to re-populate what they had originally entered.

**Import Locking**
During the final step of the Import Wizard, Post Import Session, the software attempts to gain control of all records. If the software is unable to gain control of a record (because someone else has the record open) it will notify the user and offer to post the files the slow, non-locking way or allow them to cancel.

**Unlocking Records**
1. Navigate to "File".
2. Click on "Security and Administration"
3. In the "Business Rules and Options" section, click on "Browse System Process Locks".
4. Highlight User and click "Delete/Remove the Selected Lock".

### 4.5 Uninstall Software

**Uninstall Routines**

The Select Uninstall Method screen offers two options for removing CRS Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine.

**Uninstall CRS Pro (Custom)**
1. Close all applications including CRS Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "CRS Pro 2017" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Custom" and then click the "Next" button to start the uninstall program.
6. Files are categorized for deletion. Users may "Select All" (recommended), "Select None" or use their mouse to select specific files. Categories include:
   - System Files
   - Directories
   - INI Files
   - INI Entries
   - Registration Database Keys
7. After selecting appropriate files click "Finish" to complete the uninstall.

**Uninstall CRS Pro (Automatic)**
The Automatic uninstall process retains your current data files under the main program directory in the folder named "Data", preserves the "Uploads" folder containing any uploads generated by the CRS Pro
software for submission to the Service Bureau, and miscellaneous .DLL files are left in the Program root directory used by the software. In addition the .INI file is also preserved in the\Admin or \Windows directory.

1. Close all applications including CRS Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "CRS Pro" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Automatic" and then click the "Next" button to start the uninstall program.
6. CRS Pro prompts you through the remainder of the uninstall routine.

**NOTE:** Users who uninstall CRS Pro and then reinstall it may get an "Invalid Record Declaration (47) Accessing TAXDATA.TPS [or FILERS.TPS]. Press OK to end this application" warning. This error occurs because some files were not deleted during the automatic uninstall. Users must perform a custom uninstall of 1099 Pro (and select all files for deletion) and then reinstall the software.

### 4.6 Data Files

#### Data Files

CRS Pro data files are suffixed with ".TPS". For example, "filers.tps" contains filer data and "country.tps" contains country codes. These files are located in the Data folder and in a typical installation are located at C:\1099_Pro\ProCRST17\Data.

#### INI File

The INI file contains information specific to your installation such as data paths and version. For example:

```
NetPath=C:\1099_Pro\ProCRST17
LocalPath=C:\1099_Pro\ProCRST17
InstallVersion=201X.18.12
```

In a standard installation the "ProCRST17.ini" file is located at C:\1099_Pro\ProCRST17\Admin.

The INI file may or may not be deleted during a custom uninstall. This file can be manually deleted to totally remove software from your system or to perform a clean re-installation. This file can remain if a users wants to reinstall the software but retain their settings.

### 4.7 Video Display Issues

#### Video Display Issues

If the data on the form appears distorted or out of alignment please follow the directions below to correct your resolution and font settings.
Adjusting your resolution and DPI settings.

Windows 10
1. On your Windows desktop right-click your mouse and select Display Settings.
2. At the Customize Your Display screen verify the size of text is set at 100% (not larger). Then click "Advanced Display Settings" and verify Resolution is set at 800 x 600 (or higher). Click "Apply" and "Keep Changes". You may need to restart for these settings to take effect.

Windows 7/8
1. On your Windows desktop right-click your mouse and select Personalize > Display. Click Adjust resolution, verify your display resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. On the Display screen click Set custom text size (DPI). Verify scale is set to 100% (96 pixels per inch). Click OK. You may need to restart for these settings to take effect.

5 Security and Administration

Global Administrative Options

Access the Global Administrative Options screen via the menu bar > File > Security and Administration.

Security
Through the use of settings and rights administrators can restrict users and thereby protect sensitive company data.

Add/Update Individual Users
Administrators can use the Add/Update Individual Users screen to create users and assign them to specific tasks.
See Adding and Updating Users
Access Groups and User Profiles
Create new Access Groups and User Profiles based on the user's custom settings. Your groups will be available when adding or changing a user and are included in all security reports.

Passwords
Passwords can help protect sensitive company data.
See Passwords for more information

Security Access Logs
The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all logon attempts.
See Security Access Logs

Security Reports
CRS Pro offers numerous reports to track users and access groups. These security reports are available only to administrators or users with administrative rights.
See Security Reports

Turn On/Off Security
CRS Pro offers two levels of security; on and off. If security is enabled, access to CRS Pro is limited to users with valid User ID/Password combinations. These users are restricted to specific tasks assigned by the Administrator. This provides a twofold method of protecting sensitive company data.
See How to Enable or Disable Security

Tax Form Audit Trail and Action Logging Options

View Audit Trail Records
The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the Record History screen allows the viewing of individual tax forms only).
See Master Audit Trail Browser.

Purging Audit Trail Logs
The Audit Trail Record Log is invaluable for tracking tax forms changes. If the log becomes so large that the performance of CRS Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.
See Purging Audit Trail Logs for more information.

Program Options

Preference, Update and Program options
Configure many of the software general settings such as date range warning, update checking and backup reminders.
See Preferences for more information.

Tax Form Validation for Import and Entry
Adjust settings to configure the warning and error messages displayed when importing or manually entering forms.
5.1 Security Overview

5.1.1 System Security Settings/Password Requirements: Step 1

Setting Password Requirements

Step 1: Set Security Preferences/Password requirements
The Security Preferences/Passwords requirements section allow Administrators to configure details regarding user passwords including: password length, lockout settings, expiration and password format

1. To configure password and login requirements click the "Set Password Requirements" button.

2. At the Modify System Security Settings window, configure the following settings:
   a. Minimum Password Length: Defines the minimum character length the password can be; range is from 5-15 characters
   b. Lock a User ID after this many invalid login attempts: Sets the maximum number of times a user can fail to log in before needing to have their account unlocked by an administrator.
   c. Days before a password expires: Sets the length of time a user’s password is valid before they must choose a new one.
   d. Days to warn a user before a password expires: Defines when the software will begin notifying the user their password is set to expire.
   e. Times before a password can be used again: Defines how many different passwords must be used before a user can use the same password again.
   f. Require at least One (1) Uppercase Character: Determines whether or not there must be at least one uppercase character in a User’s password.
   g. Require at least One (1) Lowercase Character: Determines whether or not there must be at least one lowercase character in a User’s password.
   h. Require at least One (1) Numeric Character: Determines whether or not there must be at least one numeric character in a User’s password.
   i. Require Special Characters in Password: Determines whether or not special characters (i.e., !, @, #, $, %, ^, etc.) are required in a User’s password. Admin must specify which special characters are allowed before enabling this option (see "l" below).
   j. Special Characters (Up to 15): Define special characters which may be used during password creation.

5.1.2 Security - Access Groups: Step 2

Security - Access Groups

Step 2: Creating and Managing Access Groups
Access Groups allow an Administrator to define the Program Areas and Form types that a User will have access to, as well as their level of access. Users only have the rights specifically assigned to them; any rights not assigned are denied by default. The rights available within CRS Pro are View/Access area, Create, Modify, Delete, Report, Correct, Print, and Reset/Void where applicable.

1. At the menu bar click File > Security & Administration > Security Groups.
2. At the Security Options screen click the "Create and Manage Access Groups" button to open the Access Groups screen.

3. Click “Add” to open the Update Access Groups screen and create a new access group.
   - Users may also select “Change” or “Delete” to modify any existing access groups or to view the contents of a built-in Access Group.
   - **IMPORTANT:** CRS Pro includes multiple built-in access groups (indicated by a TEAL color) that cannot be modified or deleted.

4. **Assign or Modify Access Rights** at the Update Access Groups screen by entering a Group Name and then “Tag” (or select) items in the Access Form or Program Area to configure. After tagging an item click the “Modify Highlighted Records” button.

5. The Modify Access Rights window opens and the Administrator may assign specific rights to a form or program area by clicking the check box to the left of the form to modify. If the right is ghosted or grayed out then that right is unavailable for that particular area. You may also "Select All Rights" or "Clear All Rights".

6. Click “Save” when done to return to the Update Access Groups screen. Administrators may add Notes for the Access Group if desired. When done modifying Access rights click "Save Changes to Group" to exit and save changes.

7. At this point the Admin may "Add", "Change" or "Delete" other Access Groups as necessary; excluding CRS Pro's built-in access groups. When finished click “Close” to return to the Security Options screen.
   - **IMPORTANT:** If a Program Area or Form type is "Tagged" (or selected) and no rights are assigned to it, you have created a “View only” access rule. View only access allows an assigned users to VIEW an area or form but they cannot enter or save any edits.

5.1.3 **Security - Manage Profiles: Step 3**

**Security - Manage Profiles**

**Step 3: Create and Manage User Profiles**

User Profiles allow Admin to apply Access Groups to specific Filers/Departments. When assigning a user to this profile (Step 4), the User only has the specific rights granted by that Access Group to the specified Filers. 1099 Pro’s built-in User Profiles are applied to ALL filers. **NOTE:** In order to access the 1099 Pro system, **a User must have rights to AT LEAST one Filer, in other words, they must be assigned to at least one User Profile.**

The below diagram illustrates the components comprising a **User Profile**. In Step 4 the users are assigned to the profiles.

---

**Diag 1:**
User profile composed of multiple filers (companies/departments) and 1 access group.

**Diag 2:**
User profile composed of 1 filer and multiple access groups.
1. To create or manage a User Profile click "Create and Manage User Profiles for Filers and Access Groups" from within the Security Options window. 1099 Pro includes built-in User Profiles. Built-in groups are colored in teal and cannot be modified or edited. By default, all built-in User Profiles have access to ALL current and Future Filers.

2. Click "Add" to create a new user profile or select "Change" to modify any existing User Profiles. The "Quick Assign" button walks users through these steps in a wizard. Use the "Clone Profile" button to clone a previously created profile and then edit the Filers and Access Groups assigned to it.

3. After clicking "Add", "Change" or "Clone Profile" the Update User Profile screen opens. At this screen assign Access groups to Filers.
   o Create or update a user profile:
     a. Create a name for the User Profile.
     b. Tag (or select) the Filers to allow access to.
     c. Highlight the Filer to configure and click the "Assign Access Groups" button to attach Access Groups that were previously created to the profiles.
     d. At the Tag Access Group screen select the previously created profiles (Step 2).
     e. After selecting profiles click "Save" to exit. Repeat Steps C, D and E for each Filer in this profile.

4. Upon exiting the Update User Profile screen return to the User Profiles screen where Admin can continue to add, change or delete profiles. After updating profiles click "Close" to return to the Security Options window.

5.1.4 Security - Add/Update Individual Users: Step 4

Security - Add/Update Individual Users
**Step 4: Add/Update Individual Users**

Generally there is one User for each physical user of the software. This section assists in the creating, updating, and deleting of Users. Remember, **built-in accounts cannot be modified or deleted.**

1. To configure Users, click on "Add/Update Individual Users" at the Security Options screen.

2. The Users screen displays all current users in the software. Use the "Add User" button to add a new user and the "Change" button to modify an existing user or view the profiles they are associated with. The "Delete" button removes users from the system.

3. Click the "Add User" button to open the Adding a User window where Admin creates the login information required for the new User to access the software (or Change User in the case of clicking the "Change" button).
   - **User Login Settings:**
     - **User ID:** Enter a User ID for software login. The "Administrator" is a built-in User ID and cannot be modified; at a minimum CRS Pro requires an Admin.
     - **Password:** By default, all new users are assigned **NEW** as their password—this cannot be changed at this screen. To set the user requirements for password see Set Security Preferences.
     - **Lock Status:** Indicates if a user account is locked due to login failures. Click "Change" to lock or unlock an account. The Admin can reset the password as necessary.
   - **(Optional Information)**
     - **User Name:** User's full name; this information does not impact login credentials.
     - **Phone:** User contact phone number.
     - **Other Info:** Add other information such as user's department, e-mail address, location, etc.
     - **User Profile Membership:** This field displays all of the User Profiles that the user is currently associated with. See **Step 5: Add Users to a Profile**

**5.1.5 Security - Add Users to a Profile: Step 5**

**Security - Add Users to a Profile**

**Step 5: Add Users to Profiles:**

This last step in configuring security will guide you through the process of assigning a user to a profile created during Step 3.

**To Add User to a User Profile**

1. Click on the "Add/Remove Users from Profiles" button located on the Security Options window.
2. At the Security – Assign Users screen (Available User Profiles screen in Corporate Suite) assign newly created users to a profile.
3. Select the profile you wish to add users to by clicking the “Available User Profiles” dropdown.
4. Tag the users that you wish to have applied to the selected profile. Click "Save" **prior to adding users to another profile.**
5. To tag a user highlight the user and click “Tag” button or click in the column to the left of their UserID.

**Select which tax years users have access to under the profile.** (Corporate Suite Only)

1. Click “Save”/ “Save my Changes to this Profile/Year”
2. Repeat the steps above to add users to additional profiles.
5.1.6  Turn On/Off Security

Turn On/Off Security

Section 1: Accessing Security
2. At the Security Options screen the Security status is displayed as ON or OFF.
3. If security is OFF (or not enabled) click the "Activate Security" button to enable it.
4. The user is prompted to restart the program.

5.1.7  Passwords

Passwords

Passwords help protect sensitive data.

First Time Logon
If security is enabled during the Welcome Wizard, the Administrator must create a new password the first time they logon to CRS Pro.

1. In the User ID field enter Administrator; in the Password field enter NEW.
2. Click "OK".
3. The Logon screen requires you to enter a new password.
   - Passwords must be at least 6 characters.
   - Passwords are case sensitive.
   - Password cannot be "NEW"
4. After successfully creating a password, Administrators are encouraged to create Users.

I Lost My Password!
If a User forgets their password the Administrator may reset it.

1. At the menu bar select File > Security & Administration.
2. At the Administration screen select "Security Groups" > "Add/Update individual Users".
3. At the Browse & Update the List of Users screen select the User whose password needs to be reset and click "Change".
4. At the Changing a User screen click the "Reset" button. The password is automatically reset to "NEW". The next time the User logs into CRS Pro they are required to change their password.

If the Administrator forgets their password they must contact Technical Support. The purchaser of CRS Pro must send a request on company letterhead stating that the Administrator password is lost and an unlock code is required. Upon receipt of this request, Technical Support will provide an unlock code good for that day only.
5.1.8 Logging in as a Different User

Logging in as a Different User

If logged in with a user account in 1099 Pro, you may log off your existing user and log in as a different user without fully closing the software. Follow the steps below to log in as a different user. **IMPORTANT!** You must first close all screens in 1099 Pro using the close button at the bottom right. "Logon as Different User" will only appear once you close all top level screens and you can see the following window in your 1099 Pro software.

**Steps to change your current logon account.**
1. Click on “File” on the toolbar at the top in 1099 Pro.
2. Select “Logon as Different User”
3. When you are prompted with the 1099 Pro logon screen, type in your User ID and then your password.
4. Click "OK".

Finally verify your login has changed by checking the user currently logged in in the bottom right corner of the screen.

5.1.9 Security Reports

Security Reports
CRS Pro offers numerous reports to track Users, User Profiles, and Access Groups. These security reports are available only to administrators or users with administrative rights.

To generate security reports

1. At the menu bar select File > Security and Administration.

2. At the Global Administrative Options screen select "Security Groups" > "View/Print Security Reports". Available reports include:
   - **Users by Name**: Lists all users sorted by User ID.
   - **Users and Attached Profiles**: Lists all access users and all of the User Profiles they are associated with.
   - **Profiles and Associated Access Groups**: Lists User Profiles and the Access Groups, Filers and Departments they are associated with.
   - **Access Group Detail**: Lists Access Groups and all of the permissions assigned to them.
   - **Detailed Security Report**: Summarizes the User Profiles and Access Groups selected Users are assigned to.
   - **Security Log**: Generates a report based on the security audit trail.

3. All reports offer a print preview option.

5.1.10 Security Access Log

Security Access Log

The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all log-on attempts.

Browse & Manage the Security Access Log

CRS Pro includes predefined queries for sorting access log records including:
   - **All Records**: Default selection that displays all records.
   - **Access for One Date**: Select this query and then enter the date for which you want to show logs.
   - **Access for One User**: Select this query and then click "Select User to Show" to pick a user, or click "Show Records with No Users" for any records with an unknown user.

Export Log-on Records to an Excel spreadsheet:
The Security Access Log tracks all attempts to open CRS Pro. This log can be exported for review in an Excel document:

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click "Manage Security Access Logs".
3. Click on "Export to XML" located near the bottom left.
4. Select a destination folder and click "OK"

Purge Log-on Records
The Security Access Log tracks all attempts to open CRS Pro. If the log becomes so big that the performance of CRS Pro is compromised, older records may be purged. When purging records ONLY
successful log-on's are deleted. To purge records:

1. At the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. At the Browse & Manage the Security Access Log screen click the "Purge Log-on Records" button.
4. The Purge Audit History screen allows the user to indicate the date PRIOR to which log-on records are purged. Modify this date as necessary.
5. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort.
   - All purge attempts are permanently recorded in the log.

5.2 Data Maintenance

5.2.1 Backup Data

Backup Data

CRS Pro backups can automatically copy all data files and compress them into a WinZip format. By default, the software prompts for a daily backup. It is smart to backup your data on a regular basis. If a problem occurs and data files need to be restored, a backup can save time, aggravation and expense!

See Restore Data (via a backup file)

To Modify Backup
1. At the menu bar select File > Security and Administration.
   - Users with restricted Security settings may not have access to this area; such users should consult with their software Administrator.
2. At the Global Administrative Options select "Program Options" > Business Rules and Options > "Preference, Update and Program Options".
3. At the Preferences screen, General tab, refer to the Backing Up Your Data Files subsection.
   - Change the frequency of the backup prompt; "0" or zero for every time the software is exited, "1" for once per day, "2" for every two days, etc.
   - Uncheck the box to disable backup prompts (not recommended).

To Backup Data
Access the Backup Wizard as prompted automatically by CRS Pro (see Modify Backup above). The Backup Wizard application, Backup17.exe, can also be accessed directly through File Explorer. In a standard installation it is located at C:\1099 Pro\ProCRST17\Data Backups. All users must exit the software prior to running the backup.

1. At the Backup Wizard screen click "Next" to proceed.
2. Select Backup Location and File Name and click "Next" to continue:
   - Accept the default location for the backup file or use the ellipses button to select another location such as a network drive or flash drive.
   - The program automatically includes the date and time of the backup file in the default name.
Accept the default name (recommended!) or manually enter a name. The extension of your backup file defaults to .ZIP. **Backup twice to the same file name and the existing backup file will be overwritten!**

3. Review your backup choices and click "Back" to revise or "Proceed with Backup" to continue. This screen details Total [data] Files, Total Size and Estimated Zip Size.

4. The Administrator indicates if backup was successful.
   - Use WinZip (a shareware utility) to access your backup data. Download it at [www.winzip.com](http://www.winzip.com).

### 5.2.2 Restore Data

**Restore Data**

Users are strongly encouraged to backup data on a regular basis. If data is damaged or destroyed a backup file can quickly restore data. **Restoring a data file means losing ALL changes made since the last backup.** See [Backup Wizard](#).

**To Restore Data**

1. Re-install the software to its BASE version (run the Full Install only). Software downloads are available on the [1099 Pro Wiki](#). Download the appropriate Tax Year and Version. Consult Technical Support with questions.

2. Locate your .ZIP backup file (e.g., "CRS Pro Backup 9-AUG-2017 9-38AM.ZIP") which in a standard installation is located in the Data Backups folder (i.e., C:\1099 Pro\ProCRST17\Data Backups).

3. Double-click the .ZIP file to open the WinZip utility and then extract the contents of this backup file—.TPS (data) files—to your Data folder (i.e., C:\1099 Pro\ProCRST17\Data).
   - Learn more about WinZip.

4. Open your software and run a [Form Counts by Filer](#) report to verify accuracy of restored data.

5. After successfully restoring your data, update your software to its most recent version.

### 5.2.3 Roll Forward Utility

**Roll Forward**

CRS Pro software allows users to roll forward 2016 Filer/Reporting FI information (including name, TIN and address) and optionally Security settings and customized Import Maps. Rolled forward Filer data is available at the [Filer Master List](#) screen for viewing or changes.

**How to Select Filers AFTER Roll Forward**

- **Select Filers:** Use the "Select Another Filer" button, located at the top of the task panel, to switch between Filers.

**IMPORTANT:** To roll forward data does NOT mean to copy 2016 tax form specific information such as dollar amounts into the new 2017 installation. The exception is Corporate Suite — a multi-year software
How To Roll Forward Data

Users can roll forward their prior year data during the Installation Wizard (Image 1) or from the Windows Start Menu > CRS Pro > Roll 2016 Data to 2017 Software. The roll forward utility is unavailable if any Filer data has been added into the 2017 software; perform the roll forward PRIOR to entering or importing any data into the software. To perform a roll forward AFTER adding data, users must uninstall the 2017 software and then perform a fresh installation.

(Image 1 - Roll Forward data option available through initial Installation Wizard.)

Preferences

Preference items allow the customization of CRS Pro software. Any user with access to Security and Administration can modify preferences. Changes made at the Preferences screen are universal to the program; not specific to the user. In multi-user environments, Administrators may opt to restrict user access to this area by setting permissions within Access Groups.

To Modify Preferences

1. At the menu bar select File > Security and Administration.

2. At the Global Administrative Options screen select "Program Options" > Business Rules and Options > "Preference, Update and Program Options".

See File Not Found: Information Request Error
3. At the Preferences screen, tabs include; General, General (More) and Checking for Updates. Many items are checked "ON" by default with the intention to help safeguard user data. Functions may be set "OFF" or "ON" at the user's discretion by inserting or removing a check in the corresponding box.

4. Changes take place after clicking "OK" and then exiting and re-opening the software.

Preferences Options

Overall Options
Auto capitalize names, addresses and localities during manual entry.

Backing Up Data Files
Remind me to backup every X days. Users are strongly encouraged to backup data on a regular basis. To backup once per day enter "1", every two days enter "2", etc. Set to zero to backup every time the program is exited.

Global Date Range Checking*
Warn if dates entered on forms are outside of this range. Set dates are within the respective tax year. Dates may be modified by clicking the ellipses buttons.
- Date is before 1/01/2017 (default entry)
- Date is after 12/31/2017 (default entry)

Options for Manually DELETED Tax Forms
- Allow previously deleted tax forms to be visible at the Work With My Tax Form screen.
- Allow users to undelete previously deleted tax forms. This feature is not available in CRS Pro.

Recipient Address ZIP Code/City Options
- Convert City to UPPER case during manual entry ZIP lookups
- Always convert Recipient City to UPPER case during printing

Other Options
- Automatically reselect the last Filer at program start

Checking for Updates
- Ask for confirmation every time before checking for updates. Only uncheck this box if your Internet connection is always on. When an update is available, users are always prompted prior to download/installation, regardless of the status of this box.
- How often should program check for updates:
  - Automatic Adjustment (recommended) - The program will check for updates occasionally during summer, more frequently as tax season approaches and every day at the height of tax season.
  - Specified Interval (1 - 45 days) Throughout the Year - Checks will occur at the interval specified here.
  - Manual Checking Only
  - See Software Updates

5.4 Hosted Solutions

Hosted Solutions

Full Service and Limited Service hosting is available for a fee through Data Processing Solutions (DPS).
All hosting solutions include the application running at DPS's secure facilities and your users access to the software via secure Internet connections. See the diagram below which shows the relationship in how data is shared between both your company and our hosting provider, DPS.

Full Service includes all aspects including Importing, Error Reports, Filings, Corrections, etc. DPS is the premier hosting solution with extensive experience in the Insurance, Banking, Oil & Gas and Financial Industries.

For more information visit our site at http://www.1099pro.com/serv_Hosting.asp or contact:

1099 Pro, Inc.
Hosting Services
23901 Calabasas Road, Suite 2080
Calabasas, CA 91302
Tel: (866) 444-3559
Fax: (818) 876-0202
E-Mail: Hosting Department

6 Audit Trails

Audit Trails Overview

Audit Trails DO NOT track the history of manual and cascading changes to a tax form including old and new values, date changed and the user responsible for changes. NOTE: If Audit Trail Records don't reflect a known change; Audit Trails are (or were) disabled.

Master Audit Trail Browser
The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to CRS forms (the Record History screen allows...
the viewing of individual tax forms only).
See Master Audit Trail Browser.

About Record History
The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record. Cascading updates are not reflected.
See Record History for more information

Purging Audit Trail Logs
The Audit Trail Record Log is invaluable should you need to track tax forms changes. If the log becomes so big that the performance of CRS Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.
See Purging Audit Trail Logs for more information.

Enabling/Disabling Audit Trails
Disable Audit Trails only if speed/performance is critical to the user. By disabling this feature tax form changes are not tracked AND the Record History screen is automatically disabled.
See Enabling/Disabling Audit Trails

6.1 Audit Trails Activity Report

Audit Trails Activity Report

Generate a report detailing specified audit trail activity in your CRS Pro installation.

1. On the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen select "Audit Trails & Logging" and the "View/Print Audit Changes Report" button.
3. Options at the Specify Audit Trail Filters screen include:
   o Limit Report to Changes by PCode: All or Select Individually
   o Limit Report to Changes from Users or Workstations
   o Limit Report to Date Ranges
   o Record Activity Options: All Activity, All but Views, Only Deleted
4. Click the "OK" button to initiate the report.
5. The Admin prompts, to preview the report.
   o Click "Yes" to open in preview mode.
   o Click "No" to send the report directly to the printer.
   o Click "Cancel" to exit the report.

Audit Trail Activity Report Legend:
T = TIN (Tax ID Number)
N = Name
A = Account (#)

Old values are on the left
New values are on the right
6.2 Deleted Record Detail

Deleted Record Detail

From the Master Audit Trail Browser, click the "Deleted Record Details" button to display the contents of a deleted tax record. NOTE: The Master Audit Trail Browser will not reflect records that were deleted while Audit Trails were disabled.

See Master Audit Trail Browser

6.3 Master Audit Trail Browser

Master Audit Trail Browser

The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the Record History screen allows the viewing of individual tax forms only).

To View Records
1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Audit Trails & Logging", "View Audit Trail Records".
3. At the Master Audit Trail Browser screen refer to the Date, Time, User ID, Field Name, Old Value and New Value columns for invaluable information.

6.4 Purge

Purge Audit Trail Log Records

The Audit Trail Record Log is an invaluable tool for tracking tax forms changes. If the log becomes so big that the performance of CRS Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.

To purge audit trail log
1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Purge Audit Trail Records".
3. At the Purge Tax Data Audit Trail Record screen all records prior to the selected date are deleted. Modify this date as necessary.
4. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort.

6.5 Record History

Record History
The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record. Cascading updates are not reflected. **NOTE:** If Record History does not reflect a known change to a form, Audit Trails are, or were, disabled.

To learn more See Viewing Record History and Enabling & Disabling Audit Trails.

### 6.6 Turn Audit Trails On/Off

#### Turn Audit Trails On/Off

Disable Audit Trails only if speed/performance is critical to the user. By disabling this feature tax form changes are not tracked AND the Record History screen is automatically disabled.

**To turn audit trails On/Off**
1. On the menu bar select File > Security and Administration.
2. The Administration screen indicates if Audit Trails are on or off.
   - Click "Activate Audit Trails" to turn on functionality.
   - Click "Turn OFF Audit Trails" to turn off functionality.

**To view record history**
At the “Work with My Tax Forms” screen highlight a record and click "Change".
- Records with a pending print status display the Changing a Record screen. Click the "Audit Trail" button located in the upper right corner of the screen.
- Records with any other print status display the Protected Form Update screen. Click the "Field Update History" button.

### 6.7 Audit Trail Report Filters

#### Audit Trail Report Filters

Use to generate an audit trail detail report.

**To Set Filters**
1. On the menu bar select File > Security and Administration > Global Administrative Options > **Audit Trails and Logging**.
2. At the Tax Form Audit Trail and Action Logging Options window select "View/Print Audit Changes Report".

3. At the Audit Trail Report Filters screen select options to filter data for the Audit Trail report. Options include:
   - **Limit Report to changes for one Form Type**
     - **All Forms**: Default selection.
     - **One Form Type (select from list)**: This option is not available in CRS Pro.
   - **Limit Report to changes for one PCode**: A large range of filers can generate a very large and slow to process report; users are encouraged to run reports for individual filers.
     - **All Filers**: This default selection displays all Filer Names and PCodes on the report.
• One Filer (Select from list): Use to select a Filer, by PCode, to include on the report.
  o Limit Report to changes from one User ID or Workstation
    • All Users: This default selection displays all UserID's on the report.
    • One Workstation (enter): Choosing this option will allow you to choose which UserID will be used to filter down your report.
  o Limit Report to a Date Range
    • None - all dates will be shown:
    • Today: This default selection displays all changes made today.
    • Last 7 days: Displays all changes made within the last 7 days.
    • Last 14 days: Displays all changes made within the last 14 days.
    • Last 30 days: Displays all changes made within the last 30 days.
    • Specify Other Range: Displays all changes made within a specified date range. (P1)

4. Click the "OK" button to generate report.

5. Now you will be given the option PREVIEW your report before it is printed. Click "Yes" if you would like to view the report before it actually prints out. Click "NO" to have the report begin printing or click "Cancel" to change your options before you begin printing your report.

7 Browse Filers

Browse Filers

Use the Filer Master List screen to view/sort filers and Add, Change or Delete filers. To quickly jump
between existing filers use the Select Another Filer button.

Filer Highlights
- CRS Pro accepts multiple filers with one TIN. This is useful for companies that issue forms from multiple departments or for batch processors.
- CRS Pro allows US, Canadian and foreign filers.

See Filer Record Details for a thorough explanation on each filer specific field.

Views and Queries
- Current Sort/View Order: Users can sort filers by Filer PCode or TIN.
- Current Query/Filter: By default all filers are displayed. Use the "Current Query" drop menu to create custom queries, e.g., "Address Type Code = Other Foreign", etc.

Add a Filer
CRS Pro allows unlimited filers.
See Adding a Filer

Change a Filer
Changes made to a filer affect only records with a Pending status. To switch between existing filers use the Select Filer button.
See Changing a Filer

Delete a Filer
A filer can only be deleted if it is NOT associated with any recipient records.
See Deleting a Filer

Run Filer Report
The Filer/Employer/Payer Listing provides detailed information on filers including Name, TIN, Contact Information, State ID Numbers and a history of any address changes.
See Running Filer Reports

Select a Filer
Use the Select Filer screen to select a filer.
See Selecting a Filer

Tag Filers
CRS Pro allows users to manually tag (select) filers for inclusion in a print session.
See Tagging Filers

7.1 Add a Filer

Add a Filer/Reporting FI

CRS Pro allows users to create XML in the Common Reporting Standard for an Entity (sometimes referred to as a Reporting FI) for transmission to a Country (sometimes called a Jurisdiction). CRS Pro refers to the combination of a Reporting FI and the Country to report to as a FILER. CRS Pro allows unlimited filers.
ALL data in each FILER is reported to only one Country/Jurisdiction in the XML Report. When submitting an XML file for one Reporting FI for a Jurisdiction, the information in your XML file may be shared appropriately with other countries as per the Automatic Exchange Portal's Activated Exchange Relationships.

*Please visit https://www.1099pro.com/videos.asp and view the "How to Add a Filer" video for a brief tutorial on the Filer process.

Add a Filer/Reporting FI
1. From the menu bar select File > Filers (Withholding Agents).
2. At the Filer Master List screen click "Add".
3. At the Adding a Filer Record screen complete all fields and click "OK" to save the filer.

☐ See Filer Record Details for a thorough explanation on each entry field.

7.2 Change a Filer

Change a Filer

Changes made to a Filer only apply to records with a Pending status. To switch between existing filers use the Select Another Filer button.

To Change a Filer
1. From the menu bar select File > Filer /Reporting FI.
2. At the Filer Master List screen click "Change".
3. At the Changing a Filer Record screen make changes and click "OK".
4. The Administrator prompts to update all pending records with the new filer information. Click "Yes" to update filer or "Cancel" to abort changes and exit the screen.

☐ See Filer Record Details for a thorough explanation of each entry field.

7.3 Delete a Filer

Delete a Filer

A filer can only be deleted if it is NOT associated with any recipient records.

To Delete a Filer
1. From the menu bar select File > Filer List.
2. At the Filer Master List screen highlight the filer and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the filer or "No" to cancel.
7.4 Filer Record Details

Filer Record Details

A “Filer” is the unique combination of the Jurisdiction (or country) being reported to AND the associated Reporting Financial Institution (or entity). **A Filer contains information for only one Jurisdiction and one Reporting FI.** For example, if ABC Bank has physical branches in Germany (DE) and France (FR), create one Filer ABC Bank to report DE based accounts to DE and a second Filer ABC Bank to report FR based accounts to FR. The key to differentiating these Filers is the required Payer Code field.

**General Tab**

**Jurisdictions**
- Receiving Country: The country (or Jurisdiction) receiving the account holder data.
- Sending Country: The country (or Jurisdiction) sending the account holder data.

**Filer Identification Number**
This is the Reporting FI's identification number and could be a US GIIN, TIN, company registration number, Global Entity Identification Number or other similar identifying number specified by the tax administration. Additional identification numbers can be added if necessary.

**Payer Code—REQUIRED**
Users typically enter an abbreviated, descriptive Filer name in this field. For example, use “DE_ABC” to represent the German branch of ABC Bank and “FR_ABC” to represent the French branch. Use the Receiving Country Code as the first two characters of the Payer Code to make the XML reporting process more organized. Payer codes must be unique and are for the user's internal reference only.

If the PCode contains any of the following characters, \ / : * " < > |#, they are stripped from the XML file name.

**Filer Name**
This is the Reporting FI's legal name. The corresponding Name Type code is an optional field.

**Filer Contact**
At least one contact is required and only one may be selected as the default for each Filer. The Filer Department is for internal purposes.

**Advanced Filer Options**

**Prefix Override:** The default prefix for a Filer's XML file name is composed of the Sending Country Code + Year for the Data + Receiving Country Code. Thus, if France sends data to Germany for TY 2016, the default prefix would be FR2016DE. If an XML file name must start with a different character string enter it in this field and indicate if it should be used for the FileName, MessageRefID and/or DocRefID fields.
- Jurisdictions may have unique XML specifications such as requiring the FI Identification Number in the file name field.

**NIL Reporting**
Select the "Filer is used ONLY for NIL reporting" checkbox for those Filers who have reviewed their client data and determined there is no data to report. For details see "Subparagraph C(17) – Excluded Account" in the OECD's Standard for Automatic Exchange of Financial Account Information in Tax Matters, 2nd Edition. **Only NIL Filers can create a NIL Report.** This checkbox is not available if
editing a filer with existing data.

**Address Tab**
Displays Filer country code(s) and address information.

### 7.5 Contact Persons

**Contact Information**

At the Filer Record screen add or edit a Contact Person, Department and Phone Number. This contact information documents who has responsibility for this Filer / Reporting FI. **At least one contact is required.**

**To Add/Edit Contacts**
1. On the **menu bar** select File > Filers List.
2. At the Filer Master List screen highlight a filer and click the "Change" button.
3. At the Filer Record screen (General tab) use the "Add", "Change" or "Delete" buttons as appropriate.
   - Dept. Code - The filer's internal reference such as AP, Sales, HR, LA Office, NY Office, etc. A maximum of 15 characters is allowed.
   - Default - Only one contact may be selected as default.
4. Use the "Save" button to save changes or "Cancel" to abort changes and exit.

### 7.6 Filer Reports

**Filers List Report**

The Filer Listing provides detailed Filer specific information including Name, TIN, Contact Information and a history of any address changes. All filers are automatically included in the report.

- See Summary of Forms Issued by Filer report for a detail of forms issued by filer including Form Counts, Recipient Name / TIN / Address and each record's respective status.

**To Run Filers List Report**
1. From the **menu bar** select File > Filers.
2. At the Filer Master List screen click "Run Filer Report".
3. The Administrator prompts to "Print One Filer Per Page" and **preview** the report. Select as appropriate.

### 7.7 Tag Filers

**Tag Filers**

CRS Pro allows users to manually tag (or select) filers for inclusion in various processes.
Tag Key Shortcuts
- **Tag**: Use this button (or ALT + T) to tag individual filers.
- **Tag All**: Use this button (or ALT + A) to tag all filers.
- **Untag**: Use this button (or ALT + U) to untag an individual filer.
- **Untag All**: Use this button to untag all filers.
- **Flip**: Use this button (or ALT + F) to reverse the tag status of an individual filer.
- **Flip All**: Use this button (or ALT + L) to reverse the tag status of all filers. For example, if there are three filers and only one filer is tagged, the Flip All button will tag the two previously untagged filers and untag the original filer.
- **Prev Tag**: Use this button (or ALT + P) to scroll backwards through tagged filers.
- **Next Tag**: Use this button (or ALT + N) to scroll forwards through tagged filers.

8 Work With My Tax Forms

Work With My Tax Forms

The Work With My Tax Forms screen (sometimes referred to as the Enter, Update and View screen) provides direct access to Account Holder records. This screen allows users to View, Change and Delete forms and perform Group Actions. See Form Entry Screen.

Access the Work With My Tax Forms Screen via the Preparing My Forms task panel > Work With My Tax Forms.

Sort By Options
- **Current Sort/View Order** - Users can sort forms by Last Name/Company, TIN, Account or by creating a custom view. See Current Sort/View Order for further details. There are two ways to search for a form; one from the keyboard depending on your sort order and one by using your mouse.

- **Current Query/Filter** - By default all forms for the form type selected are displayed. Users can display a subset of the current form type by clicking on the "Current Query" drop down and use an alternate ready-made query, e.g. "Filed Corrections Only" or create their own custom query, e.g. "Tax State = CA, Corrected Forms Only", etc. Note that the "Status" of a form can be used to create powerful queries to limit the records displayed. For example, if two batches of forms were imported - one with a Pending status and the other a Printed status - you could limit the forms displayed by their respective status.

Add CRS Form
CRS Pro allows forms to be added (either manually or via import) up to the user's current transaction limit. Transactions can range from 1,000 in a standard purchase to an unlimited number of transactions. —See CRS Forms and Registration & Upgrades

Change a CRS Form
Only forms with a Pending status are available for modification. **Note**: Cascading updates are changes made to a filer's information globally throughout all CRS forms. —See Cascading Changes and CRS Forms
Delete a CRS Form
Only forms with a Pending status are available for deletion. Delete forms individually at this screen or in batch via Group Actions.
—See CRS Forms and Group Actions

Print/View Report
This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report).
—See Print/View Reports

Group Actions Button
Group Actions allow users to tag (or select) a number of items and then perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of pending forms allows the user to manually select any number of pending forms for removal. All associated notes for the forms are likewise deleted.
—See Group Actions

Browse By Form Button
The “Browse By Form” button allows users to initiate browsing CRS forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as if you were using the standard browse. For example, if viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when you switch to Browse by Form mode.
—See Browsing By Form

8.1 Form Entry Screen

Form Entry Screen

The Form Entry screen is used to view, add or edit CRS form information. Review the Entry Screen Overview and then CRS field specific information below.

Entry Screen Overview

Navigating Fields / Filling In Boxes
Use the TAB key to move through fields on the tax form. To move backwards through fields use the SHIFT and TAB keys concurrently. To select/unselect a check box use the space bar and then TAB to the next field.

Updates and Corrections
Make necessary changes, additions or deletions to the form and click the "Save" button to exit and return to the Enter, Update & View screen. Any changed values or amounts turn blue to distinguish between original and adjusted information. The "Correction" and "Void Form" check boxes cannot be manually marked at this screen. See Correct a Form.
What Is a Protected Form?
A form with any status other than Pending is protected or locked to prevent any mismatch of data from the original record that has transmitted via an XML file. This includes forms with a status of XML Filed. It is also possible that these forms were imported in a status other than Pending, in which case they would also be considered protected until they are Reset (VOIDED). Only forms with a Pending status can be changed or deleted.

Viewing Manual Changes to a Form
CRS Pro tracks all manual changes to a form and can be viewed at the Changing a Record screen via the "History" button.

Saving / Saving Not Available
Save any changes to a form immediately via the "Save" button. Error checks are automatically performed on any saved form and the form cannot be saved if it is missing certain elements required for XML schema validation. Some of CRS Pro's errors come from validations against the OECD XML Schema such as an Account Balance or Payment Amount also require a Currency Code. Other errors come from the Standard for Automatic Exchange of Financial Account Information in Tax Matters, 2nd Edition.

If your accounting or legal department indicates a condition is NOT an error for the jurisdiction being reported to, users can disable the error at the Business Rules Validation screen. Changes at this screen are global to the software and impact all data for all Filers.

Account Holder Section
The top section of the Form Entry screen displays the Filer/PCode and specific Account Holder information. At a minimum, the Account Number and Account Holder Type fields are REQUIRED. Acceptable Account Holder Type codes are specified in the Import File Conventions.

Additional Fields
The bottom section of the Form Entry screen is composed of five tabs including Name and Address, TIN/IN and Country, Birth Information, Payments and Controlling Person.
Name and Address Tab
Numerous names and addresses are allowed as illustrated in the above image.

TIN/IN and Country Tab
A person can have multiple TIN's and an Entity/Organisation can have several IN's (Identification Numbers).

Birth Information Tab

Payments Tab

Controlling Person Tab
Multiple controlling persons are allowed and each controlling person can have multiple Names/Addresses/TINs/Countries associated with them.

8.2 CRS Forms: Add, Change, Delete

CRS Forms: Add, Change or Delete

A standard installation of CRS Pro allows up to 1,000 CRS forms; bump codes can be purchased at any time.

Add a Form
Please visit https://www.1099pro.com/videos.asp and select the "How to Add a Form" video for a brief tutorial on the process.

To Add a Form
1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.
2. At the Enter, Update and View screen click "Add" to access the Adding a Form CRS Record screen.
3. After completing all fields click "Save". The record is saved and a blank screen is presented for your next record. Click "Cancel" to exit the Adding a Form Record screen.
Change a Form
Only forms with a Pending status are available for modification.

To Change a Form
1. At the Preparing My Tax Forms task panel click the "Work With My Tax Forms" link.
2. At the Enter, Update and View screen highlight the appropriate form and click "Change" (or double-click) to access the Changing a Form screen.
3. Make necessary changes and click "Save".

Delete a Form
Only forms with a Pending status can be deleted. Deleted forms can be viewed at the Work With My Tax Form screen (see View Deleted Records below).

To Delete a Form
1. At the Enter, Update and View screen highlight the record and click "Delete".
2. The Administrator prompts to confirm the deletion. Click "Yes" to delete the record or "No" to cancel.

To View Deleted Forms
Deleted forms are available for audit trail purposes and can be viewed only. Deleted forms cannot be undeleted.
1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen select "Program Options" > "Preference, Update and Program Options".
3. At the Preferences screen, General tab, under Options for Manually DELETED Tax Forms select the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox.
4. Click "OK" to save changes.
5. Return to the Enter, Update and View screen to view deleted tax records.

8.3 Form Status Overview

Form Status Overview

Records with a Filed XML status are "protected" from edits. Use the Protected Form Update Options screen to access these records. Available update options vary according to the record's status.

Protected Form Update Options screen
Use this screen to access protected records for viewing or generating corrections.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.
2. Highlight any record with a Filed XML status.
3. Click the "Change" button to display the Protected Form Update Options screen.

<table>
<thead>
<tr>
<th>Record</th>
<th>Available Options</th>
</tr>
</thead>
</table>
### Status

**Pending**
These forms are ready to generate XML files. Users can view, change, delete the form or include it in an XML file.

**Deleted**
These forms have been deleted and cannot be un-deleted. Users may view the form.

**Filed XML**
This record has been included in an XML file.

**Corr/XML**
This record has been corrected and included in an XML file.

#### Create Corrections
Refer to About Corrections and Create Corrections - A Tutorial

### 8.4 Browsing by Form

**Browsing By Form**

The Work With My Tax Forms screen offers the ability to browse all tax forms (by the same filer) using the update form. This allows the user to quickly move from form-to-form and view data.

**To Browse By Form**

1. On the **Preparing My Forms** task panel click the "Work With My Tax Forms" link.
2. At the Enter, Update and View screen select the individual form to start browsing at.
3. Click the "Browse By Form" button located at the bottom center of the screen.
   - Use the **PageUp** ("pgup") and **PageDown** ("pgdn") keys to move forwards/backwards through the forms.
   - If a form has a protected status (XML Filed, etc.) users may only VIEW the form.
   - Forms with a Pending status are available for EDITS. To continue browsing forms after making changes to a Pending form, simply press the PageUp/PageDown keys to continue.
4. To exit the Browse By Form feature use the Escape ("esc") key on your keyboard or click the "Cancel" button on the tax form.

**NOTE:** When using Browse by Form, the current View and Query settings remain in effect, just as when using the standard browse. For example, if viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when switching to Browse by Form mode.

### 8.5 Group Actions

**Group Actions**

The "Group Actions" button is located at the bottom of the Work With My Tax Forms screen and provides direct access to the following options:
8.6 Browse Notes/Attachments

Browse Notes

All forms and filers have a "Notes" button allowing users to create and update notes for that item.

Considerations:
- When in a data entry screen, the "Notes" button changes to "Has Notes" once it contains any information.
- Each note can contain up to 512 characters, and an unlimited number of notes are allowed for each item.
- Every time a note is created or updated, the note displays the date and time of the action and either the User ID of the person who made the change (if you have Security turned on) or the network name/ID of the machine where the change was made.
- Depending on the type of note, you may be able to view and update them from multiple places within the program.

Global Notes
These are visible everywhere within the program, and can be viewed and updated from every Notes browse. Global Notes can also be directly entered via the menu bar > File > Global Notes.

Filer Notes
Filer notes are associated with a specific Filer, and are only available on the update form for that Filer.

Tax Form Notes
These notes are attached to a specific tax form. When entering notes for a tax form, you can also view/update all Global notes.
8.6.1 Update Notes

Update Notes

This screen allows users to add or modify notes. Please see Browse Notes/Attachments for all available note types.

8.7 GIIN Validation

GIIN Validation

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI's jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI's FATCA Registration is submitted and approved.

The Internal Revenue Service (IRS) Automatically validates a Global Intermediary Identification Number (GIIN) against the most up to date IRS information. A GIIN is a 19 digit identification number that is instrumental in the United States' new FATCA legislation. Any Foreign Financial Institution (FFI) will undoubtedly need to validate all GIIN information before reporting the upcoming FATCA Form 8966.

See GIIN Composition & Formatting

8.8 GIIN Composition

GIIN Composition

☐ Enter a Filer/Reporting FI's GIIN at the Add a Filer screen.
☐ See FATCA Identification Number.

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI's jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI's FATCA Registration is submitted and approved.

GIIN Formatting Overview
The GIIN is a 19-character identification number, in the XXXXXXX.XXXXX.XX.XXX format, that is a composite of several other identifiers. These identifiers include the following:

- Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI's online FATCA account. For all FIs other than Member FIs, the FATCA ID is a
randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI's FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. **The FATCA ID is not the same as the GIIN.**

- The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

- The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

- The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

### Global Intermediary Identification Number (GIIN) Composition Format:

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>No. of char</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>FATCA ID (first six characters)</td>
<td>6</td>
<td>1-6</td>
<td>Alphanumeric upper case only. For all Financial Institutions, this is the same as the first 6 characters of the FATCA ID. For leads and singles, this is your FATCA ID. For members, this is just the first six characters. (First 6 characters of any Financial Institution’s FATCA ID are randomly generated and will never use the letter “O”.)</td>
</tr>
<tr>
<td>Separator 1</td>
<td>1</td>
<td>7</td>
<td>Period = .</td>
</tr>
<tr>
<td>Financial Institution Type</td>
<td>5</td>
<td>8-12</td>
<td>Alphanumeric upper case only. Lead = 00000. Sponsoring Entity = 00000. Single = 99999. Member = Same as the last 5 characters of the Member FIs FATCA ID (sequential, starting from 00001 and going to 99998, then A0000 – ZZZZZ; will never use the letter “O”.)</td>
</tr>
</tbody>
</table>
### Character Representation:

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>No. of char</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separator 2</td>
<td>1</td>
<td>13</td>
<td>Period = .</td>
</tr>
<tr>
<td>XX</td>
<td>2</td>
<td>14-15</td>
<td>Alpha upper case only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Based on Financial</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Institution or Branch</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>category</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LE = Lead</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SL = Single</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ME = Member</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BR = Branch (the first</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>thirteen characters of a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>branch’s GIIN will match</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the first thirteen</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>characters of the GIIN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>of the Financial</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Institution with which the branch is</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>associated)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SP = Sponsoring Entity</td>
</tr>
<tr>
<td>Category Code</td>
<td>2</td>
<td>14-15</td>
<td>Alpha upper case only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Based on Financial</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Institution or Branch</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>category</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LE = Lead</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SL = Single</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ME = Member</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LE = Lead</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SL = Single</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ME = Member</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BR = Branch (the first</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>thirteen characters of a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>branch’s GIIN will match</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the first thirteen</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>characters of the GIIN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>of the Financial</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Institution with which the branch is</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>associated)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SP = Sponsoring Entity</td>
</tr>
</tbody>
</table>

| Separator 3              | 1           | 16       | Period = .           |
| XXX                      | 3           | 17-19    | Numeric              |
| Country Identifier       |             |          | ISO 3166-1 numeric   |
|                          |             |          | standard country code of |
|                          |             |          | the Financial Institution or |
|                          |             |          | branch                  |
|                          |             |          | NOTE: Use 999 for      |
|                          |             |          | country code “Other”    |

### 8.9 Capitalization

**Capitalization**

CRS Pro capitalizes the first letter of names and addresses during manual data entry. This is a modifiable default preference setting.

**Please note:**
- Account number and free form text fields have no special formatting.
- State abbreviations are forced uppercase.

### 8.10 Cascading Changes

**Cascading Changes**

**What are Cascading changes?**

When making manual changes to the Filer Master List in CRS Pro, those changes are then cascaded or (updated) throughout all tax forms with a Pending status. Cascading updates help ensure that ALL filer and recipient information, regardless of the tax form, is quickly and uniformly synchronized.

**When does the cascading of those changes take place?**

After making changes to a filer, click the “Save” button. The Administrator prompts to “Update all
Pending forms with the new information? Click "Yes" to update all pending forms associated with the filer, or "No" to update only the selected filer.

To update filer information for tax forms with statuses other than Pending (i.e., XML Filed.), the user must manually reset the form's status back to Pending. The cascading changes automatically and immediately take effect.

I made prior changes to a tax form and now I am being prompted with a window "Recipient Record may need updating" or "Possible Recipient Information Mismatch." What do I do now? CRS Pro prompts the user to update or synchronize changes if it sees that the existing recipient information does not correspond with the master recipient database. It will continue to do this for all consecutive tax forms that require updating. Click "Yes" to apply the changes or "No" to not make any changes. The same applies to changes made to filer and contact information, as well as manual changes made directly to the Recipient Master list.

8.11 Options for Tax Form Data Entry

Options for Tax Form Data Entry

CRS Pro contains data entry options accessible at the Form Entry screen. Inactive buttons in this list indicate the form is not available for edits.

- **History**: This screen displays record history information for the selected tax form
- **Notes**: Allows users to View, Add, Update and Delete Notes for this tax form. After entering Notes the button changes to "Has Notes" with **BOLD** text to indicate that notes now exist for this form. For more help on Notes, See Browse Notes.
- **Check Form**: Check form against existing business rule validations.
- **OECD CRS Instructions**: Access general instructions.
- **Help**: Provides help with the current screen.

8.12 Print/View Reports

Print/View Reports

**How to Print/View Reports**
1. At the "Work with My Tax Forms" screen click the "Print/View Report" button.
2. The Administrator prompts to use the current query if one is selected at the Work With My Tax
Forms screen. If a query is not selected, the Administrator asks "Which Forms To Include?"
Options include:
- (1) All - Generates a standard Control Totals report
- (2) Query - Allows the user to select a previously saved query or create a new query
- (3) Selected - Generates a report for the highlighted record at the Work With My Tax Forms
  screen
- Cancel - Cancel and exit the report

See Control Totals Report

8.13 Search

Search

Use the Search field to quickly locate a Filer.

To Search (AKA Incremental Index)
1. Set the Current View to the correct sort order criteria (i.e. By TIN)
2. At the Browse the Filers screen, place your cursor in the Search field.
3. Enter the first few characters of your search criteria and hit the TAB key.
   - The browse screen highlights the record matching your entry. If multiple records match your entry
   the screen highlights the first match. Use the ARROW keys to scroll through the matches.
   - The Search results are governed according to the column sort order. (i.e. If searching by Last Name/
   Company, and you search the last name of Charlie Tuna in ascending order by typing in the letters
   "T" then "U"... in the search field then hit the TAB key, the search results listed are displayed with
   Charlie Tuna's last name.) If searching by Recipient TIN and you're sort order is set in ascending
   order then your search results are going to be listed in numeric order from beginning to end for this
   column only. This same method and result applies to all respective columns.

Note: For a quick form lookup without using you mouse, type the first few numbers of the TIN (assumes
the sort order is by TIN) and you will drop down to that particular record, if your sort order is by another
field (Last Name or Account ...) then type the first few characters you of the field to drop down to that
record. To use the "Search ..." box you must click in the box, type your characters and hit the Tab key.

8.14 Tagging Records

Tagging Records

CRS Pro allows users to manually tag (or select) records for inclusion various processes.

Tag Key Shortcuts
- Tag: Use this button (or ALT + T) to tag individual records.
- Tag All: Use this button (or ALT + A) to tag all records.
- Untag: Use this button (or ALT + U) to untag an individual record.
- Untag All: Use this button to untag all records.
- Flip: Use this button (or ALT + F) to reverse the tag status of an individual record.
- Flip All: Use this button (or ALT + L) to reverse the tag status of all records. For example, if there
are three records and only one record is tagged, the Flip All button will tag the two previously untagged records and untag the original record.

- **Prev Tag**: Use this button (or ALT + P) to scroll backwards through tagged records.
- **Next Tag**: Use this button (or ALT + N) to scroll forwards through tagged records.

### 8.15 Zip Code Lookup

**Zip Code Lookup**

CRS Pro allows users to quickly find or verify zip codes, cities, and states within the USA. The Zip Code Lookup feature:

- Includes every 5 digit ZIP code in the USA.
- Includes FPO (Fleet Post Office) and APO (Army Post Office) ZIP codes.
- Allows you to search by city, state, or ZIP code.
- Contains current ZIP code data.

Zip Codes can be looked up from either the City field (shows all matching cities) or the zip field (more precise, shows matching zips.) If you type a partial city or zip and then invoke the pop up, the list will start at the closest approximation. This database includes all zip codes and cities accepted by the United States Postal Service. The USPS currently recognizes all United States ZIP codes by either their preferred or alternate city names.

**USPS Codes**:
- **P** = Preferred City Name (Example: Philadelphia, 19101)
- **A** = Alternate (Example: Phila, 19101)

**Tip**

Right-click on the City or Zip Code fields to pull up the list of cities in the U.S. Or type in the name of the City or Zip code in the search field. As you type, the software will narrow down the closest match based on your entry. A third tab, By State, allows users to type in the abbreviation of the state to match the zip code searched for.
9 Imports Overview

Import Overview

CRS Pro features a powerful, intuitive Import Wizard to simplify the process of importing your data. Generally, users who can access their data in Excel (or a similar product) can import it! Importing delimited data is easiest; however, users may also import Fixed Length files such as those created for the IRS. The Microsoft applications Excel, Access and SQL allow data to be saved in a .TXT format (see Converting Excel Formats); whereas older applications allow data to be saved in a .CSV (comma separated values) format.

All software installations include sample import files. Users who review the sample import files and include our Header Records have great success with their imports! See Sample Import Files and Import File Conventions.

Error and Validation Checking is automatically performed on all imports; thereby allowing users the opportunity to find and fix any problem records before importing into the software.

See Reset (Void) Import Session

Import Wizard Steps

Step 1: Importing Data - Begin the import process.

Step 2: Validating Data - Test data for errors and warnings.

Step 3: Post Results - Post imported data for access at the Work With My Tax Forms screen.
9.1 Import Data

Import Data

CRS Pro features a user-friendly Import Wizard to simplify the import routine. Many database and spreadsheet applications such as Microsoft Excel, Access and Lotus 1-2-3 provide for the exporting of data to an ASCII file. These files can be imported into CRS Pro, thus relieving the burden of manually entering the information onto the tax form.

- Import Maps for a Delimited or Excel File Type

See Import Wizard.

9.1.1 *SAMPLE IMPORT FILES*

Sample Import Files

All CRS Pro software installations include sample import files (also referred to as XLS Data Shells). Users are strongly encouraged to review the sample import files included in our software and available, in a standard installation, at C:\1099 Pro\ProCRST17\Import\Samples. Users who review the sample import files and include our Header Records have great success with their imports!

- Please review Import File Conventions.
- For customers not interested in using our Header Records or for information on importing Delimited File Types, see Import Maps for a Delimited File Type, or Excel.

Instructions for an Easy Import

Users who review our sample import files PRIOR to creating theirs and include our exact Header Records (the respective field names) have great success with their imports. Follow these steps:

1. Access the Import folder, which in a standard installation is located at C:\1099 Pro\ProCRST17\.

2. In the Import folder, double-click on the Sample XLS Files folder to view available sample import files.
   - Import_CRS_MultipleTabs_Example.xlsx: Contains various worksheets. Only the first worksheet is imported from Excel into CRS Pro: modify your import file accordingly.
     - 1 Line Import P—Simplest import. Each line represents a single CRS reportable account. This example has only 1 Payment, 1 Account Holder Name/Address, and no Controlling Persons.
     - Multiple PMT Import—Import multiple Payments (PMT) associated with a single CRS reportable account.
     - Multiple Name Import—Import multiple Account Holder (AH) names, addresses, TINs, and country codes associated with a single CRS reportable account.
     - Controlling Person Import—Import multiple Controlling Persons (CP) associated with a single CRS reportable account.
     - Full Example ALL Fields—Import ALL of the above examples in a single import file.
     - Types—A complete listing of valid CRS Type Codes and their related definitions.
     - CC—A complete listing of valid CRS Country Codes.
     - Currency—A complete listing of valid CRS Currency Codes.
   - Import_CRS_Example.xlsx
3. Review the sample data and notice the formatting of the TINs, First and Last Names, Foreign Addresses, etc. Review Import File Conventions completely before proceeding. All Excel files contain a second worksheet with form specific guidance on the various fields and data requirements.

4. Copy the Header Records (the first row of data containing the respective field names) onto a new Excel sheet. Then copy your relevant data into the appropriate fields.
   - Do not place a blank row between the Header Records and the start of your data.
   - Do not edit the Header Record descriptions.
   - It is acceptable to delete columns, however doing so will trigger a warning during the import process.

5. Save this excel sheet as a Text (Tab Delimited).TXT file to maintain formatting. This file is ready to be imported into the software.

See Import Wizard - Step 1: Importing Data

9.1.2 Import Wizard

Import Wizard

CRS Pro simplifies the import process with our Import Wizard. The Import Wizard consists of three simple steps that may be done at once or at different times. Nothing is actually imported into the software until all three steps are completed.

☐ See Create An Import File - Please review PRIOR to using the Import Wizard.
☐ See Import Session Summary Report

Import Wizard Steps:
Step 1: Importing Data - Begin the import process.
Step 2: Validating Data - Allows the opportunity to test data for errors and warnings.
Step 3: Post Results - Post imported data for access at Work With My Tax Forms screen.

9.1.2.1 Manage Import Maps

Manage Import Maps

The Browse Screen for Import Map files lists the type of mapping and the file format used for each map. Additional details including Map Notes and Formatting Details are displayed in the Notes section.
To Add a New Map
1. Within the CRS PRO Import Wizard click the "Add/Update Import Maps" button.
2. To add a new map click the "Add" button, select Delimited or Fixed Length as the map type, and follow the steps in the Import Map Wizard.

Change Existing Maps
Users can highlight an existing map on this screen and click "Change". Follow the steps on the screen and the wizard guides the user through the process of changing an existing map. Any changes made overwrite the current mappings.

To Delete Existing Map
1. Highlight the existing map to delete. The user is prompted to confirm their choice, click "OK".
2. An existing mapping cannot be deleted if it is tied to a current import/in-process import session. Any such imports must be completed or abandoned first and then the map can be deleted. Once deleted a map cannot be recovered.

View/Print Map Reports

9.1.2.1 Delimited or Excel Import Map Wizard

Delimited or Excel Import Map

The CRS PRO Import Wizard simplifies the process of creating Import Maps so users can import their data into the CRS PRO software. The first step in creating an Import Map is to specify how the records to import will be selected and where the records will be inserted into the tax form. Import files can be imported in a variety of formats, including delimited .CSV, Tab-Delimited, Pipe-Delimited, Fixed Length, and Excel (XLS or XLSX). Follow the steps below to create and/or define an Import map.

- Remember, your CRS PRO installation includes sample import files for automatic map-by-name imports!
Define Import Map Type

The Excel Import Wizard can be accessed during the Import Wizard process at the Select the Type of Data and Format Screen.

1. At the Select the Type of Data Format screen click the "Add/Update Form Import Maps" button.

2. At the Manage Form Import Maps screen click the "Add" (or "Change") button to access the Import Map Wizard. The Administrator prompts, "Which Type of Import Would You Like To Create?": select "Delimited" or "Excel".
   - To delete an import map, highlight the map and click the "Delete" button.
   - If header records in an import file are changed, the user must either modify the existing map or create a new map that reflects those changes.
   - The following columns define an Import Map: Map Type, File Format, Status and Description. The description column gives details about the currently selected import map and the Map Notes window to the right provides additional information.

3. At the Manage Form Import Wizard review onscreen information and click "Next" to proceed.

4. At the Define Overall Specifications for the Import File screen, the Mapping Form is determined by the type of tax form previously selected in the Import Wizard at the Select the Type of Data and Format to Use screen. To change the form type users must exit this wizard and return to the Import Wizard.

5. Check the "Has a Header Row" check box if appropriate. The header row in the spreadsheet has unique descriptive field names instead of user data.

6. At the Select the Sample Form File To Use screen browse for your file and click "Next" to proceed. A sample of the user's data file will display in the below box.

7. At the Map the Import Fields/Columns to Your Form screen, users may:
   - Map by Name - use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.
   - Drag & Drop Fields - manually match each field from the input file on the left to the corresponding tax form field on the right by dragging and dropping. To cancel a match, drag from right to left or double-click on it.
   - Assign Value - assign a fixed value to the selected unmapped field. For example, for the Rcp TIN Type field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported recipients have an identical recipient TIN type.

8. At the Default Field Size and Format Options screen select below options and click "Next" to continue:
   - Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount. For example, "10000" = "100.00" in implied decimals. The use of the implied decimal format in delimited file formats is rare.
   - Define date field indicators.

9. At the Set Recipient Matching Options screen choose how the software matches imported records with existing Recipients and/or tax forms. Options include:
   - Matching Recipients with a TIN
     - TIN plus Account Number
     - TIN plus Last Name (use only if account numbers are unavailable or inconsistent)
Matching Recipients When TIN is Missing/Blank

- Account and then Last Name (default option) - Looks for account numbers first, then matches for Last Name for the Account.
- Account plus a blank/missing TIN - Use when TIN/Account Number are the only identifying fields in the field (no name information is provided).
- Last Name and then Account - Looks for the Last Name first, then matches for Account Number for the recipients.
- Last and First Name (use if account numbers are unavailable or inconsistent) - Account numbers are NOT used to match for recipients.

10. At the Specify a Name and Usage Notes for the Import Map screen enter a title of description for this map. Users may also add usage notes for further clarification. Click "Next" to continue.

11. At the Set Options for Locating Your Import Files screen review options and click "Next" to continue.
   - Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
   - Users may optionally specify a default file name for the files that will be imported using this map.

12. Lastly, review settings on the summary screen and if satisfied, click "Finish". The Administrator indicates if the import map was successfully created. Users may opt to import the data used to create this map by clicking the "Yes" button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.

9.1.2.1.1.1 Map by Name Method

Map by Name Method

The Map by Name method is ideal for those import files incorporating CRS Pro's unique import file Header Records and automatically maps all fields with matching names. Users are strongly encouraged to incorporate these Header Records from our sample import files. See Delimited or Excel Import Map.

Import files containing CRS Pro Header Records automatically map during the import process. Some users may prefer to manually map by name and can reference the below instructions.

To Perform a Manual Map By Name
At the Map the Import Fields/Columns screen of the Import Wizard, use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.

When Mapping Street Addresses:
- Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
- Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates Address Lines 1 & 2 have merged for a successful mapping.
- Drag all other fields as normal.
9.1.2.1.1.2 Drag & Drop Method

Drag & Drop Method

The Drag & Drop method is ideal for those import files containing unique header records or no header records. Users are strongly encouraged to incorporate Header Records from our sample import files. See Delimited or Excel Import Map.

At the Map the Import Fields/Columns screen of the Import Wizard, click on any field from the left column (Input Field Name) and drag it across to the corresponding field in the right column (_mapped Field Destination). Repeat process until all needed fields are assigned. If the wrong field is accidentally assigned, double-click the mapped field and the information is removed.

When Mapping Street Addresses:
- Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
- Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates Address Lines 1 & 2 have merged for a successful mapping.
- Drag all other fields as normal.

9.1.2.2 Modifying an Existing Import Map

Modify an Existing Import Map

Add a Header Record AFTER Import Map Creation
Use this process to generate Header Record for an existing custom import map. Built-in import maps are not available for edits.

1. On the Preparing My Forms taskpanel select "Import CRS Tax Forms".
2. Click on "Import Records from Excel or a Delimited Text File".
3. Scroll through the Import Wizard to the Select the Type of Data and Format to Use screen. Click on "Add/Update CRS Import Maps".
4. Select the import map to add the new header and click "Change". Built-in import maps are not available for edits; however users can make a Copy of a built-in map and edit the copy instead!
5. At the Excel Import Map Wizard use the "Next" button to scroll through windows to the Map the Import Fields/Columns to the Data File screen. At this screen click "Add".
6. At the Adding a New Input Field Name/Column window (Image 1) there are two fields:
   - In the "Field Name/Column" field enter a Header name and fragment it. For example, "Input Field Name/Column". See the Map by Name section for more detail.
   - Leave the "Mapped to Field" blank.

Image 1
7. Click "Save".
8. Returning to the Map the Import Fields/Columns to the Data File screen, the newly created Header appears in the left-hand column. Drag the new header to the corresponding field in the right-hand column.

Add an Import Field AFTER Import Map Creation
Use this process to add import fields to an existing import map WITHOUT any Header Records (Fixed Position).

9.1.3 Step 1: Import Data or Filers

Step 1: Import Data or Filers

Welcome to Step 1 of the Import Wizard. Users can import Data or Filers directly into the program; thereby eliminating the need to manually enter data and thus saving valuable time!

Prior to starting an import please consider:
- Sample import files are included in a standard installation at C:\1099 Pro\ProCRST17\Import\Samples. Users are strongly encouraged to review the sample files and incorporate the Header Records to ensure a smooth import.
- If your data file includes leading zeros in TINs or ZIP codes save the file in Text (Tab Delimited) (.txt) format in Excel to preserve formatting.
- For detailed information on import file conventions please reference the online 1099 Pro WIKI.

Import Wizard—Step 1: Importing Data
Please watch our YouTube video on the CRS Import process.

1. On the Preparing My Forms task panel click the "Import New CRS Forms" link.

2. At the Start a New Import Process screen click the "Import Records From Excel or a Delimited Text File" button.

3. At the Import LOAD Wizard screen click "Next" to proceed. Use the "Back" button at any time to go back a step.

4. Select the Type of Data and Format and then click "Next" to proceed. If working in a multi-user or network environment see Troubleshooting Import Issues below.

5. Select the type of tax form or "FILERS" for a filer only import.
Indicate the Import File Format: Excel or Delimited
If your import file does NOT include Header Records, use the "Add/Update Import Maps" button to create a custom mapping. See Manage Import Maps and the Delimited Import Map Wizard.

6. At the Select the File To Import screen browse for your file and click "Next" to continue.
   - The selected file should appear in the display box; although the data may appear slightly askew.
   - **Data may NOT appear if** 1) there is a blank row at the top of the import file, or 2) there is a blank row between the Header Row and the start of the data. Users should cancel the import and modify their import file accordingly.
   - If data is based on a CRS Pro sample import file and any columns or fields were manually deleted, users may receive a WARNING at the next screen indicating some expected fields are missing. Please review the screen carefully for instructions.

7. Select the Filer for the Import. By default the forms import to the currently selected Filer. Use the "Select a Filer" button to change as necessary.

8. At the View the Mapped Import Records screen scroll down to verify that data is correctly mapped. Use the "View Next" button to sort through actual records and see live data. Should your data contain any strange characters; see Import File Conventions. Users can also verify the Data Type, File Format, and Process Type before proceeding. Click "Next" to continue.

9. Specify Import Status and click "Next" to continue. See Import Statuses.
   - Pending - This default status allows users to update, print, reset and file records in any manner.
   - XML Filed - To indicate XML has been generated for these records.

10. At the Confirm, Text and/or Begin Import Process screen users can test their import file for potential errors or warnings. If errors or warnings are determined, users are encouraged to cancel the import and edit their import file as necessary. Users may NOT edit errors and save changes at this screen. Click "Finish" if satisfied with the import file and are ready to proceed to Import Wizard - Step 2: Validating Data.

11. The Administrator prompts, "What do you want to do?".
   - 1 - Report: Select to review any warnings or errors in your import data and generate a report or correct them
   - Interactively.
   - 2 - Continue: Select to proceed directly to Import Wizard—Step 2: Validating Data.
   - 3 - STOP: Select to return to the Import Wizard at a later time.

**Troubleshooting Import Issues**

When importing a Microsoft Excel text file users may encounter a problem when assigning fields at the Specify Form Field Mapping screen. If the software generates "0" records on the left side in the Available Input Fields column, this is due to the import file being "locked" in memory by Microsoft Excel—or similar application—across a network LAN or WAN. The user must force Microsoft Excel or similar application to release control over the text file to be imported. To solve this problem, follow the steps below:

**If working locally on an individual computer (not on a network):** First, close all instances of Microsoft Excel used to generate your text file for import. Rename the import file. Begin a new import process, starting with Step 1 above.

**If working on a network with your import file residing on another computer (such as a**
workstation or server): Close all instances of Microsoft Excel used to generate your text file for import. Copy the file from the server to a folder on your local hard drive. Rename the import file. Begin a new import process starting with Step 1 above. Verify with your Administrator you have the proper rights to carry out this task.

9.1.3.1 Import Status Options

Import Status Options

Users must select a print status for data imported via the Import Wizard. The imported records are termed a 'session'. Records in an import session with a Pending status are available for edits, printing, etc. Records in an import session with any other status can only be voided (deleted). Use the Import Session Report to review the status of records in an import session.

Pending Status
Forms in this import session can be changed, printed, reset or filed in any manner.

Filed = Filed XML Status
Not available at this time.

9.1.3.2 Import Session Status Values

Import Session Status Values

An import session refers to all the forms/records contained in a particular import file. An import session has status to indicate its position in the import process—displayed in the "Status" column at the Completed and In-Process Import Sessions screen.

During the Import Wizard records in an import session are automatically assigned a Pending status and are available—upon conclusion of the import process—for edits, deletion or generating an XML file. Use the Import Session Report to review the status of records in an import session.

Import Session Status Definitions

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imported</td>
<td>The import session has been successfully imported into the software. View forms at the Work With My Tax Forms screen.</td>
</tr>
<tr>
<td>Loaded</td>
<td>The import session has been loaded, but not imported (or posted) into the software. To complete the import process highlight the session and click the “Continue with Session” button.</td>
</tr>
<tr>
<td>In-Process</td>
<td>The import session has been loaded and some of the forms have been edited, posted or abandoned; but more forms still need to be processed.</td>
</tr>
<tr>
<td>Updated</td>
<td>This import file has been imported and at least one of the forms has been opened and saved (edits to the form). Re-applying validation also trigger this status.</td>
</tr>
<tr>
<td>Partial</td>
<td>Some forms in the import file have been Imported; others remain in a Loaded status.</td>
</tr>
<tr>
<td>Imp/Disc</td>
<td>Some forms in the import file have been Imported, others were Discarded (or deleted) during</td>
</tr>
</tbody>
</table>
the Post; processing is complete.

<table>
<thead>
<tr>
<th>Discarded</th>
<th>All forms in the import session were abandoned or reset.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned</td>
<td>All forms for this import session were abandoned; none imported.</td>
</tr>
<tr>
<td>Reset/ Void</td>
<td>A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Filed) are NOT removed.</td>
</tr>
</tbody>
</table>

9.1.4 Step 2: Validate Data

Step 2: Validate Data

Welcome to Step 2 of the Import Wizard. At this screen users validate and check their data for any potential errors.

Import Wizard—Step 2: Validating Data

Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and click the "Importing Using Standard Maps" video to watch a brief tutorial of the import process.

1. Click the "Test My Import for Problems" button to perform a test import on up to 250 records. The Test Import Result window displays any errors and warnings. Select any record and click "Change/Fix selected record" to view data, however changes are not saved in test mode. This is an excellent opportunity to verify your data and go back and make any necessary changes to mappings, delimiters, etc. Click "Close" to exit this screen.

2. Decide how to proceed with the import:
   - If records need to be corrected or deleted click "Finish" and then "Report" to run a summary report detailing any errors or warnings. This report is not available once the import session is posted. Then proceed to the Edit, Post or Abandon Imported Records screen.
   - If NO records need to be corrected or deleted AND you want to proceed directly to the final step of the import routine, click "Finish" and then "Continue". At the Edit, Post or Abandon Imported Records screen click "Post Session". You immediately enter the Post Import Records wizard.
   - If NO records need to be corrected or deleted BUT you don't want to proceed to the final step of the import routine at this time, click "Finish" and then "Stop". Remember to return at some point to modify, delete or post this import session!

3. A standard installation of CRS Pro allows up to 1,000 transactions. If the combined total of existing records in the database and imported records exceeds 1,000, the import may abort.
   - To handle more than 1,000 transactions contact Sales at (888) 776-1099.

Proceed to Import Wizard—Step 3: Posting Results.

9.1.4.1 Review Import Records

Review Import Records
The Edit, Post or Abandon Import Records screen allows users the opportunity to review individual import records PRIOR to posting them into the software. Users can change/edit or delete individual records OR abandon an entire import session. Users also have the opportunity to edit eligible import records post import via the Work With My Tax Forms screen.

See Errors and Warnings

To Review Import Records
1. Click the "Continue with Session" button at the Completed and In-Process Import Session window for any import session with a Loaded or Updated status, OR at the conclusion of the Import Wizard—Step 1: Import Data, select "2 - Continue" as prompted by the Administrator.
   - During the Import Wizard—Step 1: Importing Data, users can click the "Test My Import File for Problems" button. This opens the Review Import Records screen in TEST mode strictly for the purpose of verifying field mappings. Changes made at this screen in TEST mode are not saved.

2. The Edit, Post or Abandon Import Records screen displays all import records contained in an import session.

<table>
<thead>
<tr>
<th>Primary Identifier</th>
<th>TIN. If TIN is not present then Account Number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Identifier</td>
<td>Account Number. If Account Number is not present OR used as Primary Identifier then Last Name.</td>
</tr>
<tr>
<td>Status/Validation</td>
<td>OK = Record complies with business rule validations (no obvious problems). Errors = Record is imported BUT contains serious data flaws that may result in the record being rejected by the IRS/SSA. Err+Warn = Record is imported BUT contains possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA. <em>Reject</em> = Record is not imported unless corrected. Triggered by Missing TIN, Missing Last/Company Name or non-allowed negative amounts. <strong>EDIT</strong> = Record is displayed in TEST mode and contains errors. Changes made to record are not saved in TEST mode.</td>
</tr>
<tr>
<td>Error Messages</td>
<td>(blank means no errors)</td>
</tr>
</tbody>
</table>

3. Double-click on any record to access the Update Records window.

<table>
<thead>
<tr>
<th>Data Field</th>
<th>The tax form specific fields, whether populated or not.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Value</td>
<td>Precise data values from the import file. For example, a raw value of &quot;750&quot; for a dollar amount box.</td>
</tr>
<tr>
<td>Import Value</td>
<td>Software imported data values. For example, an imported value of &quot;750.00&quot; for a dollar amount box—notice the dollar amount is auto-formatted during the import process.</td>
</tr>
<tr>
<td>Field Errors or Warnings</td>
<td>Lists any Reject errors including Missing TIN, Missing Last/Company Name or non-allowed negative amounts. If the incorrect or missing data is corrected, the associated warning disappears after clicking the &quot;Save&quot; button.</td>
</tr>
</tbody>
</table>

4. Make edits in the corresponding Raw Value fields (double-click to open field) and then "Save" (see Image 1) to return to the main Edit, Post or Abandon Import Records screen. Notice that after data is corrected at the Update Records window, the Status/Validation and Error Messages columns automatically update to reflect changes.
5. Users can continue to 1) “Change/Fix” selected records and/or 2) “Delete/Remove” selected records and then “Post the Session” to complete the import and bring eligible* records into CRS Pro. See Import Wizard—Step 3: Posting Results. Alternately users can opt to “Abandon This Session” and discard all records in the import, regardless of their Status/Validation.
   - Records imported and posted with errors have asterisks (*) prefixed to their status at the Work With My Tax Forms screen. For example, *Pending or *Filed.

9.1.5 Step 3: Final Import - Post Results

Step 3: Final Import - Post Results

Welcome to the final step of the Import Wizard. At this screen users post their data into the software.

Import Wizard—Step 3: Post Results

Posting Import Session
1. Open the Post Import Wizard via:
   - Continuing directly from the Import Wizard—Step 2: Validate Data and selecting "Post This Session", OR
   - At the Preparing My Forms task panel select the "Import New Tax Forms" link. At the Completed and In-Process Import Session screen select any import session with a Loaded or Partial status and click "Continue with Session" and then "Post This Session".

2. At the Post Import Wizard click "Next" to continue. At any time click "Back" to go back a step.

3. If any records in the session contain errors or warnings decide how to handle them. Options include:
   - Do not post records with errors: (Recommended) Records without errors are posted and problem records are placed on "hold" so you can fix them at a later time.
   - Post records with Warnings/Errors: Post all records now. You'll need to review individual records and manually update these fields at a later time.
4. Specify how to deal with existing recipients in the CRS Pro system. Options include:
   - Match forms with existing Recipients, but do not update addresses
   - Ignore existing TINs, add every Recipient as new
   - Update the incoming tax form with my current Recipient information
   - Update my Recipient information with new information from the tax forms (default selection)

5. Review settings and click "Finish" to post your import session. Your imported records are available to view and/or edit at the Work With My Tax Forms screen.
   - See Import Session Summary Report

9.1.6 Reset (Void) Import Session

Reset/Void Import Session

What Happens When an Import Session Is Reset
When an import session is reset (voided), all CRS forms associated with the import session are deleted UNLESS their status has been changed since the original import. For example, if records are imported as Pending and then some are updated to XML status, only the Pending records are deleted.

If this was a partial import and records have a Loaded status, users must first highlight the session, click the "Continue with Session" button and then "Abandon the Session" to remove the session.

Reset/Void Import Session
Once an import session is reset/void it cannot be reversed.

1. On the Preparing My Forms task panel select the "Import New CRS Forms" link.

2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.

3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   - The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".

9.1.7 Country Codes Table

Country Codes Table

Use the Select Country Code Table to quickly determine any country’s 2-character alpha code per FATCA's Country/Jurisdiction Listing. These country codes are used by banks, financial institutions and tax administrations and are specifically intended for use in XML files.

Country Code Tabs:
- By Country Code: Sorted alphabetically by Code
- By Country Name: Sorted alphabetically by Country
9.2 Import File Conventions

Import File Conventions

For a smooth import please thoroughly review these conventions PRIOR to creating your import file. We strongly encourage our users to review the sample import files that are included in our software and available, in a standard installation, at C:\1099 Pro\ProCRST17\Import\Samples. Users who review the sample import files and include our Header Records have great success with their imports!

The order of data fields is not important and it is acceptable to have extra fields that won't be included in your import file (e.g., phone number or email address, etc.). For additional import file conventions please refer to the 1099 Pro Wiki site.

Fields in RED are required.

<table>
<thead>
<tr>
<th>Field (Header Record)</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordType</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td><strong>P</strong> = Parent—Each &quot;P&quot; record represents a new CRS reportable account. The name, address, and birth information on a P record is associated with the Account Holder, not the Controlling Person.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PMT</strong> = Payment—Use &quot;PMT&quot; if more than one Payment is associated with a CRS reportable account. An import file can have unlimited amount payments related to a single CRS account. Each &quot;PMT&quot; record is associated with the nearest Account (&quot;P&quot; Record) that is above it. Each &quot;PMT&quot; Record should only contain payment information in the columns &quot;Payment&quot;, &quot;PaymentCurrCode&quot; and &quot;PaymentType&quot; fields.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AH</strong> = Account Holder—Use &quot;AH&quot; if more than one Account Holder / Name / TIN / Address is associated with a CRS reportable account. An import file can have unlimited Account Holders related to a single CRS account. Each &quot;AH&quot; Record is associated with the nearest Account (&quot;P&quot; Record) that is above it.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CP</strong> = Controlling Person—Use &quot;CP&quot; if Account has one or more Controlling Persons. Unlimited CP records are allowed. A &quot;CP&quot; is always an individual/person. This element is not required by the CRS XML schema but some jurisdictions may require it. Each &quot;CP&quot; record is associated with the nearest</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Account ("P" Record) that is above it.
- CPC = Controlling Person (Child)—Use "CPC" if Controlling Person has multiple names or addresses. Unlimited CPC records are allowed. Each CPC record is associated with the CP record above it.

**RecordType sequences must be in either P > PMT > AH > CP > CPC or P > AH > CP > CPC > PMT formats.**

<table>
<thead>
<tr>
<th>CP_Type</th>
<th>Controlling Person Types:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS801</td>
<td>CP of legal person - ownership</td>
</tr>
<tr>
<td>CRS802</td>
<td>CP of legal person - other means</td>
</tr>
<tr>
<td>CRS803</td>
<td>CP of legal person - senior managing official</td>
</tr>
<tr>
<td>CRS804</td>
<td>CP of legal arrangement - trust - settlor</td>
</tr>
<tr>
<td>CRS805</td>
<td>CP of legal arrangement - trust - trustee</td>
</tr>
<tr>
<td>CRS806</td>
<td>CP of legal arrangement - trust - protector</td>
</tr>
<tr>
<td>CRS807</td>
<td>CP of legal arrangement - trust - beneficiary</td>
</tr>
<tr>
<td>CRS808</td>
<td>CP of legal arrangement - trust - other</td>
</tr>
<tr>
<td>CRS809</td>
<td>CP of legal arrangement - other - settlor-equivalent</td>
</tr>
<tr>
<td>CRS810</td>
<td>CP of legal arrangement - other - trustee-equivalent</td>
</tr>
<tr>
<td>CRS811</td>
<td>CP of legal arrangement - other - protector-equivalent</td>
</tr>
<tr>
<td>CRS812</td>
<td>CP of legal arrangement - other - beneficiary-equivalent</td>
</tr>
<tr>
<td>CRS813</td>
<td>CP of legal arrangement - other - other-equivalent</td>
</tr>
</tbody>
</table>

This field is required ONLY if doing a Controlling Persons import.

<table>
<thead>
<tr>
<th>AccountNumber</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do not use commas or dollar signs</strong>, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250,0000 (Access or double precision databases) imports as $1,250.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BalanceCurrCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter <strong>Currency Codes</strong>. Detailed country code information is available in CRS Pro's sample import file in the Currency worksheet. For example:</td>
</tr>
<tr>
<td>USD = US Dollar: AMERICAN SAMOA; BONAIRE; SINT EUSTATIUS AND SABA; BRITISH INDIAN OCEAN TERRITORY; ECUADOR; EL SALVADOR; GUAM; HAITI; MARSHALL ISLANDS; MICRONESIA, FEDERATED STATES OF; NORTHERN MARIANA ISLANDS; PALAU; PANAMA; PUERTO RICO; TIMOR-LESTE; TURKS AND CAICOS ISLANDS, UNITED STATES; UNITED STATES MINOR OUTLYING ISLANDS; VIRGIN ISLANDS (BRITISH); VIRGIN ISLANDS (US)</td>
</tr>
<tr>
<td>USN = US Dollar (Next day): UNITED STATES</td>
</tr>
<tr>
<td>USS = US Dollar (Same day): UNITED STATES</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AH_Type* and AN_Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Missing data in the AH_Type field triggers an automatic record REJECT.</strong></td>
</tr>
</tbody>
</table>

**AcctHolderType indicates account is held by either:**
- CRS007 = Natural Person
- CRS101 = Entity - Passive Non-Financial Entity with one or more controlling person that is a Reportable Person
- CRS102 = Entity - CRS Reportable Person
- CRS103 = Entity - Passive Non-Financial Entity that is a CRS Reportable Person

**AND**

**AcctNumber is the Type of Account Number:**
- OCED601 = IBAN International Bank Account Number (follows a known structure)
- OECD602 = OBAN Other Bank Account Number
- OECD603 = ISIN International Securities Information Number (follows a known structure)
- OECD604 = OSIN Other Securities Information Number
- OECD605 = Other Any other type of account number e.g. insurance

### Payment

**Do not use commas or dollar signs**, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250.0000 (Access or double precision databases) imports as $1,250.

### PaymentCurrCode

Enter Currency Codes. Detailed codes are available in CRS Pro’s sample import file in the Currency worksheet. See BalanceCurrCode.

### PaymentType

Type of Payment:
- CRS501 = Dividends
- CRS502 = Interest
- CRS503 = Gross Proceeds/Redemptions
- CRS504 = Other – CRS (Example: other income generated with respect to the assets held in the account)

### ResCountryCode

Country Codes are available in CRS Pro’s sample import file in the CC worksheet.

### TIN

May include alphanumeric characters, dashes, periods and spacing.

### IssuedBy

**ORG_INType**

Type of Entity Tax Number (filled in at the FILER / Reporting FI field):
- EIN
- TIN
- UNKNOWN
- US GIIN

### NameType

The NameType attribute is the same for Organisations and Persons. Possible values are:
- OECD202 = indiv
- OECD203 = alias
- OECD204 = nick
- OECD205 = aka
- OECD206 = dba
- OECD207 = legal
- OECD208 = atbirth
- OECD201 = SMFAliasOrOther (not used for CRS)

### FirstName

### MiddleName

### Last Name/Company

### Birth_Date

Use MM/DD/YYYY format only. Unacceptable formats include Jan 3, 2017 and January 3, 2017.

### Birth_City

### Birth_CountryCod

Country Codes are available in CRS Pro’s sample import file in the CC worksheet.
### LegalAddressType

**Type of Address:**
- OECD001 = residential or business
- OECD002 = residential
- OECD003 = business
- OECD004 = registered office
- OECD005 = unspecified

<table>
<thead>
<tr>
<th>Street</th>
<th>Recipient address line 1</th>
<th>40</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suite</td>
<td>Recipient address line 2</td>
<td>40</td>
</tr>
<tr>
<td>City</td>
<td></td>
<td>40</td>
</tr>
<tr>
<td>CountrySubEntity</td>
<td>Enter legal US state abbreviation or full country name.</td>
<td></td>
</tr>
<tr>
<td>PostCode</td>
<td>Enter ZIP or postal codes. <em>For Canada the required format is letter-number-letter, a space, then number-letter-number. For example, “C3H 4W9” is a valid Canadian postal code.</em></td>
<td></td>
</tr>
<tr>
<td>CountryCode</td>
<td>Enter Country Code. Codes are available in CRS Pro's sample import file in the CC worksheet.</td>
<td>25</td>
</tr>
</tbody>
</table>

### Additional Fields

<table>
<thead>
<tr>
<th>Check boxes</th>
<th>Use X / Y / T / 1 to mark a checkbox. Leave field blank or use N / F / 0 (zero) to NOT mark checkbox. Values are not case sensitive.</th>
<th>1</th>
</tr>
</thead>
</table>
| Type of Transmission | Internal CRS Pro Values:  
- OECD0 = Resend Data (not used for CRS reporting)  
- OECD1 = New Data  
- OECD2 = Corrected Data  
- OECD3 = Deletion of Data  
- OECD10 = Resend Test Data (not used for CRS reporting)  
- OECD11 = New Test Data  
- OECD12 = Corrected Test Data  
- OECD13 = Deletion of Test Data | |

### 9.3 Converting Excel Formats

#### Converting Excel Formats

**Excel Spreadsheet Files**
When saving data in Excel, use the ‘Save As’ method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files appear out of alignment when viewed from a text editor such as Notepad but look great when viewed from Excel. To import .TXT (TAB delimited) files select [TAB], [CR LF] and Double Quotes as your delimiters in the Import Wizard. .TAB files will not display at the “Open” screen in Excel unless “All Files (*.*)” is selected at the “Files of Type” field.

**Comma Quote Delimited Files**
In a database program such as Microsoft Access save your file in .CSV (Comma Separated Values) format. To import .CSV files select Double Quotes and Comma as your delimiters in the Import Wizard or the import will fail. Examples of acceptable .CSV file formats (note formatting of dollar amounts):

"Charlie","Tuna","100.00","555-55-5555","1525 Bruin Ave","Westwood","CA","90024"
"Charlie","Tuna",100.00,"555-55-5555","1525 Bruin Ave","Westwood","CA","90024"

**Other Spreadsheet Files**
In your program determine if files can be saved in .TXT (text) format. If difficulty is encountered, columns may be inserted between the existing columns and a "|" (pipe) may be entered as a delimiter. To import .TXT files select Pipe as your delimiter in the Import Wizard.

**No Obvious Way to Create an Import File**
If nothing else works, try printing your data to a file. A generic text driver that only prints text characters may be required. Import that file into a spreadsheet, parse the various columns and then import into 1099 Pro.

**9.4 Delimiters**

**Delimiters**

A Delimiter is defined as a character used to indicate the beginning and end of a data string. Delimiters can be commas, periods, tabs, spaces or quotes. Users must specify the delimiter for their import file. Upon correctly setting delimiters, each field of your header record should appear on a different line at the Import Data Delimiter screen. If your data displays in one long row or contains strange characters the wrong delimiter was used. Select the appropriate delimiter to correct this problem.

**File Format Choices**
- **Standard Tab Delimited**: Works with all .TAB sample import files and standard .TAB files.
- **Standard Comma Delimited (CSV)**: Works with comma separated value (CSV) files.
- **Pipe**: Works with pipe delimited "|" values.

**9.5 Import Session Report**

**Import Session Summary Report**

The Import Session Summary details all records in the selected import session.

**To Generate Report**
1. At the **Preparing My Forms** task panel select the "Import New CRS Forms" link.
2. At the Completed and In-Process Import Sessions screen highlight an import session and click the "Amount/Totals Report" button.
   - The "Amount/Totals Report" button is ghosted for any session with a status of Abandoned or Reset/Void.
3. The Report Options screen prompts to:
   - Select the Printer - consider printing to PDF to save paper
   - Select the Sort Order - by Last Name/First Name or by TIN
   - Preview before printing
   - Print Summary totals only
4. Click "OK" to generate the report or "Cancel" to exit the report.

See **Reset/Void Import Session**
9.6 Reset/Void Import Session

Reset/Void Import Session

What Happens When an Import Session Is Reset
When an import session is reset (voided), **all CRS forms associated with the import session are deleted UNLESS their status has been changed since the original import.** For example, if records are imported as *Pending* and then some are updated to *XML* status, only the *Pending* records are deleted.

If this was a partial import and records have a *Loaded* status, users must first highlight the session, click the "Continue with Session" button and then "Abandon the Session" to remove the session.

Reset/Void Import Session
Once an import session is reset/void it cannot be reversed.

1. On the Preparing My Forms task panel select the "Import New CRS Forms" link.

2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.

3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   - The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".

9.7 Reject Imports

Reject Imports

Records that contain certain errors are automatically rejected for import. Reject errors include:
- Missing Last Name and TIN
- Field contains non-allowed negative amounts

If the correct information is available, users should exit the Import Post Wizard and fix the record at the Edit, Post or Abandon Records screen. If the correct information is not available, users may proceed with the import. The rejected record is held at the Completed & In-Process Import Sessions screen and may be fixed at a later time.

For more information on Warnings, Errors and Reject Errors see Error & Validation Checking.

9.8 Form Status Overview

Form Status Overview

Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session.
Use the Import Session Report to review the status of records in an import session.

9.8.1 Microsoft Access 2007 Rollup Procedure

Microsoft Access Rollup Procedure for Microsoft Office 2007

This procedure assists users with the process of aggregating information for multiple tax forms located on one spreadsheet and combining them onto one sheet. This process is useful when exporting information from multiple databases and several of them contain information for the same recipient. 1099 Pro, Inc. does not supply customers with Microsoft Office 2007 or Microsoft Access 2007. Users must have their tax form information in an Excel spreadsheet prior to beginning this tutorial.

To Aggregate Data

2. Click on “Blank Database” and name the file. If necessary select an alternate location to save your database file.

3. In Access select the “External Data” tab and choose “Excel”.

4. Click on “Browse” to locate the Excel file to import. Verify the option “Import the source data into a new table in the current database” is selected.

5. The user is presented with a screen displaying all data contained on the spreadsheet divided by columns. Users are STRONGLY encouraged to use Header Records for the columns in their Excel files. To do so, select the option “First Row Contains Column Headings”. Verify data and click the “Next” button to proceed.

6. As the user clicks “Next” through the Import Spreadsheet Wizard, they are prompted to choose which field will be used as a primary key; we recommend letting Access choose the primary key. Click “Next” to continue.

7. The user is prompted to name the table and click “Finish”.

8. Lastly, the user can save the import steps used to create this table. Mark the “Save Import Steps” checkbox, name the file file and click “Save Import”.

9. The user returns to the Access main screen. Select the "Table" and locate the newly created table in the left-hand pane. Double click the table to display its contents.

10. With the table open, right-click on the table name in the left-hand pane to display a drop down menu and select "Design View".
11. The table displays three columns: Field Name, Data Type and Description. It is important to verify that the data is imported as the correct data type. All boxes to be aggregated must have "Number" as their Data Type; otherwise, errors will occur during aggregation.
   - Field Name contains Header Records.
   - Data Type indicates how Access stores the data. The Number field type stores only numerical data. The Text field type can store text or numerical characters.
   - Description (optional) is useful for internal notes and will not affect data in any way.

12. Click the “Create” tab and then the “Query Design” icon.

13. The Show Table window lists the newly created table. Highlight the table and click "Add" and then "Close" the window.

14. Drag and drop the Header Records from the query window into the “Field” columns on the bottom of the screen. Drag and drop each Header Record that should appear in the export.

15. Next, for every box area to be aggregated right-click your mouse and select the "Totals" area.
underneath the desired box and select "Sum".

16. For all areas that should have their information combined, leave the “Totals” area at “Group by”. This will combine their fields, and this is what should be used for things like TIN, Address types, etc.

17. Once you are done, click on the “Run” icon.

18. If everything was entered correctly, you will be presented with a combination of all your matching forms as well as the totals for all the boxes where the prior information matched identically. If “Sum” was chosen for an area that could not be “Summed” (I.E. Form Category), you will receive the following error message:

19. Once that is done, you will be presented with a new object that contains all the information that you chose to aggregate.

20. You can now click on the “External Data” tab, and over the “Export” area, click on “Text File”.

21. It is not recommended that you select any of the options on this page. You will be given further options once you have clicked “OK”.

22. You will now see all your information in the “Sample Export Format” window. In addition to this, you will be given the option to save your text file as a “Delimited” or “Fixed Width”. It is recommended that you choose “Delimited” file. Click “Next” to continue.

23. You will now be given the choice of what delimiter will be used. It is recommended that you use the “Tab” delimiter. Also select “Include Field Names on First Row” and change the “Text Quantifier” to “None”, and click “Next” to continue.

24. You will now be given the chance to name your file; it is suggested that you name the file that will easily identify it, and click “Finish”. If you plan on creating many of these types of files, it is recommended that you select the option to “Save Export Steps” and choose a name that will easily identify the delimited text file creation process.

10 Error & Validation Checking

Error & Validation Checking

CRS Pro performs various validation checks on your data. Error and validation checks occur whether data is manually entered or imported (see Disclaimer). It also occurs when generating XML files. If a problem is found, the software flags the record with a Warning, Error or Reject Error. Users are encouraged—although not required—to fix warnings and errors before continuing.

- Users can instantly scan all records in the software for errors and warnings via the menu bar > Utilities > Check/Update Error Status For All Forms.
- See Business Rules/Validation Changes
- See XML Failed Schema Validation

Warnings & Errors Defined

Whether importing or manually entering data, CRS Pro indicates if any records have errors or warnings
associated with them, or if they were rejected.

- **Warnings** are intended to flag a possible inconsistency or omission in the data that may result in the record being rejected.
- **Errors** are serious flaws in the data that would most likely result in the record being rejected.
- **Reject Errors** occur when the user has not entered correct data, resulting in an automatic rejection.

**Find Problem Records**

CRS Pro offers several methods to locate records containing warnings and/or errors including:

- **Form Counts Report** - View a concise listing of all filers and form types including number of warnings and/or errors per form type.
- **Control Totals Report** - View errors and/or warnings in detail by Account Holder. Users must select the “Extended Version - Errors and Warnings Messages” to access this information.
- **Review Import Session** - Prior to posting import data into the software, users can edit or delete individual records during Step 2: Validate Data of the Import Wizard.
- **Error Queries** - Sort records with errors and/or warnings at the Work With My Tax Forms screen. See Error Queries below.

**Error Queries**

At the Enter, Update and View screen display records with errors and warnings or errors only.

**To Run Error Queries**

1. On the **Preparing My Forms task panel** select "Work With My Tax Forms".

2. At the Enter, Update and View screen use the Current Query drop menu to select "Errors and Warnings Only" or "Errors Only".

3. The Enter, Update and View screen immediately displays any records that match the query criteria.
   - If NO records display then there are no records for the selected filer and form type with errors or warnings.
   - Any record containing an error or warning may be fixed provided it has a pending status.
   - After fixing a problem record it will disappear from this list. After fixing all problem records reset the Current Query to “All Records”.

**Disclaimer**

1099 Pro, Inc.’s CRS Pro software identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this software. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

**Feedback**

Users who encounter a situation that should possibly generate an Error or Warning in the software are encourage to discuss the situation with 1099 Pro, Inc. at compliance@1099pro.com. Please indicate the form type, data set and OECD or government regulations in your correspondence.

### 10.1 Warnings and Errors Scan

**Errors & Warnings Scan**
Users can scan their records for errors and warnings prior to generating an XML file. If errors or warnings are found in XML files, users can choose whether or not to process those records.

**Processing Records with Errors/Warnings**

Errors and Warnings typically indicate missing or incorrect information. Account Holder Last Name, Birth Town or City and Account Balance are required fields that will generate errors if data is missing.

Users are encouraged to make every effort to fix missing or invalid data but if they are unable to do so, file the records anyway. A good way to identify errors and warnings by recipient is to run a **Control Totals Report** with "Extended Version—Errors and Warnings Messages" selected. **Try to fix any errors or warnings prior to transmitting an XML file.**

- See Error & Validation Checking

## 11 XML Overview

### XML Overview

- See XML File Session Window
- See XML Wizard
- See XML Failed Schema Validation
- See XML to Excel (to review Test or Production data)

**What Is An XML File?**

Per the OECD, a schema is a data structure to transmit data and XML is the IT-based language used for this purpose. Each XML file contains specific data elements and descriptive attributes as detailed in the OECD's [Common Reporting Standard User Guide and Schema](https://www.oecd.org). CRS Pro formats data into the XML V1.0 per these specifications.

### 11.1 XML File Session Window

**XML Session Window**

The XML Session window contains both the XML generation and NIL report functions available in CRS Pro. From this window users can generate the following electronic files:

- **XML File Wizard** - Click the "Create an OECD XML File" button.
- **NIL Report Files** - Click the "Create a NIL Report" button.

**Completed XML Session List**

The XML Session List contains logs detailing all files generated via the XML Wizard.

**Columns Include:**

<table>
<thead>
<tr>
<th>Log ID</th>
<th>A specific number assigned to every XML file generated by the Wizard.</th>
</tr>
</thead>
</table>
### Session
A number assigned to any group of files generated together by the XML Wizard. _Multiple sessions can be included in a single log._

### # Forms
The number of forms generated for the particular log.

### Receiving Country

### Session Type
The type of transaction or session that was processed: ORIGINALS, TEST or CORRECTIONS.

### Session Date
The date the XML file was created.

### Session Time
The time the XML file was created.

### Date Reset
Indicates date an XML file was voided or reset.

### Payer Code

### File Name
Details the file name and location saved.

---

**View/Print Log Report**

Use to generate a totals report on the currently selected session.

**Reset/Void XML Session**

Use to Void/Reset the currently selected XML session along with any log IDs associated with that session. See [Reset XML Session](#).

---

### 11.2 XML Wizard

#### XML File Wizard

This wizard simplifies the process of creating an XML file; allowing users to create Original, Correction, Amended and Void files.

**IMPORTANT:** Special characters are prohibited in XML file generation: The apostrophe (‘), double dash (--), quotation mark ("), and hash (#) symbols are prohibited as they can be used in a security threat and will cause the transmission to be rejected with a failed threat detection error notification. Replacing the characters with an entity reference will still cause a rejection.

**Generate XML Files**

1. On the [Create XML task panel](#) select the "XML OECD" link.

2. At the Create the OECD XML File screen click the "Create an OECD XML File" button.

3. At the XML Wizard screen review important onscreen information and click "Next" to continue. Click "Back" at any time to go back a step.

4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.
5. Select Filer/Reporting FIs to include via the "Tag" buttons or manually select the filers to include in this XML file.

6. Specify the File Type and Transmission Medium:
   - New Data
   - New TEST Data - Send only test data (not production data) under a dummy filer. Test data is marked as "filed".

7. Select the destination folder. Default location is C:\1099 Pro\ProCRST17\MagFiles.
   - File naming convention is
     TransmittingCC:YYYY:ReceivingCC:_PayerCode_TypeOfData_SessionID_TimeStamp.XML.
   - If the Filer/Reporting FIs PCode contains any of the following characters, \ / : * " < > |#, they are stripped from the XML file name.
   - Some Jurisdictions have specific naming conventions.

8. Set Reporting Period—The default period is the last day of the tax year being reported. Any date within the Tax Year installation of CRS Pro can be selected. For example, in a CRS Pro 2016 installation, only 2016 Reporting Periods are allowed. Click "Next" to continue.

9. At the Ready to Generate XML File(s) screen review settings and if satisfied click "Finish" to start the XML file generation.

10. The Progress screen tracks your Electronic File Generation Process and indicates total files created. Click "OK" to exit this screen.

11. Return to the Completed XML screen and view XML file specific information.
   - If the XML failed schema the file name is prefixed with "FailedSchema", see XML Failed Schema Validation Wizard.
   - If the Filer/Reporting FIs PCode contains any of the following characters, \ / : * " < > |#, they are stripped from the XML file name.
   - Click the "Visit the OECD Site" button for direct access to the Automatic Exchange Portal (AEP).

### 11.3 XML to Excel

**XML to Excel**

Use Microsoft Excel® to analyze Test or Production XML files created in CRS Pro. See Generate XML Files.

**Review ALL Information**

To view ALL of the information in your XML file in an Excel® spreadsheet, open a blank spreadsheet in Excel and drag the .XML file onto the blank spreadsheet. Wait a few seconds until the Open XML popup displays (as shown below) and choose to open the file "As an XML Table".
The spreadsheet with your XML data will include a lot of duplicate information; consider deleting all of the columns to the left of Column AD (DocRefId3) EXCEPT Columns C, D and N which (i.e., TransmittingCountry, ReceivingCountry and FilerName). In the Column AccountNumber are many blank rows. All of the data associated with this AccountNumber is located to the right of the AccountNumber column on this row and the following blank rows. Data for the next account number starts when you see a new AccountNumber similar to the below image.

Review Balance and Payment Information
Customized Excel file for opening an XML file to review balance and payment information.

1. From your CRS Pro installation (typically located at C:\1099 Pro\ProCRST17\Maps) open CRS_Pro_TY2017_Payments_And_Balance.xlsx.

2. From the Excel menu bar click Developer > Import.
   o If the Developer tab is not visible see Show Developer Tab below.

3. Browse to locate your .XML file with the data to import (typically located at C:\1099 Pro\ProCRST17\MagFiles). Double-click on the .XML file.

4. Review your data on the "Import from XML" worksheet of the Excel file. The XML data auto-fills the columns. Save your data to a different file name using the "File" and "Save As" options.
Comprehensive XML Review
Customized Excel file for opening an XML file to review detailed, comprehensive information.

1. From your CRS Pro installation (typically located at C:\1099 Pro\ProCRST17\Maps) open CRS_Pro_TY2017_Comprehensive.xlsx.

2. From the Excel menu bar click Developer > Import.
   - If the Developer tab is not visible see Show Developer Tab below.

3. Browse to locate your .XML file with the data to import (typically located at C:\1099 Pro\ProCRST17 \MagFiles). Double-click on the .XML file.

4. Review your data on the "Import from XML" worksheet of the Excel file. The XML data auto-fills the columns. Save your data to a different file name using the "File" and "Save As" options.

Show Excel Developer Tab (If Not Visible)
If the Developer tab is not displayed in the top ribbon of Excel, use the following instructions from the Microsoft Support website.

In Excel 2010, 2013 and 2016:
1. Click File > Options.
2. Click the Customize Ribbon category.
3. Under Main Tabs, check the Developer box, and click "OK".

In Excel 2007:
1. Click the Microsoft Office Button > Excel Options.
2. Click the Popular category.
3. Under Top options for working with Excel, check the Show Developer tab in the Ribbon box, and click "OK".

11.4 Reset XML Session

Reset XML Session

To reset/void an XML session automatically resets all records in that session to their pre-XML Filed status. For example, a record that prior to XML filing had a Pending status will return to Pending status and is thus available for edits and/or inclusion in a new XML file session.

To Reset Session
1. On the Create XML task panel select the "XML V1.0 OECD" link.

2. At the Completed XML List screen highlight a session and click the "Reset (Void) Session" button.

3. The Administrator prompts, "Are you sure that you want to RESET/VOID this XML session?" Click "Yes" to proceed or "No" to cancel.
   - The "Trans Type" column indicates that the session has been voided.
   - The Reset/Voided column indicates the date the session was voided.
11.5 NIL Reports

NIL Reports

Who Must File NIL Reports? What Is The Submission Procedure?
Filing of nil returns. A jurisdiction may require the filing of a nil return by a Reporting Financial Institution to indicate that it did not maintain any Reportable Accounts during the calendar year or other reporting period. The Model FATCA IGAs do not require nil returns but this could be required by local law.

To Generate NIL Report
Prior to generating a NIL Report please view https://www.1099pro.com/videos.asp “How to Create a NIL Report with CRS Pro Professional. CRS Pro only allows a NIL Filer to create a NIL Report; please see To Create a NIL Filer below.

1. On the Create XML task panel select "XML V1.0 OECD".
2. At the Create XML File or NIL Report screen click the "Create a NIL Report" button.
3. In the NIL Report Wizard review important onscreen information. Click "Next" to continue or "Back" at any time to go back a step.
4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.
5. Tag Filers to include in the report. Click "Next".
6. Select the Type of File to create. Click "Next".
7. Review the default destination folder for the NIL report; in a standard installation this is C:\1099 Pro \ProCRST17\MagFiles. Click "Next" to continue.
8. Review Contact and Company information and update as necessary. The default Reporting Period for the NIL Report is year-end, i.e., 12/31/XXXX, but may be edited as needed. Click "Next".
9. Review onscreen settings then click "Finish" to generate the report.

To Create a NIL Filer
CRS Pro only allows a NIL Filer to create a NIL Report.

1. On the Reporting F1 task panel select "My Filers List".
2. At the Filer Master List screen add a new filer or edit an existing filer.
   o The "Filer Is Used ONLY for NIL Reporting" checkbox must be marked. This checkbox is not available if editing a filer with existing data.
   o A Payer Code (PCODE) is required, but the Filer/Agent EIN is not.
3. Click "Save".

12 XML Failed Schema Validation

XML Failed Schema Validation

XML V1.0 OECD—Failed Schema Validation
Users receive the following message if an XML file fails Schema Validation during XML generation. To determine why the file failed validation, both an .XML file and a .TXT log file are generated which flag the
line number(s) where the file failed schema. In almost all cases the error is because of missing or incorrect data.

XML files that fail validation have the prefix “FailedSchema” added to the beginning of the normal file name which is composed as below where TransmittingCC is the Transmitting Country Code and ReceivingCC is the Receiving Country Code of the Filer (Reporting FI). These files are located, in a standard installation, at C:\1099 Pro\ProCRST17\MagFiles.

Typical File Naming Convention:
TransmittingCC:YYYY:ReceivingCC:_PayerCode_TypeOfData_SessionID_TimeStamp.XML

Example Failed XML Name:
FailedSchema_AD2016AD_AH NAME_TestNew_24_2017-06-23 9-53AM.xml

Example Failed Log File with Line Numbers in it:

Log Files look similar to the following:
File failed validation check:

What Does This Mean?
- The above tells us that an error in the XML file was encountered at line 41.
- The error occurred when the element Address was encountered.
- The program expected either a TIN or Name element instead. Carefully review the below XML and notice that there is a TIN element, but no Name element—the Name element is missing!
  - Typically schema errors come from one or more missing values for the Header Fields (denoted for illustration purposes below in red). For example a Country Code, Birth Date, First & Last Name, etc... Review Import File Conventions to review required data fields.

```xml
<crs:AccountHolder>
  <crs:Individual>
    <crs:TIN issuedBy="TR">TINTIN1</crs:TIN>
    <crs:Address legalAddressType="OECD303">
    </crs:Address>
  </crs:Individual>
</crs:AccountHolder>
```

Line 41
Examples

Where a box has a solid line or a notation is made, the data is required and is ordered as shown.

For example, in the Individual listed above, the XML starts with ResCountryCode, then with the optional TIN and then Address. However, as displayed below in Image 1, the XML requires the Name element before the Address element. Thus, the error at Address in line 41 is triggered because the required Name information—which should have been preceding the Address—is missing!

AccountHolder_Type/Individual

![Diagram of XML structure](image)

Birthdate is required

Here are other elements and how they are sequenced.
ControllingPerson_Type/Individual

AccountHolder_Type/Organisation

Balance is required.
**CorrectableAccountReport_Type/AccountBalance**

Both are required if you have payments.

**CorrectableAccountReport_Type/Payment**

The account number is required.

**CorrectableAccountReport_Type/AccountNumber**
complexType NamePerson_Type

description

The user must spread the data about the name of a party over up to six elements. The container element for this will be 'NameFix'.

attributes

- nameType

- crs:PrecedingTitle
  His Excellency, Estate of the Late ...

- crs:Title
  0..∞
  Greeting title, Example: Mr, Dr, Ms, Her, etc. Can have multiple titles.

- crs:FirstName
  0..∞
  Firstname of the person

- crs:MiddleName
  0..∞
  Middle name [essential part of the name for many nationalities]. Example: Sakthi in "Nivetha Sakthi Shanka", Can have multiple middle names.

- crs:NamePrefix
  de, van, van de, von, etc. Example: Derck de Clarke

- crs:LastName
  0..∞
  Represents the position of the name in a name string, Can be Given Name, Forename, Christian Name, Surname, Family Name, etc. Use the attribute 'Name-Type' to define what type this name is. In case of a company, this field can be used for the company name.

- crs:GenerationIdentifier
  0..∞
  Jnr, Thr, Third, III

- crs:Suffix
  0..∞
  Could be compressed initials - PhD, VC, QC

- crs:GeneralSuffix
13 Filing via OECD

13.1 OECD Overview

OECD Overview

What Is the Organisation for Economic Co-operation and Development (OECD)?

“The mission of the Organisation for Economic Co-operation and Development (OECD) is to promote policies that will improve the economic and social well-being of people around the world.” The OECD is comprised of a Council composed of one representative per member country, plus a representative of the European Commission, various Committees and led by a Secretariat. Please see About the OECD.

14 Reports

Reports

CRS Pro offers numerous reports including:

- Control Totals
- NIL Reports
- Form Counts
- Forms Issued by Filers
- Filers Listing
- Import Session Summary
- Import Map Reports
- and many others!

14.1 Form Control Totals

Form Control Totals

The Control Totals report is an invaluable tool for reviewing Account Holder records and pinpointing Errors and Warnings. Information contained in this report includes:

- Filer/Reporting FI's Name, TIN and PCode
- Account Holder's Name, TIN, Account Number and Address
- Individual record print status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more....

To Run Control Totals Report

1. Use the "Select Another Filer" button to choose the Filer/Reporting FI to generate report for.

2. On the menu bar select Reports > Form Control Totals.
3. At the View/Print Control Totals Report screen select a printer.
   o Consider printing to PDF to save paper.

4. Report Filter and Form Selection Options - Choose a method for selecting records:
   o All Pending Originals for this filer
   o All Forms for this Filer
   o Use Query Wizard to choose or create a query
   o Manually select records (tagging)

5. Error and Warning Messages - Choose how to print warnings and/or errors. **This option is only available if Extended Version is selected** under Report Format Options, below.
   o Don't print error and warning details
   o Print error and warning details
   o Print ONLY forms with errors and warnings
   o Print ONLY forms with errors

6. Report Record Ordering Options - Choose how to sort the records:
   o By Last Name
   o By TIN
   o By Account Number, then Last Name

7. Report Format Options - Choose a report format:
   o Summary Version (amounts only, no address, text or error/warning detail)
   o Extended Version (all form details including address and errors/warnings)

8. Additional options include:
   o Add custom notes for this report run
   o Print totals only (suppress individual form details)
   o Print Preview

9. To generate report click "Print Now".

10. At the preview screen go to the last page to view box-by-box totals.

14.1.1 Troubleshooting Control Totals

**Troubleshooting Control Totals**

On occasion users may experience difficulty generating a Control Totals report due to setting incorrect parameters. Verify the following:

- The correct Filer/Reporting FI is selected.
- A valid Report Filter and Form Selection Option was chosen. For example, if "All Pending Forms" is selected and there are no pending forms no report will generate.

If no information matches the set parameters the Control Totals Report will not generate.
14.2 Form Counts

Form Counts Report

The Form Counts Report generates a listing of all forms sorted by Filer/Reporting FI, detailed by Status. The end of the report tallies form totals for errors and/or warnings, original and corrected forms. This report is very useful for tracking the status of forms and determining if records contain any errors or warnings.

To Run Form Counts Report
1. On the menu bar select Reports > Form Counts.
2. Click “Yes” to preview the report.

14.3 Forms Issued By Filer

Forms Issued by Filer

The Summary of Forms Issued by Filer provides detailed recipient information for all forms issued by the selected filer(s).

To Run Report
1. On the menu bar select Reports > All Forms Issued by Selected Filer.
2. Click “Yes” to preview the report.
3. At the Browse the Filers File screen click the “Tag” button to select filers. A red checkmark appears beside each tagged filer. To sort filers prior to tagging, use the View drop menu.
   o Review Tag Key Shortcuts
4. After tagging appropriate filers click “Proceed” to run the summary.

14.4 Import Map Reports

Import Map Reports

The Import Map report is an invaluable tool for reviewing import maps. Information contained in this report includes:
- Import Map Title
- Type: CRS or Filers
- Creation Date and Time of the Import Map
- Formatting Specifics
- Creation Date and Time of the Report including the Network Station ID
- Field Names, Field Types and Field Descriptions

To Run Report
1. On the menu bar select Utilities > Run the Import Wizard OR on the Preparing My Forms task panel select “Import New CRS Forms”.
2. Select the “Import Records from Excel or a Delimited Text File” button to initiate the Import Wizard.
3. At the Select the Type of Data screen in the Wizard, click the “Add/Update CRS Import Maps” button.
4. Highlight the appropriate import map and click the “View/Print Map” button
5. The user is prompted to preview the report.

14.5 Daily Totals Report by UserID

Daily Totals Report by UserID

The Daily Totals Report by UserID displays the total changes made via manual entry by UserID. The user must specify the date, Filer(s) and form(s) to include in this report. This report is useful for verifying changes made to records by an individual user.

15 Current Sort/View

Current Sort/View

Record Sorting:
CRS Pro offers built-in views that are tied directly to the Search field. To search for records by TIN the view must be set to "By TIN". Likewise, to search for records by name the view must be set to "By Last Name/Company" or "By Filer Name" as appropriate. Failure to properly set the view will result in a failed search attempt.

Views are available at select browse screens.

15.1 Current Sort/View

Custom View

Custom Sorting of Records & Column Display
Sophisticated users can select Custom View from the Current View drop menu and design their own views.

To Define a Custom View
1. At the Work With My Tax Forms screen refer to the Current View drop menu and select "Custom View".
2. The Define View Format screen opens and allows users to select the available fields from the left column and organize them in the "show these fields in this order" column on the right.
3. Users can move the position of these items in the order in which they will appear by highlighting them one-by-one and clicking the UP/DOWN keys to adjust it's position accordingly.
4. To save these changes click, "Apply" or Click "Next" to define a sort order for the custom view. The software displays the "Select a sort order for the view" screen. At this point users can:
   o Use the default sort order (Which tells CRS Pro to accept the current sort order)
   o Select a predefined sort order (fastest) which tells the software to use the built in predefined list (Example: Filer ID, Last Name/Company, First Names or by Filer ID, Recipient TIN, then Last Name/Company.)
   o Define your own custom sort order (slowest) Allows you to indicate what custom sort order the software should follow based on your custom field selections.
15.2 Custom Sort Order

Custom Sort Order

Define Custom Sort Order / Column Displays
Sophisticated users can define a custom sort order to view records in addition to the default sort options of by Account, TIN or Last/Company Name.

1. At the Work With My Tax Forms screen click the "Current Sort/View" drop menu and select "Custom View".
2. At the Define Column Layout window use the "Next" button to open the Select a Sort Order for the View window.
3. Select the "Define Your Own Custom Sort Order" radio button to access the Sort Designer window.
4. Make your selections to arrange records by up to four fields, in ascending or descending order. For example: Sort View by "Account Holder Type", Then by "Account Create Date", Then by "Country".
5. Click "OK" to save changes and close window.
6. Click "Apply" at the Select a Sort Order for the View window. This window closes and changes take effect immediately at the Work With My Tax Forms screen.
7. To cancel the custom view use the Current/Sort View drop window to select the default view.

15.3 Dynamic Queries (CS Version Only)

Dynamic Queries

The features contained within this section are available exclusively to users of the 1099 Pro Corporate Suite software.

Basic Use
- All 'AskFor...' tokens are composed of a single word with no spaces or other punctuation. Tokens are not case sensitive, but users are strongly encouraged to enter them using the capitalization as shown in this document as it makes the queries easier to read and understand.
- Manual Query: Click on the 'Manual' button and use the "AskFor..." string where desired. Examples:
  - RcpTIN = AskForText
  - DateLastEdit > AskForDate
  - DateCreated BETWEEN AskForDateRange
  - TIP: Date and Time ranges must be entered manually as shown above.

- At the Query Wizard Value Entry screen the 'Expression' radio button must be selected, or else the 'AskFor...' token is treated as if it is the actual value to use. Thus, the query returns neither a result nor triggers an invalid query response/error from the database. If the 'Expression' option is disabled, the query must be manually created.

Once the query is created and saved it prompts the user, each time, for the value to use (substitute) where the 'AskFor...' expression was in the query. To resubmit the query with a different value, click on the 'Redo' button under the "Current Query:" prompt to enter a new value (or set of values). Users can likewise press "F5" on their keyboard to redo a query. This simplifies the process of creating a query.
with new values to browse, update or report.

Removing a Query
To view all records again, users can select ‘All records’ on the query list or click on the ‘Undo’ button to the left of the ‘Redo’ button.

Restrictions
Users can have multiple unique ‘AskFor…’ expressions in the same query, but not the same one multiple times. For example:

This expression is allowed.
DatePrinted = \textit{AskForDate} \text{ AND } RcpLName = \textit{AskForText}

This expression is not allowed.
RcpLName = \textit{AskForText} \text{ AND } RcpFName = \textit{AskForText}

1099 Pro, Inc. plans to lift these restrictions at a future date.

**WORKAROUND:** For text and numbers users can use the from/through variants of the same type as additional tokens. For example:

\begin{verbatim}
RcpLName = \textit{AskForText} \text{ OR } RcpLName = \textit{AskForFromText} \text{ OR } RcpLName = \textit{AskForThruText}
\end{verbatim}

**TIP:** Each ‘AskFor…’ token creates its own pop-up window, so multiple tokens can result in a succession of pop-ups before the query is completed and applied.

Available "AskFor..." Tokens

<table>
<thead>
<tr>
<th>Token</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textit{AskForText}</td>
<td>Requests any type of text/string value. For example, anything dealing with names, addresses, TIN, account numbers or alphanumeric codes. Basically, anything that is not explicitly a number or date. Prompt is &quot;Text to use&quot;.</td>
</tr>
<tr>
<td>\textit{AskForFromText}</td>
<td>Same as &quot;AskForText&quot; except the prompt is &quot;1st/From value&quot;.</td>
</tr>
<tr>
<td>\textit{AskForThruText}</td>
<td>Same as &quot;AskForText&quot; except the prompt is &quot;2nd/Thru value&quot;.</td>
</tr>
<tr>
<td>\textit{AskForDate}</td>
<td>Requests a single date, with the pop-up calendar option. Defaults to current date and presets options are available.</td>
</tr>
<tr>
<td>\textit{AskForFromDate}</td>
<td>Same as &quot;AskForDate&quot; except the prompt is &quot;1st/From date&quot;</td>
</tr>
<tr>
<td>\textit{AskForThruDate}</td>
<td>Same as &quot;AskForDate&quot; except the prompt is &quot;2nd/Thru date&quot;.</td>
</tr>
<tr>
<td>\textit{AskForDateRange}</td>
<td>Pops up the full date range query window, with calendars and quick-select options for all common ranges (this year, this month, a particular month, a quarter, etc.) or select any random range.</td>
</tr>
<tr>
<td>\textit{AskForNumber}</td>
<td>Requests a single number and provides for decimals. Prompt is &quot;Number/Amount&quot;.</td>
</tr>
</tbody>
</table>
AskForLowNumber | Same as "AskForNumber" except the prompt is "1st/Low number".
---|---
AskForHighNumber | Same as "AskForNumber" except the prompt is "2nd/High number". These two tokens can be combined to create a numeric range.
AskForTimeRange | Asks for starting and ending times within a single day. Offers a number of quick-select options including 'Last 30 minutes', 'Midnight to 6AM', 'Before Noon', etc.

1099 Pro is continuing to enhance the token process and add more tokens to make it more intuitive. Check the online help or ask 1099 Pro for an updated list when program updates are issued.

### Queries

**Queries**

CRS Pro offers predefined queries to filter your data. The Current Query drop menu is available at the Work with My Tax Forms and Filer Master List screens.

- See Custom Query

**Pre-defined Queries include:**
- Corrections (Filed)
- Corrections (Not Filed)
- Errors and Warnings
- Filed Original Forms
- Forms with Notes
- Pending Original Forms
- Printed Original Forms
- Voided Original Forms

**Filer:**
- Has notes
- SSN
- EIN
- Combined Fed/State filing program

### 16.1 Custom Query using Manual Override

**Custom Query using Manual Override**

Sophisticated users can use the manual override feature in the Query Wizard to create custom queries via the Expression Builder which allows additional Date and Function Categories.

1. At the Query Wizard Field Selection screen, click the "Manual" button in the lower left of the window.

2. In the Query Wizard Manual Override screen, users may either choose from pre-selected fields from the Field List drop menu or click the ellipses [...] button to its immediate right.

3. At the Expression Builder screen options include:
Queries 105

- **Data and function categories**: Select the category of the function to be applied in this column.
- **Data and function names**: Contains a list of logical expressions to be applied to the query. A logical expression consists of a field, operator and value.
- **Validate**: This button will compile and determine if the current expression has been constructed properly.
- **Clear**: Removes the contents of the current expression from the expression builder main screen.
- **Insert**: Inserts the currently highlighted "Data and function name" into the Expression Builder Window.
- **OK**: Executes the "Validate" feature to check the validity of the expression and saves your expression.
- **Cancel**: Closes the expression builder and returns you to the Query Wizard "Field Selection screen.

4. After saving your custom expression it is available for selection at all Current Query drop menus.

16.2 **Custom Query Wizard**

**Custom Query Wizard**

The Query Wizard allows custom access to data via an intuitive wizard driven interface. All users can quickly create and save customized queries and then re-use those queries.

1. Access the Current Query drop menu at the Work With My Tax Forms screen. At the Current Query drop menu select "Custom Query".

2. In the Query Wizard select a field to evaluate, e.g., "Box 1 Amount" or "Recipient State or Province", and click "Next".
   - See **Form Status Values** for specific information on the "Form Status", "Voided", "Correction Type" and "Error Status" fields.

3. At the Operation Selection screen, select the operator, e.g., "Is Equal To" or "Is Between", and click "Next".
4. At the Value Entry screen determine the value to be used to complete the expression. For example, "Recipient State or Province Is Equal to CA" where "CA" is the value. Optionally, users may process the query using "Compare Using Case Sensitive Matching" by placing a check in the box. Click "Next" to continue.

5. Click "Finish" to save your changes and run the query.
   - At the finish screen users may add any additional selection criteria as needed.
   - Use the "Change" button to change your current query or use the "Delete" button to delete the current query and start again.
   - After clicking "Finish" the user is prompted to save the query. Click "Yes" to save and enter a query name or click "No" to bypass saving a query name and display the results of the current query.

### 16.3 Form Status Values: Database Queries

**Form Status Values—Database Queries**

Database values are useful for generating Custom Queries in CRS Pro or in an SQL database.

In the Query Wizard select **Form Status Code** = Optional, form statuses to return, accepts an array of integers. The default returns all printed status forms. If an original form has a correction, only the latest correction is returned. This includes both parts of a 2-part correction, the zero correction and the new part. The original or new corrected values can be requested and both parts are returned.

<table>
<thead>
<tr>
<th>ORIGINAL RECORDS</th>
<th>CORRECTION ZERO FORM (2-PART)</th>
<th>Correction (1-Part) / New Form (2-Part)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: Original Pending</td>
<td>0: Original Pending</td>
<td>10: Corrected Pending</td>
</tr>
<tr>
<td>1: Original Printed</td>
<td>11: Corrected Printed</td>
<td>20: Correction Pending</td>
</tr>
<tr>
<td>2: Original Printed and Voided</td>
<td>12: Corrected Printed and Voided</td>
<td>21: Correction Printed</td>
</tr>
<tr>
<td>3: Original Printed and Filed Paper</td>
<td>13: Corrected Printed and Filed Paper</td>
<td>22: Correction Printed and Voided</td>
</tr>
<tr>
<td>4: Original Printed and e-Filed</td>
<td>14: Corrected Printed and e-Filed</td>
<td>23: Correction Printed and Filed Paper</td>
</tr>
<tr>
<td>5: Original SB Printed</td>
<td>15: Corrected SB Printed</td>
<td>24: Correction Printed and e-Filed</td>
</tr>
<tr>
<td>6: Original Not Printed and e-Filed</td>
<td>16: Corrected Not Printed and e-Filed</td>
<td>25: Correction SB Printed</td>
</tr>
<tr>
<td>7: Original Not Printed and SB e-Filed</td>
<td>17: Corrected Not Printed and SB e-Filed</td>
<td>26: Correction Not Printed and e-Filed</td>
</tr>
<tr>
<td>8: Original SB Printed and SB e-Filed</td>
<td>18: Corrected SB Printed and SB e-Filed</td>
<td>27: Correction Not Printed and SB e-Filed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>28: Correction SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>


**Error Status Values**

In the Query Wizard select **Error Status** = Optional.

- 0: No Errors
- 1: Warnings
- 2: Errors
- 3: Warnings + Errors
- 4: Fatal / Major Errors
17 Error Messages

Error Messages

Error messages appear as pop-ups within your software due to user error or a software bug. Many of these errors have simple solutions that can be easily applied by the user, the user's IT department or 1099 Pro, Inc.'s Technical Support. Prior to applying any solution backup data to avoid any possible data loss.

Most error messages result from one or more of the following issues:
- Incorrectly mapped data file.
- Inadequate user rights to read/write/edit data file.
- Third party anti-virus software removing critical software files.
- Incomplete software updates.

Authorization Code Error

If an Authorization Code does not work it is almost always because an incorrect version of the software was installed. For example, a CRS Pro 2016 Authorization Code is incompatible with a CRS Pro 2017 installation. Users should verify that the version installed matches the version purchased.

Common Error Messages & Solutions

- **Invalid Record Declaration Error** 47
- **Unable to Open Required File (ProTips): 2 – File Not Found**
- **Unable to Open Required File (ProTips): 3 – Path Not Found**
- **Unable to Open SystemID: 2 – File Not Found**
- **Unable to Open SystemID: 3 – Path Not Found**
- **Unable to Open SystemID: 5 – Access Denied**
- **Unable to Open SystemID File 53 – Invalid Clarion File**
- **Clarion Trappable Runtime Errors**
- **EC002 – Unable to Open Files!**
- **Error Code #0008 – Can't Find Stub Loader**
- **Could Not Load DLL Library \USER32.DLL**
- **Single User Version Error**
- **File Not Found: Information Request**

Antivirus Exceptions

CRS Pro software requires full rights to certain folders and subfolders plus a carve-out from any antivirus programs (e.g., Norton, McAfee, Sophos, Kaspersky, Webroot, etc.). This includes full rights and permissions to where the software is installed is required, which is typically C:\1099Pro and all subfolders. In the case that your data folder is on a network, users will also need full rights to the Data folder where the .TPS files reside.

Antivirus (AV) programs often prevent installations, software updates and corrupt.TPS data files. The following assumes that the software is installed in the default installation locations. Be sure to create exceptions which correspond to where the software is launched from and where your data (.TPS) files reside.
For detailed instructions on setting up a carve-out for our software products please refer to the 1099 Pro WIKI at https://wiki.1099pro.com/display/PDWA/Antivirus+Exceptions.

17.1 Invalid Record Declaration (47)

File Access Error: Invalid Record Declaration (47)

Solution:
This error can occur when either system latency or anti-virus software interrupts the record-numbering process. Please contact Technical Support to further assist in renumbering records.

17.2 Unable to Open Required File (ProTips): 2 – File Not Found

Unable to Open Required File (ProTips): 2 – File Not Found

Solution:
This error most often occurs if there was an error during installation or an error when mapping the file path to your data folder. First, verify the software is not running from a network location; the software must be run locally, or from a client installation linked to a hosted data file.

The software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\ProCRSTxx\Admin.
- Open the file called ProCRSTxx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro \ProCRSTxx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom
17.3 Unable to Open Required File (ProTips): 3 - Path Not Found

Unable to Open Required File (ProTips): 3 – Path Not Found

Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\ProCRSTxx\Admin.
- Open the file ProCRSTxx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRSTxx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

17.4 Unable to Open SystemID: 2 - File Not Found

Unable to Open SystemID: 2 – File Not Found

Solution:
This error most often occurs if there was an error during installation, or if a third party virus protection software removed CRS Pro program files. Verify the file "Systemid.TPS" exists; located in file path C:\1099 Pro\ProCRST17\Resource. If this file has been removed, or was blocked from installation, you may need to backup your data, then uninstall and reinstall the software. Be sure to list CRS Pro as trusted software in your anti-virus software to avoid having files removed.

If "Systemid.TPS" is present, it's possible that the file path to your data contains unacceptable characters. This can be changed by editing your .INI file:

- Navigate to C:\1099 Pro\ProCRSTxx\Admin.
- Open the file called ProCRSTxx.INI.
- Locate the file path associated with "SAV:GlobalDataPath".
- Make sure the data file path does not contain a backslash at the end of the path, or any periods if
using a UNC. For example: \stationx.1099pro.com\c\xxxx\.

- Save and run the software again.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro \ProCRSTxx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Please contact Technical Support to further assist in renumbering your records.

17.5 Unable to Open SystemID: 3 - Path Not Found

Unable to Open SystemID: 3 – Path Not Found

Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\ProCRSTxx\Admin.
- Open the file called ProCRSTxx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro \ProCRSTxx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

17.6 Unable to Open SystemID: 5 - Access Denied

Unable to Open SystemID: 5 – Access Denied

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact Technical Support for additional assistance.

17.7 Unable to Open SystemID File: 53 - Invalid Clarion File

Unable to Open SystemID: 53 – Invalid Clarion
File

Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\ProCRSTxx\Admin.
- Open the file ProCRSTxx.INI.
- Edit the file path associated with “SAV:GlobalDataPath” to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRSTxx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

17.8 EC002 – Unable to Open Files!

EC002 – Unable to Open Files!

Solution:
This error most often occurs when attempting to restore data from the wrong year (e.g., data from 2016 into CRS Pro for 2017). Users cannot restore data into a different year’s software. This is a security measure to ensure that users do not accidentally file the wrong data.

Recipient and filer information may be rolled forward during or immediately after installing. For more information, see Roll Forward Data.
17.9 File Not Found - Information Request

File Not Found: Information Request

Solution:
This error may occur when performing a Roll Forward procedure if some of the user selected items such as "Prior Year Security Settings" or "Prior Year Import Maps" do not contain data. For example, in the 2016 software security was not used or custom import maps were not created.

The user should click "OK" and continue with the installation.

17.10 Could Not Load DLL Library \USER32.DLL

Could not load the DLL library C:\Windows\USER32.DLL. The specified module could not be found.

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact Technical Support for additional assistance.

17.11 Clarion Trappable Runtime Errors

Clarion Trappable Runtime Errors

The following errors can be trapped in code with the ERRORCODE and ERROR procedures. Each error has a code number (returned by the ERRORCODE procedure) and an associated text message (returned by the ERROR procedure) indicating what the problem is.

2 File Not Found
The requested file does not exist in the specified directory.

3 Path Not Found
The directory name specified as part of the path does not exist.
4 Too Many Open Files
The total number of file handles available has been used. Check the FILES= setting in the CONFIG.SYS file, or the user's or network's simultaneous open files setting in a network environment.

5 Access Denied
The file has already been opened by another user for exclusive access, has been left in a locked state, or you do not have network rights to open the file. This error can also occur when no disk space is available.

7 Memory Corrupted
Some unknown memory corruption has occurred.

8 Insufficient Memory
There is not enough unallocated memory left to perform the operation. Closing other applications may free up enough memory.

15 Invalid Drive
An attempt to read a non-existent disk drive has failed.

27 Invalid Table Declaration
An attempt to open a table that has an invalid table structure has failed. This is normally found when a Dynamic File has been created incorrectly. Also seen in IP Driver based applications.

30 Entry Not Found
A GET to QUEUE has failed. For GET(Q,key), the matching key value was not found, and for GET(Q,pointer), the pointer is out of range.

32 File Is Already Locked
An attempt to LOCK a file has failed because another user has already locked it.

33 Record Not Available
Usually an attempt to read past the end or beginning of file with NEXT or PREVIOUS. May also be posted by PUT or DELETE when no record was read before the attempted PUT or DELETE.

35 Record Not Found
For a GET(File,key), the matching key field value was not found.
36 Invalid Data File
Some unknown data file corruption has occurred, or the OWNER attribute does not match the password used to encrypt the file.

37 File Not Open
An attempt to perform some operation that requires the file be already open has failed because the file is not open.

38 Invalid Key File
Some unknown key file corruption has occurred.

40 Creates Duplicate Key
An attempt to ADD or PUT a record with key field values that duplicate another existing record in the file has been made to a file with a key that does not allow duplicate entries.

43 Record Is Already Held
An attempt to HOLD a record has failed because another user has already held it.

45 Invalid Filename
The filename does not meet the definition of a valid DOS filename.

46 Key File Must Be Rebuilt
Some unknown key corruption has occurred that requires the BUILD statement to re-build the key.

47 Invalid Record Declaration
The data file on disk does not match the file's declaration in the .EXE, usually because you have changed the file's definition in the Data Dictionary and have not yet converted the existing data file to the new format. See How do I handle an Error 47

48 Unable To Log Transaction
A transaction logout or pre-image file cannot be written to disk. This usually occurs because no disk space is available, or the user does not have the proper network rights.

52 File Already Open
An attempt to OPEN a file that has already been opened by this user.
54 **No Create Attribute**  
An attempt to execute the CREATE procedure on a file whose declaration does not include the CREATE attribute.

55 **File Must Be Shared**  
An attempt to open a file for exclusive access that must be shared. (Legacy error, no longer used)

56 **LOGOUT Already Active**  
An attempt to issue a second LOGOUT statement while a transaction is already in progress.

57 **Invalid Memo File**  
Some unknown memo file corruption has occurred. For Clarion data files, this could come from a corrupt .MEM file "signature" or pointers to the memo file in the data file that are "out of sync" (usually due to copying files from one location to another and copying the wrong .MEM file).

63 **Exclusive Access Required**  
An attempt to perform a BUILD(file), BUILD(key), EMPTY(file) or PACK(file) was made when the file had not been opened with exclusive access.

64 **Sharing Violation**  
An attempt to perform some action on a file which requires that the file be opened for shared access.

65 **Unable To ROLLBACK Transaction**  
An attempt to ROLLBACK a transaction has failed for some unknown reason.

73 **Memo File Missing**  
An attempt to OPEN a file that has been declared with a MEMO field and the file containing that memo data does not exist.

75 **Invalid Field Type Descriptor**  
Either the type descriptor is corrupt, you have used a name that does not exist in GET(Q,name), or the file definition is not valid for the file driver. For example, trying to define a LONG field in an xBase file without a matching MEMO field.

76 **Invalid Index String**  
The index string passed to BUILD(DynIndex,string) was invalid.
77 Unable To Access Index
An attempt to retrieve records using a dynamic index failed because the dynamic index could not be found.

78 Invalid Number Of Parameters
You did not pass the correct number of parameters to a procedure called in an EVALUATE statement. Note: As of Clarion Version 6.2 (9047), the SQL Drivers now add more information to the trace log file, explaining why the ERRORCODE 78 was generated.

79 Unsupported Data Type In File
The file driver has detected a field in the file declared with a data type that is not supported by the file system the driver is designed to access.

80 Unsupported File Driver Function
The file driver has detected a file access statement that is not supported. This is frequently an unsupported form (different parameters) of a statement that is supported.

81 Unknown Error Posted
The file driver has detected some error from the backend file system that it cannot get further information about.

88 Invalid Key Length
An attempt to CREATE a Clarion file driver KEY or INDEX with more than 245 characters. Other file drivers can also return this error when their file system key length limits are exceeded.

89 Record Changed By Another Station
The WATCH statement has detected a record on disk that does not match the original version of the record about to be updated in a network situation.

90 File Driver Error
The file driver has detected some other error reported by the file system. You can use the FILEERRORCODE and FILEERROR procedures to determine exactly what native error the file system is reporting.

91 No Logout Active
The COMMIT or ROLLBACK statement has been issued outside of a transaction frame (no LOGOUT statement has been executed).
92  BUILD in Progress
A BUILD statement has been issued and PROP:ProgressEvents has been set to generate events. The statement generating this error is not appropriate to execute during a BUILD process.

93  BUILD Cancelled
The user cancelled the BUILD. This error is set when EVENT:BuildDone is posted.

94  Record Limit Exceeded
The target file has exceeded the record limit. This value is file driver dependant, and can be returned during any attempt to modify a file where the record limit is exceeded.

97  Stream Error
Used during RTF processing.

100  Trigger Error
This error is set whenever a registered file callback method returns FALSE. See CALLBACK

1010  Illegal Expression
The EVALUATE procedure has detected an error in the syntax of the expression it is attempting to evaluate.

1011  Variable Not Found
The EVALUATE procedure has not found a variable used in the expression it is attempting to evaluate. You must first BIND all variables used in the expression for them to be visible to EVALUATE.

17.12 Single User Version Error

Single User Version Error

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the software is installed. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact Technical Support for additional assistance.
18 Additional Services

18.1 Managed Services

Managed Services

The 1099 Pro Managed Services team, IRSCompliance, can maintain your payee and payment database in our secure SSAE 16 SOC I Type II environment, or on your secure servers. Managed Services can support current and prior years of tax data for forms 1098, 1099, 5498, W-2G, W-2, 1042-S, 3921, 3922, as well as Puerto Rico payment information. This service includes regulatory support, compliance training, and year-end recipient statements. Users can access the 1099 Pro Corporate Suite software to securely view and print their payee and payment information and perform data queries, either online or through a secure network.

With more than 25 years of experience, IRSCompliance members have real world experience in a variety of industries, and as a result, are experts in federal law, state tax, local tax, and payment types that are subject to reporting. IRSCompliance’s expertise and efficiency will improve your compliance and minimize financial risk to your company.

CUSTOM AND SCALABLE FEATURES
Federal & state filing for originals and corrections
Quarterly wage reporting
Independent Contractor Reporting
TIN Compliance Management: B-Notices, TIN matching, W-8 and W-9 processing
Balancing and reconciliation
Transaction detail history and audit trails
Penalty abatement
Form 1099-K processing and reporting

OPTIONAL SERVICES
Withholding & deposit services
Policy and procedure development
Regulatory publications, webinars, and events
Standard and custom printing services
Consulting, risk assessment services, and curing
Penalty appeals
Electronic filing services
Electronic payee statement presentment
Electronic solicitation and validation of W-8s & W-9s

1099 Sales and Technical Support
(888) 776-1099
sales@1099pro.com

19 Glossary

Glossary
Access Groups
Access Groups determine which Filers a user can access and which tasks they can perform upon those records. By default, all users can access All Filers unless Access Groups are created. Built-in Groups cannot be deleted or changed; Admin can only add or remove Users to those groups.

Available built-in groups consist of "All Filers". The key to implementing user restriction is to limit the number of Filers they have access have to.

Account Generation Wizard
CRS Pro includes an optional utility to generate account numbers for records missing this information.

Account Holder
Filer/Reporting FIs report on Account Holders. CRS Pro users sometimes interchange the terms Account Holder and Recipient.

Activation Code
A registration code (AKA authorization code or product ID) is provided upon proof of payment. The algorithm of your registration code indicates the edition, user license and number of record transactions purchased.

Aggregation
The Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer. This feature is not available in CRS Pro.

Audit Trails
Audit Trails do NOT track the history of all manual and cascading changes to a Master Filer List. Only direct changes to a tax form are stored in the record history screen.

B-Notice
If after submitting files to the IRS, a mismatch is determined, (e.g., a recipient's name and TIN do not match the IRS records), the IRS sends the Filer a CP2100 or CP2100A Notice. The Filer must then issue a Form W-9 and a B Notice to the recipient in question unless the Filer determines the error was on their part (e.g., a typo).

Backup Data
The Backup Wizard automatically copies all data files and compresses them into a WinZip format. By default, CRS Pro prompts for a daily backup.

Blank Paper
CRS Pro prints reports to blank paper.

Bump Codes
CRS Pro allows up to 1,000 transactions. Additional transactions can be purchased via Bump Codes.

CDOT
CRS Pro does not support CDOT (also referred to as "UK FATCA"). UK FATCA is being phased out and will ultimately be replaced by the Common Reporting Standard.

Control Totals
The Control Totals report is an invaluable tool for reviewing Account Holder records. Information contained in this report includes Filer/Reporting FIs Name and TIN, Account Holder's Name, TIN, Account Number and Address and much more.

Corrections
CRS Pro supports corrections but only for records that were originally filed through this software application.

Country Alias/Validation Options
This feature is not available in CRS Pro. See Country Codes Table.

- E -

EIN (Employer Identification Number)
The Employer Identification Number (EIN) is also known as a federal tax identification number, and is used to identify a business entity. Generally, businesses need an EIN.

Envelopes
Some jurisdictions have additional specifications which require an XML envelope. 1099 Pro Technical Support handles these on a case-by-case basis at TS@1099pro.com. Please provide the jurisdiction variation AND a hyperlink to the specification if you have this issue.

Excel Spreadsheet Files
When saving data in Excel, use the 'Save As' method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files appear out of alignment when viewed from a text editor such as Notepad but look great when viewed from Excel. To import .TXT (TAB delimited) files select TAB, CR LF and Double Quotes as your delimiters in the Import Wizard.

Export Wizard
This feature is not available in CRS Pro.

- F -

Filer
CRS Pro refers to the combination of a Reporting FI and the Country to report to as a Filer.

Form Status
Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the appropriate status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session.

Forms
Fill-in forms allow users to manually enter data onscreen via the Enter, Update & View Screen.

Forms Status Values
See topic on "Forms Status Values"
- G -

Generating Account Numbers

See Account Number Generation

GIIN
The Global Intermediary Identification Number is assigned to a PFFI or Registered Deemed Compliant FFI and is composed of 19-characters in a specified format.

Group Actions
Group Actions allow users to Tag (or select) multiple related items and then perform a single action on them. In all cases, the user is prompted to confirm their selections before the action is taken.

- H -

History
CRS Pro allows users to view a list of prior changes to a form. Records with a pending status display the Changing a Record screen. In the upper right corner of the form is a audit trails button. Click the "History" button. This screen tracks all manual changes made to a record.

- I -

Import
Many database and spreadsheet applications such as Microsoft Excel, Access and Lotus 1-2-3 provide for the exporting of data to an ASCII file. These files can be imported into CRS Pro, thus relieving the burden of manually entering the information onto the tax form. If your data has already been entered once, why type it again?

INI Files
The "ProCRST16.INI" file contains information specific to your installation and is located at C:\1099 Pro \ProCRST17\Admin. If installing to a directory such as Program Files it may be placed in C:\Windows. The INI file may or may not be deleted during a custom uninstall. This file can be manually deleted if you want to totally remove CRS Pro from your system or if you want to perform a clean re-installation. This file can remain if you want to reinstall the software but retain your settings.

Install
See Install Single or Install Multi-User versions

- K -

Keyboard Shortcuts
Keyboard shortcuts allow you to quickly enter or carry out functions by applying a combination of ALT [SHIFT] or Ctrl + key Commands on your keyboard.

- L -
**Master Tax Form**
In terms of Aggregating data in a tax form, the master tax form is considered to be the first tax form entered at the top of the list. *This feature is not available in CRS Pro.*

**Online Help Tutorials**
Flash enabled tutorials walk you through various tasks including importing, exporting, XML creation, queries, etc. Tutorials simplify the CRS Pro learning curve - try one at [http://www.1099 Pro.com](http://www.1099 Pro.com).

**Online Knowledge Base**
Provides a searchable database of over 200 solutions for all 1099 Pro, Inc. software products. Access the Knowledge Base at [http://www.1099 Pro.com](http://www.1099 Pro.com).

**Passwords**
The Logon screen requires users to enter a new password. Passwords must be 3-8 characters, should not be case sensitive, and the word "new" is not allowed.

**Payer Codes**
A Payer Code or PCode is an alphanumeric shorthand used to identify a Payer/Filer/Reporting FI in the software. Users might set up several Filers with the same TIN in CRS Pro and the Payer Code is the methodology to differentiate them. When creating a Filer/Reporting FI, users are encouraged to use the Receiving Country Code as the first two characters of the PCode. Payer codes are required and must be unique.

**Penalties**
See [Errors & Warnings](#) and [Penalties](#) for more information.

**Pending**
These forms were or imported or manually entered. Forms with a Pending status can be edited or deleted.

**Preferences**
At the menu bar select File > Security and Administration > Program Options > Preference, Update and Program Options to access the Preferences screen. Preference items allow users to modify general settings which affect global software functions.

**Queries**
The Query Wizard allows custom access to user data via an intuitive wizard driven interface. Users can quickly create and save customized queries.
This term is not used in CRS Pro. Please see Account Holder.

**Reports**
Reports are useful for tracking the status of forms and determining if records contain any errors or warnings. CRS Pro offers three main reports including the Control Totals Report, Forms Issued by Filer, and Form Counts by Filer.

**Restore**
The Backup Wizard automatically copies all data files and compresses them into a WinZip format. Use the shareware program WinZip to restore data to a location on your hard drive.

**Rights Groups**
Activity Groups are used to allow or deny users from performing various activities within the system. Examples may be rights to View tax forms or rights to Import/Export tax form data. Activity Groups assigned to users cause these users to inherit the rights assigned to the Group. Activity Groups consist of two types; a built-in group (denoted by the **BLUE** color) and custom groups created by Admin. Built-in groups cannot be deleted or modified except to add or remove users.

**Roll Forward**
During installation the wizard automatically looks for prior year data files. If files are located the wizard prompts to "Copy 2016 Filers to CRS Pro 2017". This is the only opportunity to roll forward prior year data into CRS Pro 2017.

- S -

**Search**
Access any filer via the **Search Name** field.

**Security**
CRS Pro offers two levels of security: On and Off.
- If security is enabled, access to CRS Pro is limited to users with valid User ID/Password combinations. These users are restricted to specific tasks assigned by the Administrator. This performs a twofold method of protecting sensitive company data.

**Service Bureau**
1099 Pro, Inc. has a proven track record of printing, mailing and electronic filing. **This feature is not available to CRS Pro users.**

**SSN (Social Security Number)**
The nine-digit Social Security number is divided into three parts:
- The first three digits are the area number. If your Social Security number was assigned before 1972 when Social Security cards were issued by local offices, the area number reflects the State where you applied for your number. If your number was assigned in 1972 or later when we began issuing Social Security cards centrally, the area number reflects the State as determined by the ZIP code in the mailing address on your application for the number.
- The middle two digits are the group number. They have no special geographic or data significance but merely serve to break the number into conveniently sized blocks for orderly issuance.
- The last four digits are serial numbers. They represent a straight numerical sequence of digits from 0001-9999 within the group

**Spreadsheets**
When saving data in Excel, use the 'Save As' method to save your file in **.TXT (TAB delimited)** format, not
.XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files may appear out of alignment when viewed from a text editor such as Notepad but maintain formatting of data. To import .TXT (TAB delimited) files select TAB, CR LF and Double Quotes as your delimiters in the Import Wizard.

- T -

Tag
The act of selecting a Filer.

Technical Support
See Technical Support

TIN (Taxpayer Identification Number)
A TIN can be a Social Security Number (SSN) issued by the Social Security Administration, an Employer Identification Number (EIN) issued by the IRS, or an Individual Tax Identification Number (ITIN) issued by the IRS. Individual Tax Identification Numbers are generally restricted to certain foreign vendors who are not eligible for social security numbers.

TIN Matching
This feature is not available in CRS Pro.

Transactions
CRS Pro allows up to 1,000 transactions; purchase additional transactions via Bump Codes.

- U -

Un-Installing
The Select Uninstall Method screen offers two options for removing CRS Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine. This option retains your current data files under the main program directory in the Data folder, any Service Bureau uploads in the Uploads folder, the .INI file in the Admin folder and any miscellaneous .DLL files used by the software.

User(s) / UserID
A user is an individual who has access to the software. Rights and permissions which delegate what this user can and cannot do are assigned to the user and then the user freely uses the software either with or without restrictions.

User Group(s)
User Groups are created by attaching one or more Access Groups and one Activity Group to them. A user's rights are determined based on which User Groups they are a member of:
- Administrator/ALL Rights
- Tax Forms (Edit/Pending)
- Tax Forms (Full Rights)
- Tax Forms (View Only)
- Import Tax Form Data
- Export Tax Form Data
- All Tasks Except Security
- File Tax Forms with IRS
- V -

**Virus Checkers**
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in CRS Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.

- W -

**W-9**
Use Form W-9 Request for Taxpayer Identification Number and Certification to request a recipient's TIN if the recipient is a U.S. person or U.S. resident alien. If the recipient is a foreign person use the appropriate Form W-8.

**Warnings**
See *Errors and Warnings*

**Web Updates**
The Check for Updates feature uses the Internet to check the 1099 Pro, Inc. update servers for a newer version of this program. Instead of running the full Web Update procedure from your Windows Start > Programs menu, users can quickly check for updates from within CRS Pro, or even have the program automatically check for you. If there is a new version, a message will pop up to display the new version and a one line summary of what is included in the update.

**19.1 Business Rules**

**Business Rules**

Business Rules are formulated in conjunction with the compliance experts from IRS Compliance to check that data being processed in CRS Pro’s software does not contain common formatting errors, form specific errors, is valid for State and Federal filing, and can be used to separate records with different levels of issues for processing. See Business Rules/Validation Changes

**19.2 ASCII**

**ASCII**

A simple text file where fields are delimited (or separated) with certain characters such as a tab, space or pipe. CRS Pro's import capability allows for most any ASCII file. These files can be exported out of most database and spreadsheet applications as an ASCII file, comma separated value (CSV) or tab delimited. Need help? Contact Technical Support.

**19.3 Cascading Updates**

**Cascading Updates**

Cascading updates are changes made to a Filer's name or address at the Filer Master List screen.
19.4 Corrected Options

Corrected Options

The Corrected Options screen is accessed whenever a corrected form (or original form associated with a correction) is selected at the "Work with My Tax Forms" screen.

19.5 Element: Country Codes

Element: Country Codes

The Residential Country Code (ResCountryCode) is an XML data element associated with an Individual Account Holder or Controlling Person. See Country Codes Table

19.6 Element: Currency / CP Codes

Element: Currency Codes

Amounts must also include the appropriate 3 character currency code based on the ISO 4217 Alpha 3 Standard. ISO 4217 is the International Standard for currency codes and it was developed to create internationally accepted codes to represent currencies.

Element: Controlling Person(s) Type Code

Each controlling person must include the appropriate controlling person type code.

Element: Name Type Code

Organisations and Persons must provide an appropriate Name Type Code.

Did You Know?
CRS Pro provides a list of all codes in the sample import file within the various worksheets of the Excel file (i.e., Import_CRS_MultipleTabs_Example.xlsx). In a standard installation this file is located at C:\1099 Pro\ProCRST16\Import\Samples\XLS Samples.

Most codes are also listed in the Import File Conventions topic.

19.7 Element: Payment

Element: Payment

The Payment Type, Payment Amount and Currency Code are XML data elements associated with an Individual Account Holder or Controlling Person. Multiple payments—of varying types and currency codes—are allowed. See Currency Codes
19.8 Element: TIN

**Element: TIN—Individual Account Holder’s TIN**

The Taxpayer Identification Number (TIN) is an XML data element used by the receiving tax administration to identify an Individual Account Holder. Multiple TINs are allowed.

The "Issued By" attribute identifies the jurisdiction that issued the TIN. If unknown, leave this field blank.

19.9 Filer

**Filer/Reporting FI**

CRS Pro refers to the combination of a Reporting FI and the Country/Jurisdiction to report to as a *Filer*.

19.10 Filing Deadlines

**Filing Deadlines**

CRS reporting deadlines vary by jurisdiction.

19.11 Hotspot

**Hotspot**

*Jump* items are indicated by a *BLUE* word or phrase. Click the jump to link to a related help topic.

*External jumps* items are indicated by an *UNDERLINED BLUE* word or phrase. Click the jump to link to an external document, website or email address. External jumps require an active Internet connection.

19.12 Import Map

**Import Map**

Import Maps describe the format and contents of external data files so that the information they contain can be imported into the program.

19.13 Penalties

**Penalties**

Filers/Reporting FIs should check with individual Jurisdictions to determine any Common Reporting Standard filing related penalties.
19.14 Pending Status

Pending Status

All records are assigned a status that determines their position in the filing cycle. Select the Pending status option to continue editing these records. See Form Status Overview

19.15 Recipient

Recipient

A recipient is an individual or business that receives a Form 1099, 1042-S or 8966.

19.16 SSAE 16 SOC I Type II

SSAE 16 SOC I TYPE II

1099 Pro, Inc. proudly features an SSAE 16 SOC 1 Type II Security Service Bureau for select form types.

Definitions
- SSAE 16 - Statement on Standards for Attestation Engagements No. 16.
- SOC I - Service Organization Control Report No. 1
- Type I - Audit of a system on a specified date
- Type II - Audit of a system throughout a specified time period

Overview
The SSAE 16 is an attestation standard put forth by the Auditing Standards Board (ASB) of the American Institute of Certified Public Accountants (AICPA).

SSAE 16 SOC I Type II is a high-level security certification requiring a stringent audit process. 1099 Pro's hosting and data facilities have passed this difficult audit without exception, ensuring that your data is secure when using any of our software or services. The SSAE 16 effectively replaces the SAS 70 for reporting periods ending on or after June 15, 2011.

This standard applies to engagements undertaken by a Service Auditor for reporting on controls at organizations like 1099 Pro which provide services to their customers. The controls in place at service organizations are likely to be relevant to a customer's internal control over financial reporting (ICFR).

Details
The SSAE 16 requires certain enhancements from the SAS 70 report - such as the service organization provide a description of its system. The description should include the services provided, control objectives, supporting processes, policies, procedures, personnel and operational activities that constitute the organization's core activities relevant to its customers.

Additionally, the SSAE 16 requires a Written Assertion by management be provided to the Service Auditor. In this document, management must assert that the system description and control objectives included therein are a fair presentation for the time period specified in the SOC 1 report.

SOC 1 reports are performed and issued under the Statement on Standards for Attestation Engagements No. 16 (SSAE 16) as explained above. The controls addressed in a SOC 1 report are those that a service
organization like 1099 Pro implements to prevent, detect and correct errors or omissions in the information it provides to customers.

Type II indicates that the service organization’s system was suitably designed to achieve stated control objectives and to operate effectively throughout a specified time period. Type I refers to a system designed for implementation on a specific date, rather than throughout a specified time period.

For further information, or report details, please contact the 1099 Pro Service Bureau.

The Service Bureau  
Phone: 866-444-3559  
Email: sb@1099pro.com

19.17 SSN  
Social Security Numbers

Social security numbers (SSNs) should be formatted as ###-##-####. Dashes are required to differentiate EINs from SSNs. There are approximately 100,000 numbers that are identical except for the placement of the dash!

19.18 States Code Table  
States Codes Table

The States Code Table has limited availability in CRS Pro. See Country Codes Table.

19.19 Tag  
Tag

Individually tag (select) a record or filer. A tagged item is marked by a red checkmark.

19.20 Task Panel  
Task Panel

The task panel is the blue bar on the left side of the CRS Pro screen and provides quick access to common tasks.

19.21 TIN Defined  
TIN Defined

Taxpayer identification number. An SSN (Social Security Number) has 9 digits divided by 2 hyphens, i.e. 333-22-4444. An EIN (Employer Identification Number) has 9 digits divided by 1 hyphen, i.e. 22-7777777. The placement of the dash is critical!
19.22 TIN Masking

TIN Masking

This feature is not available in CRS Pro.
Index

- - -
.TPS Files   27

- 1 -
1099 Compliance Seminars   20
1099 Pro Central   16
1099 Seminars   20

- A -
Abandon Import Session   76, 82
About 1099 Pro, Inc.   10
Access Denied   112
Access Group   30
Acrobat   20
Activation   12
Activation Code   12
Activity Report   42
Add a Filer   46
Add a Form   53
Add a User   32
Add or Create Records   50
Adding a Filer   46
Additional Services   40
Address Type   77
Administration   28
Adobe   20
AEOI XML Envelopes   11
Aggregate   83
Aggregating forms on a spreadsheet   83
Aggregation   83
Amount/Totals Report   81
Antivirus Exceptions   107
APO Zip Codes   62
ASCII File   125
Assign User Profiles   31
ATSG   40
Audit Trail Browser   21, 43
Audit Trail Report Filters   44
Audit Trails   41
Audit Trails Activity Report   42
Audit Trails, Purge   43
Authorization Code   12
Authorization Code Error   107
Auto Capitalize   39
Autocapitalization   59
Automatic   28
AV Errors   107

- B -
Backup Data   37
Backup Settings   39
Backup Wizard   37
BalanceCurrCode   77
Browse Filers   45
Browse IRS Forms   18
Browse Map List   65
Browse Notes   56
Browse Records   50
Browsing & Working with Entry Forms   51
Browsing by Form   55
BUILD Cancelled   112
BUILD in Progress   112
Bump   12
Bump Code   12

- C -
Capitalization   59
Carve-Out   107
Cascading Changes   59
CDOT   11
Change a Filer   47
Change a Form   53
Change a Record   50
Checking for Updates   13
City Names   62
Clarion File Error   110
Clarion Trappable Runtime Errors   112
Clock, Language and Region Settings   14
Codes - Form Status Error Status   106
Combine   83
Common Error Messages & Solutions   107
Common Reporting Standard Filers   48
Completed XML Session List   87
Compliance Seminars   20
Composition, GIIN   57

Copyright 1099 Pro® 2017
Contact Information 48, 49
Control Totals Report 98
Controlling Person Type Codes 126
Corporate Suite Dynamic Query 102
Could not load the DLL library 112
Country Codes Table 76
CP_Type Header 77
CPE Units 20
Create XML Task Panel 18
Creates Duplicate Key 112
CRS Filers 48
CRS Forms 18
CRS Instructions 18
CRS XML 88
CRS007 77
CRS101 - CRS103 77
CRS501 - CRS504 77
CRS801 - CRS813 77
Currency Codes 126
Current View 101
Custom Dynamic Query 102
Custom Query 50, 104
Custom Query Values 106
Custom Query Wizard 105
Custom Sort Order 102
Custom View 101

- D -
Daily Totals Report 101
Data Backup 37
Data Entry 60
Data Files 27
Data Input Issues 14
Data Restore 38
Deadlines 127
Dedicated Servers 40
Define View 102
Delete a Filer 47
Delete a Form 53
Delete a Record 50
Delete Audit Trails 43
Deleted Record Detail 43
Deleting software 26
Delimited Import Map Wizard 66
Delimited Import Mapping 66
Delimiters 81
Demo 12
Developer Tab 89
Different User 35
Disclaimer 9
Display DELETED Records 39
DPI 27

- E -
EC002 - Unable to open files! 111
Edit a Form 53
Edit, Post or Abandon Import Records 73
Education 20
Efiling 87
electronic filing 87
Electronic Filing Session Reset/Void 91
Elements 77
Email 48
Enter, Update and View Screen 50
Entry Forms 51
Entry Not Found 112
Envelopes, XML 11
Error & Validation Checking 85
Error Messages 107
Error Status Values 106
Error: Invalid Record Declaration (47) 108
ERROR: XML File Does Not Pass Schema Validation 92
Errors - Import Checking 85
Errors and Warnings by Recipient 98
Errors and Warnings Scan 86
Errors, Clarion 112
Excel - Review XML Files 89
Excel Spreadsheet Files 80
Exclusive Access Required 112
Expiration and Reuse Options 30
Export Data 89
Expression Builder Queries 104
External Jump 127

- F -
Fax 48
FFI 57
File Access Error. 108
File Already Open 112
File Driver Error 112
File Is Already Locked 112
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Must Be Shared</td>
<td>112</td>
</tr>
<tr>
<td>File Not Found</td>
<td>107, 112</td>
</tr>
<tr>
<td>File Not Found Information Request</td>
<td>112</td>
</tr>
<tr>
<td>File Not Open</td>
<td>112</td>
</tr>
<tr>
<td>FileName</td>
<td>48</td>
</tr>
<tr>
<td>Filer</td>
<td>46</td>
</tr>
<tr>
<td>Filer Master List Screen</td>
<td>45</td>
</tr>
<tr>
<td>Filer Name / Name Line 2</td>
<td>48</td>
</tr>
<tr>
<td>Filer Notes</td>
<td>56</td>
</tr>
<tr>
<td>Filer Record Details</td>
<td>48</td>
</tr>
<tr>
<td>Filer Reports</td>
<td>49</td>
</tr>
<tr>
<td>Filers List Report</td>
<td>49</td>
</tr>
<tr>
<td>Files already in use</td>
<td>117</td>
</tr>
<tr>
<td>Filing Deadlines</td>
<td>127</td>
</tr>
<tr>
<td>Filing Problems</td>
<td>86</td>
</tr>
<tr>
<td>Filing via XML</td>
<td>87</td>
</tr>
<tr>
<td>Finding &amp; Fixing Problem Records</td>
<td>85</td>
</tr>
<tr>
<td>First Time Password</td>
<td>34</td>
</tr>
<tr>
<td>Foreign Address - Filer</td>
<td>48</td>
</tr>
<tr>
<td>Foreign OS Installation</td>
<td>14</td>
</tr>
<tr>
<td>Form Control Totals Report</td>
<td>98</td>
</tr>
<tr>
<td>Form Counts by Filer Report</td>
<td>100</td>
</tr>
<tr>
<td>Form Counts Report</td>
<td>100</td>
</tr>
<tr>
<td>Form Status</td>
<td>82</td>
</tr>
<tr>
<td>Form Status Values: Database Queries</td>
<td>106</td>
</tr>
<tr>
<td>Forms Issued By Filer Report</td>
<td>100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G -</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Options Toolbar</td>
</tr>
<tr>
<td>Getting Started</td>
</tr>
<tr>
<td>GIIN Composition</td>
</tr>
<tr>
<td>GIIN Format</td>
</tr>
<tr>
<td>GIIN Validation</td>
</tr>
<tr>
<td>Global Administrative Options</td>
</tr>
<tr>
<td>Global Intermediary Identification Number</td>
</tr>
<tr>
<td>Global Notes</td>
</tr>
<tr>
<td>Glossary</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Group - Deleting Pending Tax Forms</td>
</tr>
<tr>
<td>Group - Printing Pending Tax Forms</td>
</tr>
<tr>
<td>Group - Reprinting Printed or Filed Tax Forms</td>
</tr>
<tr>
<td>Group - Reset Printed Tax Forms to Pending</td>
</tr>
<tr>
<td>Group - Un-voiding Tax Forms</td>
</tr>
<tr>
<td>Group - Voiding Printed Tax Forms</td>
</tr>
<tr>
<td>Group Actions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H -</th>
</tr>
</thead>
<tbody>
<tr>
<td>Halt</td>
</tr>
<tr>
<td>Header Records</td>
</tr>
<tr>
<td>Help &amp; Extras</td>
</tr>
<tr>
<td>History</td>
</tr>
<tr>
<td>HMRC US AEOI Submissions</td>
</tr>
<tr>
<td>Hosted Solutions</td>
</tr>
<tr>
<td>Hotspot Links</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I -</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illegal Expression</td>
</tr>
<tr>
<td>Implied Decimal Formatting</td>
</tr>
<tr>
<td>Import</td>
</tr>
<tr>
<td>Import Data</td>
</tr>
<tr>
<td>Import Errors</td>
</tr>
<tr>
<td>Import File Conventions</td>
</tr>
<tr>
<td>Import Filers</td>
</tr>
<tr>
<td>Import Files - Sample Files</td>
</tr>
<tr>
<td>Import Locking: Multi-User Install</td>
</tr>
<tr>
<td>Import Map Reports</td>
</tr>
<tr>
<td>Import Overview</td>
</tr>
<tr>
<td>Import Records, Review Prior to Import</td>
</tr>
<tr>
<td>Import Session Status Values</td>
</tr>
<tr>
<td>Import Session Summary Report</td>
</tr>
<tr>
<td>Import Status Options</td>
</tr>
<tr>
<td>IMPORT WIZARD - Step 1: Importing Data</td>
</tr>
<tr>
<td>IMPORT WIZARD - Step 2: Validate Data</td>
</tr>
<tr>
<td>IMPORT WIZARD - Step 3: Post Results</td>
</tr>
<tr>
<td>IMPORT WIZARD Overview</td>
</tr>
<tr>
<td>Incremental Index</td>
</tr>
<tr>
<td>INI File</td>
</tr>
<tr>
<td>Install Software</td>
</tr>
<tr>
<td>Insufficient Memory</td>
</tr>
<tr>
<td>Invalid Clarion File</td>
</tr>
<tr>
<td>Invalid Data File</td>
</tr>
<tr>
<td>Invalid Drive</td>
</tr>
<tr>
<td>Invalid Field Type Descriptor</td>
</tr>
<tr>
<td>Invalid Filename</td>
</tr>
<tr>
<td>Invalid Index String</td>
</tr>
<tr>
<td>Invalid Key File</td>
</tr>
<tr>
<td>Invalid Key Length</td>
</tr>
<tr>
<td>Invalid Memo File</td>
</tr>
<tr>
<td>Invalid Number Of Parameters</td>
</tr>
<tr>
<td>Invalid Record Declaration</td>
</tr>
</tbody>
</table>
Invalid Table Declaration 112

- J -
Jump 127
Jurisdiction XML Specs 48

- K -
Kaspersky 107
Key File Must Be Rebuilt 112
Keyboard Shortcuts 20

- L -
Language Settings 14
LegalAddressType Header 77
Loaded, Import Sessions 72
Location Code 48
Login as Different User 35
Logon as Different User 35
LOGOUT Already Active 112
Look up City 62
Look up City Name 62
Look up Zip Code 62

- M -
Maintain Pending Status 128
manage 118
Manage Custom Codes and Text 28
Manage Filer Button 16
Manage Import Maps 65
Manage Profiles 31
Managed Services 118
Manual Override 104
Manual Update 13
Map by Name Import 20
Map Street Addresses 69
Master Audit Trail Browser 21, 43
McAfee 107
Memo File Missing 112
Memory Corrupted 112
Menu bar 21
MessageRefID 48
Microsoft Access 83
Minimum Password Length 30
Modify Access Rights 30
Multi-User Considerations 25
Multi-User Installation 23

- N -
Navigate Entry Screen 51
Navigation 16
Network Import Error 70
New User Password Settings 34
NFFE Nil Report 92
NIL Filer 92
NIL Reporting 48
NIL Reports 92
No Create Attribute 112
No Logout Active 112
Norton 107
Notes 56

- O -
OECD Gateway 87
OECD Help 98
OECD Overview 98
OECD XML Schema 88
OECD1 - OECD3 77
OECD11 - OECD13 77
OECD201 - OECD208 77
OECD301 - OECD305 77
OECD601 - OECD605 77
Online Help Tutorials 21
Online Knowledge Base 21
Options for Tax Form Data Entry 60
Overview 11

- P -
P Record 77
Partial, Import Sessions 72
Password Expiration Options 30
Password Format Options 30
Password Lockout Reset 30
Password Options 30
Password Requirements 30
Passwords 34
Patches 13
Path Not Found 107, 112
<table>
<thead>
<tr>
<th>Category</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payer Code</td>
<td>48</td>
</tr>
<tr>
<td>PaymentType Header</td>
<td>77</td>
</tr>
<tr>
<td>PCode</td>
<td>48</td>
</tr>
<tr>
<td>Penalties</td>
<td>11, 127</td>
</tr>
<tr>
<td>Pending Status</td>
<td>128</td>
</tr>
<tr>
<td>PFFI</td>
<td>57</td>
</tr>
<tr>
<td>PMT Record</td>
<td>77</td>
</tr>
<tr>
<td>Post Results</td>
<td>75</td>
</tr>
<tr>
<td>Preferences</td>
<td>39</td>
</tr>
<tr>
<td>Prefix Override</td>
<td>48</td>
</tr>
<tr>
<td>Preparing My Forms Task Panel</td>
<td>17</td>
</tr>
<tr>
<td>Print an Import Map Report</td>
<td>100</td>
</tr>
<tr>
<td>Print Preview Toolbar</td>
<td>19</td>
</tr>
<tr>
<td>Print Users By Name Report</td>
<td>35</td>
</tr>
<tr>
<td>Print/View Record Reports</td>
<td>60</td>
</tr>
<tr>
<td>Pro Tips</td>
<td>107</td>
</tr>
<tr>
<td>ProCRST16.ini</td>
<td>27</td>
</tr>
<tr>
<td>Profiles</td>
<td>31</td>
</tr>
<tr>
<td>Program already in use</td>
<td>117</td>
</tr>
<tr>
<td>Program Areas/Functions Report</td>
<td>35</td>
</tr>
<tr>
<td>Protected Forms</td>
<td>54</td>
</tr>
<tr>
<td>ProTips</td>
<td>107</td>
</tr>
<tr>
<td>Purge Access Log-On Records</td>
<td>36</td>
</tr>
<tr>
<td>Purge Audit Trail Log Records</td>
<td>43</td>
</tr>
</tbody>
</table>

- Q -

<table>
<thead>
<tr>
<th>Category</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queries Dynamic</td>
<td>102</td>
</tr>
<tr>
<td>Queries, Predefined</td>
<td>104</td>
</tr>
<tr>
<td>Query - Manual Override</td>
<td>104</td>
</tr>
<tr>
<td>Query Wizard</td>
<td>104</td>
</tr>
<tr>
<td>Quick Tour</td>
<td>11</td>
</tr>
</tbody>
</table>

- R -

<table>
<thead>
<tr>
<th>Category</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Value</td>
<td>73</td>
</tr>
<tr>
<td>Record Changed By Another Station</td>
<td>112</td>
</tr>
<tr>
<td>Record History</td>
<td>43</td>
</tr>
<tr>
<td>Record Is Already Held</td>
<td>112</td>
</tr>
<tr>
<td>Record Limit</td>
<td>12</td>
</tr>
<tr>
<td>Record Limit Exceeded</td>
<td>112</td>
</tr>
<tr>
<td>Record Locking</td>
<td>25</td>
</tr>
<tr>
<td>Record Not Available</td>
<td>112</td>
</tr>
<tr>
<td>Record Not Found</td>
<td>112</td>
</tr>
<tr>
<td>Record Type Sequence</td>
<td>77</td>
</tr>
<tr>
<td>RecordType Header</td>
<td>77</td>
</tr>
<tr>
<td>Reference Materials</td>
<td>18</td>
</tr>
<tr>
<td>Region Settings</td>
<td>14</td>
</tr>
<tr>
<td>Registration &amp; Upgrades</td>
<td>12</td>
</tr>
<tr>
<td>Registration code</td>
<td>21</td>
</tr>
<tr>
<td>Reject Errors</td>
<td>85</td>
</tr>
<tr>
<td>Reject Imports</td>
<td>82</td>
</tr>
<tr>
<td>Remove Audit Trails</td>
<td>43</td>
</tr>
<tr>
<td>Removing software</td>
<td>26</td>
</tr>
<tr>
<td>Reporting F1 Task Panel</td>
<td>17</td>
</tr>
<tr>
<td>Reports Overview</td>
<td>98</td>
</tr>
<tr>
<td>ResCountryCode Element</td>
<td>126</td>
</tr>
<tr>
<td>ResCountryCode Header</td>
<td>77</td>
</tr>
<tr>
<td>Reset (Void) Import Session</td>
<td>76, 82</td>
</tr>
<tr>
<td>Reset Import Session</td>
<td>81</td>
</tr>
<tr>
<td>Reset Magmedia Session</td>
<td>91</td>
</tr>
<tr>
<td>Reset XML Session</td>
<td>91</td>
</tr>
<tr>
<td>Resolution</td>
<td>27</td>
</tr>
<tr>
<td>Restore Data</td>
<td>38</td>
</tr>
<tr>
<td>Review Import Data</td>
<td>73</td>
</tr>
<tr>
<td>Review Import Records</td>
<td>73</td>
</tr>
<tr>
<td>Rights Summary Report</td>
<td>35</td>
</tr>
<tr>
<td>Roll Forward Error</td>
<td>112</td>
</tr>
<tr>
<td>Roll Forward Utility</td>
<td>38</td>
</tr>
<tr>
<td>Roll Over Filers/Reporting FIs</td>
<td>38</td>
</tr>
<tr>
<td>Rollup</td>
<td>83</td>
</tr>
<tr>
<td>RTN</td>
<td>48</td>
</tr>
<tr>
<td>Runtime Errors</td>
<td>112</td>
</tr>
</tbody>
</table>

- S -

<table>
<thead>
<tr>
<th>Category</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Import Files</td>
<td>64</td>
</tr>
<tr>
<td>Scheduled</td>
<td>28</td>
</tr>
<tr>
<td>Scheduler</td>
<td>28</td>
</tr>
<tr>
<td>Schema Validation Failed</td>
<td>92</td>
</tr>
<tr>
<td>Search</td>
<td>61</td>
</tr>
<tr>
<td>Security</td>
<td>28</td>
</tr>
<tr>
<td>Security - Access Group: Step 2</td>
<td>30</td>
</tr>
<tr>
<td>Security - Add Users to a Profile: Step 5</td>
<td>33</td>
</tr>
<tr>
<td>Security - Add/Update Individual Users: Step 4</td>
<td>32</td>
</tr>
<tr>
<td>Security - Manage Profiles: Step 3</td>
<td>31</td>
</tr>
<tr>
<td>Security Access Log</td>
<td>36</td>
</tr>
<tr>
<td>Security Audit</td>
<td>128</td>
</tr>
<tr>
<td>Security Password Options</td>
<td>30</td>
</tr>
<tr>
<td>Security Reports</td>
<td>35</td>
</tr>
<tr>
<td>Security Settings</td>
<td>30</td>
</tr>
<tr>
<td>Select a City/Zip/State</td>
<td>62</td>
</tr>
<tr>
<td>Select Country Code</td>
<td>76</td>
</tr>
<tr>
<td>Select Filer</td>
<td>16</td>
</tr>
<tr>
<td>Seminars</td>
<td>20</td>
</tr>
</tbody>
</table>
Server Hosting  40 
services  118 
Set Password Requirements  30 
Sharing Violation  112 
Show Excel Developer Tab  89 
Single to Multi-User Upgrade  23 
Single User Version Error  117 
Social Security Number  129 
Software Updates  13 
Sophos  107 
Special Characters in XML  88 
Spreadsheets  80 
SSAE 16 SOC I Type II  128 
SSN  129 
States Code Table  129 
Status Codes  106 
Status Overview  54 
Step 2 - Validate your Data  73 
Step 3: Final Import / Post Results  75 
Stream Error  112 
Switch user  35 
System Requirements  14 
System Security Settings/Password Requirements: 
Step 1  30 
SystemID.TPS Error  109 

- T -
Tag Filers  49 
Tag Key Shortcuts  49 
Tagging Records  61 
Task Panel  16, 18 
Tax Form Notes  56 
Tax Identification Number  129 
Technical Support  22 
the specified module could not be found.  112 
TIN  129 
TIN Element  127 
Too Many Open Files  112 
Tool Bar  16 
TOP SPEED  107 
TOPSPEED  107 
Tour  11 
TPS Files  27 
Transaction Limit  12 
Transfer Data  38 
Trappable Runtime Errors  112 
Trigger Error  112 
Troubleshoot Import Issues  70 
Troubleshooting Control Totals  99 
Turn Audit Trails On/Off  44 
Turn On/Off Security  34 
Tutorial, YouTube  21 
Tutorials  21

- U -
UK FATCA  11
Unable To Access Index  112
Unable To Log Transaction  112
Unable to Open Required File (ProTips): 2 - File Not Found  108
Unable to Open Required File (ProTips): 3 - Path Not Found  109
Unable to Open SystemID file: 53 - Invalid Clarion File  110
Unable to Open SystemID: 2 - File Not Found  109
Unable to Open SystemID: 3 - Path Not Found  110
Unable to Open SystemID: 5 - Access Denied  110
Unable To ROLLBACK Transaction  112
Uninstall  26
Un-Installing software  26
Unknown Error Posted  112
Unlock Records: Multi-User Install  25
Unsupported Data Type In File  112
Unsupported File Driver Function  112
Update Software  13
Update Users  32
Updates  13
Updating a Form  51
Updating a Record  51
Upgrade  12
Upgrade Software  23
User Detail Report  35
User Group Detail Report  35
USER32.DLL  112

- V -
Validate your data during import  73
Validation  57
Validation Checking  85
Validation Failed XML  92
Variable Not Found  112
Video Display Issues  27
Video tutorials  21
View a Map Report 100
View Deleted Forms 53
Virtual Mapping 68
Void Import Session 76, 81, 82

- W -
Warnings 85
Welcome Wizard 22
WIKI Download Site 13
Windows Operating Systems 14
Work With My Tax Forms 50

- X -
XLS Data Shells 64
XML Data - Review in Excel 89
XML Envelope 11
XML Failed Schema 92
XML File Wizard 88
XML Filing 87
XML Overview 87
XML Reset/Void 91
XML Session Window 87
XML Special Characters 88

- Y -
YouTube Help Videos 21

- Z -
Zip Code Look up 62